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CHAPTER 1 Introduction

Data-Flow Programming

SAP® Sybase® Event Stream Processor uses data-flow programming for processing event
streams.

In data-flow programming, you define a set of event streams and the connections between
them, and apply operations to the data as it flows from sources to outputs.

Data-flow programming breaks a potentially complex computation into a sequence of
operations with data flowing from one operation to the next. This technique also provides
scalability and potential parallelization, since each operation is event driven and
independently applied. Each operation processes an event only when it is received from
another operation. No other coordination is needed between operations.

The sample project shown in the figure shows a simple example of this.

Each of the continuous queries in this simple example—the VWAP aggregate, the
IndividualPositions join object, and the ValueByBook aggregate—is a type of derived stream,
as its schema is derived from other inputs in the diagram, rather than originating directly from
external sources. You can create derived streams in a diagram using the simple query elements
provided in the Studio Visual editor, or by defining your own explicitly.

Figure 1: Data-Flow Programming - Simple Example
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CHAPTER 1: Introduction

Table 1. Data-Flow Diagram Contents

Element Description
PriceFeed Represents an input window, where incoming data from an external
= source complies with a schema consisting of five columns, similar to a
] database table with columns. The difference is that in ESP, the stream-
 PriceFeed ing data is not stored in a database.
Positions Another input window, with data from a different external source. Both
|——| Positions and PriceFeed are included as windows, rather than streams,
(| so that the data can be aggregated.
+ Posidons
VWAP Represents a simple continuous query that performs an aggregation,
- similar to a SQL Select statement with a GROUP BY clause.
| WiWAP

IndividualPositions

Represents a simple continuous query that performs a join of Positions
and VWAP, similar to a SQL FROM clause that produces a join.

'
L
& IrdividuaPostions
ValueByBook Another simple query that aggregates data from the stream Individual
- Positions.
+ WaheRyBadk

Continuous Computation Language

CCL isthe primary event processing language of the Event Stream Processor. ESP projects are
defined in CCL.

CCL is based on Structured Query Language (SQL), adapted for event stream processing.

CCL supports sophisticated data selection and calculation capabilities, including features
such as data grouping, aggregations, and joins. However, CCL also includes features that are
required to manipulate data during real-time continuous processing, such as windows on data
streams, and pattern and event matching.

The key distinguishing feature of CCL is its ability to continuously process dynamic data. A
SQL query typically executes only once each time it is submitted to a database server and must
be resubmitted every time a user or an application needs to reexecute the query. By contrast, a
CCL query is continuous. Once it is defined in the project, it is registered for continuous
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CHAPTER 1: Introduction

execution and stays active indefinitely. When the project is running on the ESP Server, a
registered query executes each time an event arrives from one of its datasources.

Although CCL borrows SQL syntax to define continuous queries, the ESP server does not use
a SQL query engine. Instead, it compiles CCL into a highly efficient byte code that is used by
the ESP server to construct the continuous queries within the data-flow architecture.

CCL queries are converted to an executable form by the CCL compiler. ESP servers are
optimized for incremental processing, hence the query optimization is different than for
databases. Compilation is typically performed within Event Stream Processor Studio, but it
can also be performed by invoking the CCL compiler from the command line.

SPLASH

Stream Processing LAnguage SHell (SPLASH) is a scripting language that brings
extensibility to CCL, allowing you to create custom operators and functions that go beyond
standard SQL.

The ability to embed SPLASH scripts in CCL provides tremendous flexibility, and the ability
to do it within the CCL editor maximizes user productivity. SPLASH also allows you to define
any complex computations that are easier to define using procedural logic rather than a
relational paradigm.

SPLASH is a simple scripting language comprised of expressions used to compute values
from other values, as well as variables, and looping constructs, with the ability to organize
instructions in functions. SPLASH syntax is similar to C and Java, though it also has
similarities to languages that solve relatively small programming problems, such as AWK or
Perl.

Authoring Methods

SAP Sybase Event Stream Processor Studio provides visual and text authoring environments
for developing projects.

In the visual authoring environment, you can develop projects using graphical tools to define
streams and windows, connect them, integrate with input and output adapters, and create a
project consisting of queries.

In the text authoring environment, you can develop projects in the Continuous Computation
Language (CCL), as you would in any text editor. Create data streams and windows, develop
queries, and organize them in hierarchical modules and projects.

You can easily switch between the Visual editor and the CCL editor at any time. Changes made
in one editor are reflected in the other. You can also compile projects within Studio.
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CHAPTER 1: Introduction

In addition to its visual and text authoring components, Studio includes environments for
working with sample projects, and for running and testing applications with a variety of
debugging tools. Studio also lets you record and playback project activity, upload data from
files, manually create input records, and run ad hoc queries against the server.

If you prefer to work from the command line, you can develop and run projects using the
esp_server, esp_client, and esp_compiler commands. For a full list of Event Stream

Processor utilities, see the Utilities Guide.
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CHAPTER 2 CCL Project Basics

ESP projects are written in CCL, a SQL-like language which specifies a data flow (by defining
streams, windows, operations, and connections), and provides the capability to incorporate
functions written in other languages, such as SPLASH, to handle more complex
computational work.

Events

A business event is a message that contains information about an actual business event that
occurred. Many business systems produce streams of such events as things happen.

You can use streams, windows, and delta streams with adapters to create complex projects.
Streams, windows, and delta streams allow you to consume and process input events and
generate output events.

Examples of business events that are often transmitted as streams of event messages include:

« Financial market data feeds that transmit trade and quote events, where each event may
consist of ticket symbol, price, quantity, time, and so on

« Radio Frequency ldentification System (RFID) sensors that transmit events indicating that
an RFID tag was sensed nearby

« Click streams, which transmit a message (a click event) each time a user clicks a link,
button, or control on a Web site

« Database transaction events, which occur each time a record is added to a database or
updated in a database

Event Blocks

Business events can be published into an ESP model in collections called Event Blocks,
improving the performance of your ESP model. Event blocks come in two different types:
envelopes and transactions. As an event block is being processed by a window, resulting rows
are not sent downstream immediately. Instead, they are stored until the last event of the block
is processed, and the resulting events are then sent downstream. Event blocks have the
following properties:

» Envelopes:
» Eachrowinanenvelope is treated atomically; a failure in an event does not discard the
envelope. This behavior is useful if a model's performance is important, but not
necessarily the integrity of the data.

« Transactions:
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CHAPTER 2: CCL Project Basics

» Atransaction will be discarded if any one event in the block fails. This behavior can be
used to guarantee that logical blocks of events are completely error-free.

» Before a transaction block is sent downstream, all events in the transaction are
compressed as much as possible. For example, an event with an insert and then an
update will compress down to a single insert with updated values.

Operation Codes

The operation code (opcode) of an event record specifies the action to perform on the
underlying store of a window for that event.

In many Event Stream Processor use cases, events are independent of each other: each carries
information about something that happened. In these cases, a stream of events is a series of
independent events. If you define a window on this type of event stream, each incoming event
is inserted into the window. If you think of a window as a table, the new event is added to the
window as a new row.

In other use cases, events deliver new information about previous events. The ESP Server
needs to maintain a current view of the set of information as the incoming events continuously
update it. Two common examples are order books for securities in capital markets, and open
orders in a fulfillment system. In both applications, incoming events may indicate the need
to:

« Add an order to the set of open orders,

» Update the status of an existing open order, or,

* Remove a cancelled or filled order from the set of open orders.

To handle information sets that are updated by incoming events, Event Stream Processor
recognizes the following opcodes in incoming event records:

e insert —Insert the event record.

* update—Update the record with the specified key. If no such record exists, it is a runtime
error.

» delete— Delete the record with the specified key. If no such record exists, it is a runtime
error.

« upsert —Ifarecord with a matching key exists, update it. If a record with a matching key
does not exist, insert this record.

» safedelete—Ifarecord with amatching key exists, delete it. Ifa record with a matching key
does not exist, do nothing.

All event records include an opcode. Each stream or window in the project accepts incoming
event records and outputs event records. Output events, including opcodes, are determined by
their source (stream, window, or delta stream) and the processing specified for it.
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CHAPTER 2: CCL Project Basics

Refer to the Streams, Windows, and Delta Streams topics in the Programmers Guide for
details on how each interprets the opcodes on incoming event records and generates opcodes
for output records.

Streams

Streams subscribe to incoming events and process the event data according to the rules you
specify (which can be thought of as a ""continuous query") to publish output events. Because
they are stateless, they cannot retain data.

Streams can be designated as input or derived. Derived streams are either output or local. Input
streams are the point at which data enters the project from external sources via adapters. A
project may have any number of input streams. Input streams do not have continuous queries
attached to them, although you can define filters for them.

Because a stream does not have an underlying store, the only thing it can do with arriving input
events is insert them. Insert, update, and upsert opcodes are all treated as inserts. Delete and
safedelete are ignored. The only opcode that a stream can include in output event records is
insert.

Local and output streams take their input from other streams or windows, rather than from
adapters, and they apply a continuous query to produce their output. Local streams are
identical to output streams, except that local streams are hidden from outside subscribers.
Thus, a subscriber cannot subscribe to a local stream. You cannot create primary keys for
streams. You cannot monitor or subscribe to local streams in ESP Studio.

Windows

A window is a stateful element that can be named or unnamed, and retains rows based on a
defined retention policy.

You create a window if you need data to retain state. To create a Window, open the Streams
and Windows compartment in the Visual editor in SAP Sybase Event Stream Processor
Studio and click Input Window. When creating the window, and to retain rows, you must
assign a primary key.

Since a window is a stateful element, with an underlying store, it can perform any operation
specified by the opcode of an incoming event record. Depending on what changes are made to
the contents of the store by the incoming event and its opcode, a window can produce output
event records with different opcodes.

For example, if the window is performing aggregation logic, an incoming event record with an
insert opcode can update the contents of the store and thus output an event record with an
update opcode. The same could happen in a window implementing a left join.
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CHAPTER 2: CCL Project Basics

A window can produce an output event record with same opcode as the input event record. If,
for example, a window implemented a simple copy or a filter without any additional clauses,
the input and output event records would have the same opcode.

An incoming event record with an insert opcode can produce an output event record with a
delete opcode. For example, a window with a count-based retention policy (say keep 5
records) will delete those records from the store when the sixth event arrives, thus producing
an output event record with a delete opcode.

Retention

A retention policy specifies the maximum number of rows or the maximum period of time that
data are retained in a window.

In CCL, you can specify a retention policy when defining a Window. You can also create an
Unnamed Window by specifying a retention policy on a Window or Delta Stream when it is
used as a source to another element.

Retention is specified through the KEEP clause. You can limit the number of records in a
window based on either the number, or age, of records in the window. These methods are
referred to as count-based retention and time-based retention, respectively. Or, you can use the
ALL modifier to explicitly specify that the window should retain all records.

Note: If you do not specify a retention policy, the window retains all records. This can be
dangerous: the window can keep growing until all memory is used and the system shuts down.
The only time you should have a window without a KEEP clause is if you know that the
window size will be limited by incoming delete events.

Including the EVERY modifier in the KEEP clause produces a Jumping Window, which deletes
all of the retained rows when the time interval expires or a row arrives that would exceed the
maximum number of rows.

Specifying the KEEP clause with no modifier produces a Sliding Window, which deletes
individual rows once a maximum age is reached or the maximum number of rows are retained.

Note: You can specify retention on input windows (or windows where data is copied directly
fromits source) using either log file-based stores or memory-based stores. For other windows,
you can only specify retention on windows with memory-based stores

Count-based Retention
In a count-based policy, a constant integer specifies the maximum number of rows retained in
the window. You can use parameters in the count expression.

A count-based policy also defines an optional SLACK value, which can enhance performance
by requiring less frequent cleaning of memory stores. A SLACK value accomplishes this by
ensuring that there are no more than N + S rows in the window, where N is the retention size
and S is the SLACK value. When the window reaches N + S rows, the system purges S rows.
The larger the SLACK value, the better the performance, since there is less cleaning required.
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CHAPTER 2: CCL Project Basics

Note: The SLACK value cannot be used with the EVERY modifier, and thus cannot be used in
a Jumping Windows retention policy.

The default value for SLACK is 1, which means that after the window reaches the maximum
number of records, every new record inserted deletes the oldest record. This causes a
significant impact on performance. Larger slack value s improve performance by reducing the
need to constantly delete rows.

Count-based retention policies can also support retention based on content/column values
using the PER sub-clause. A PER sub-clause can contain an individual column or a comma-
delimited list of columns. A column can only be used once in a PER sub-clause. Specifying the
primary key or autogenerate columns as a column in the PER sub-clause will result in a
compiler warning. This is because these are unique entities for which multiple values cannot
be retained.

The following example creates a Sliding Window that retains the most recent 100 records that
match the filter condition. Once there are 100 records in the window, the arrival of a new
record causes the deletion of the oldest record in the window.

CREATE WINDOW Lastl00Trades PRIMARY KEY DEDUCED
KEEP 100 ROWS

AS SELECT * FROM Trades

WHERE Trades.Volume > 1000;

Adding the SLACK value of 10 means the window may contain as many as 110 records before
any records are deleted.

CREATE WINDOW Lastl100Trades PRIMARY KEY DEDUCED

KEEP 100 ROWS SLACK 10

AS SELECT * FROM Trades
WHERE Trades.Volume > 1000;

This example creates a Jumping Window named TotalCost from the source stream Trades.
This window will retain a maximum of ten rows, and delete all ten retained rows on the arrival
of a new row.
CREATE WINDOW TotalCost
PRIMARY KEY DEDUCTED
AS SELECT

twel, ¥,

trd.Price * trd.Size TotalCst

FROM Trades trd
KEEP EVERY 10 ROWS;

The following example creates a sliding window that retains 2 rows for each unique value of
Symbol. Once 2 records have been stored for any unique Symbol value, arrival of a third
record (with the same Symbol value) will result in deletion of the oldest stored record with the
same Symbol value.

CREATE SCHEMA TradesSchema (

Id integer,
TradeTime date,
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CHAPTER 2: CCL Project Basics

Venue string,
Symbol string,
Price float,
Shares integer )

’

CREATE INPUT WINDOW TradesWinl
SCHEMA TradesSchema
PRIMARY KEY (Id)

KEEP 2 ROWS PER (Symbol)

Time-based Retention

In a Sliding Windows time-based policy, a constant interval expression specifies the
maximum age of the rows retained in the window. In a Jumping Window time-based retention
policy, all the rows produced in the specified time interval are deleted after the interval has
expired.

The following example creates a Sliding Window that retains each record received for ten
minutes. As each individual row exceeds the ten minute retention time limit, it is deleted.
CREATE WINDOW RecentPositions PRIMARY KEY DEDUCED

KEEP 10 MINS
AS SELECT * FROM Positions;

This example creates a Jumping Window named Win1 that keeps every row that arrives within
the 100 second interval. When the time interval expires, all of the rows retained are deleted.
CREATE WINDOW Winl

PRIMARY KEY DEDUCED

AS SELECT * FROM Sourcel
KEEP EVERY 100 SECONDS;

The PER sub-clause supports content-based data retention, wherein data is retained for a
specific time period (specified by an interval) for each unique column value/combination. A
PER sub-clause can contain a single column or a comma-delimited list of columns, but you
can use each column only once in the same PER clause.

Note: Time based windows retain data for a specified time regardless of their grouping.

The following example creates a jumping window that retains 5 seconds worth of data for each
unique value of Symbol.

CREATE SCHEMA TradesSchema (
Id integer,
TradeTime date,
Venue string,

Symbol string,
Price float,
Shares integer )

’

CREATE INPUT WINDOW TradesWin2
SCHEMA TradesSchema

10
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PRIMARY KEY (Id)
KEEP EVERY 5 SECONDS PER (Symbol)

’

Retention Semantics

When the insertion of one or more new rows into a window triggers deletion of preexisting
rows (due to retention), the window propagates the inserted and deleted rows downstream to
relevant streams and subscribers. However, the inserted rows are placed before the deleted
rows, since the inserts trigger the deletes.

Aging Policy

An aging policy can be set to flag records that have not been updated within a defined interval.
This is useful for detecting records that may be stale. Aging policies are an advanced, optional
feature for a window or other stateful element.

Named Windows

A named window is explicitly created using a CREATE WINDOW statement, and can be
referenced in other queries.

Named windows can be classed as input or derived. Derived windows are either output or
local. An input window can send and receive data through adapters. An output window can
send data to an adapter. Both input and output windows are visible externally and can be
subscribed to or queried. A local window is private and invisible externally. When a qualifier
for the window is missing, it is presumed to be of type local.

Table 2. Named Window Capabilities

Type Receives Data From | Sends Data To | Visible Externally

input Input adapter or external | Other windows, delta | Yes
application that sends da- | streams, and/or out-
ta into ESP using the ESP | put adapters

SDK
output Other windows, streams, | Other windows, delta | Yes
or delta streams streams, and/or out-
put adapters
local Other windows, streams, | Other windows or No
or delta streams delta streams

Unnamed Windows

An unnamed window is an implicitly created stateful element that cannot be referenced or
used elsewhere in a project.

Anunnamed window is implicitly created when the KEEP clause is used with a source name in
the FROM clause of a statement.
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CHAPTER 2: CCL Project Basics

Note: On a Delta Stream, only unnamed windows can be created by specifying the KEEP
clause in the FROM clause.

Anunnamed window is implicitly created when the KEEP clause is used with a source name in
the FROM clause of a statement. On a Delta Stream, only unnamed windows can be created by
specifying the KEEP clause in the FROM clause.

Examples

This example creates an unnamed window on the input Trades for the MaxTradePrice
window to keep track of a maximum trade price for all symbols seen within the last 10000
trades:

CREATE WINDOW MaxTradePrice

PRIMARY KEY DEDUCED

STORE S1

AS SELECT trd.Symbol, max(trd.Price) MaxPrice
FROM Trades trd KEEP 10000 ROWS

GROUP BY trd.Symbol;

This example creates an unnamed window on Trades, and MaxTradePrice Keeps track
of the maximum trade price for all the symbols during the last 10 minutes of trades:

CREATE WINDOW MaxTradePrice

PRIMARY KEY DEDUCED

STORE S1

AS SELECT trd.Symbol, max(trd.Price) MaxPrice
FROM Trades trd KEEP 10 MINUTES

GROUP BY trd.Symbol;

This example creates a TotalCost Unnamed Window from the source stream Trades. Jumping
Window will retain ten rows, and clear all rows on the arrival of the 11th row.

CREATE DELTA STREAM TotalCost
PRIMARY KEY DEDUCTED
AS SELECT
trd.x*,
trd.Price * trd.Size TotalCst
FROM Trades trd
KEEP EVERY 10 ROWS;

In all three examples, Trades can be a delta stream, or a window.

Delta Streams

Delta streams are stateless elements that can understand all opcodes. Unlike streams, they are
not limited to inserts and updates.

Delta streams can be classed as derived streams. Derived streams are either output or local. A
delta stream is derived from an existing stream or window and is not an input stream. You can
use a delta stream anywhere you use a computation, filter, or union, but do not need to maintain
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a state. A delta stream performs these operations more efficiently than a window because it
keeps no state, thereby reducing memory use and increasing speed.

You must provide a primary key for delta streams. Delta streams are allowed key
transformations only when performing aggregation, join, or flex operations. Because a delta
stream does not maintain state, you cannot define a delta stream on a window where the keys
differ.

While a delta stream does not maintain state, it can interpret all of the opcodes in incoming
event records. The opcodes of output event records depend on the logic implemented by the
delta stream.

Example
This example creates a delta stream named DeltaTrades that incorporates the getrowid
and now functions.

CREATE LOCAL DELTA STREAM DeltaTrades
SCHEMA (
RowId long,
Symbol STRING,
Ts bigdatetime,
Price MONEY (2),
Volume INTEGER,
ProcessDate bigdatetime )
PRIMARY KEY (Ts)
AS SELECT getrowid ( TradesWindow) RowId,
TradesWindow.Symbol,
TradesWindow.Ts Ts,
TradesWindow.Price,
TradesWindow.Volume,
now () ProcessDate
FROM TradesWindow

CREATE OUTPUT WINDOW TradesOut

PRIMARY KEY DEDUCED
AS SELECT * FROM DeltaTrades ;

Comparing Streams, Windows, and Delta Streams

Streams, windows, and delta streams offer different characteristics and features, but also share
common designation, visibility, and column parameters.

The terms stateless and stateful commonly describe the most significant difference between
windows and streams. A stateful element has the capacity to store information, while a
stateless element does not.
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tention policy)

Feature Capabili- | Streams Windows Delta Streams
ty
Type of element Stateless Stateful, due to reten- | Stateless
tion and store capabili-
ties
Data retention None Yes, rows (based on re- | None

Available store types

Not applicable

Memory store or log
store

Not applicable

Element types that can
be derived from this el-
ement

Stream or a Window
with an aggregation
clause (GROUP BY)

Stream, Window, Delta
Stream

Stream, Window, Delta
Stream

tion operations

Primary key Required | No Yes, explicit or de- Yes, explicit or de-
duced duced
Support for aggrega- No Yes No

Behavior on receiving
update

Receives and produces
insert

Receives and produces
update

Receives and produces
update

Behavior on receiving
insert

Receives and produces
insert

Receives and produces
insert

Receives and produces
insert

Behavior on receiving
delete

Receives but ignores

Receives and produces
delete

Receives and produces
delete

Streams, windows, and delta streams share several important characteristics, including
implicit columns and visibility rules.

Bindings on Streams, Delta Streams, and Windows

Bindings enable data to flow between projects. When you create a binding, a stream, delta
stream, or window in one project subscribes or publishes to a stream, delta stream, or window

in another project.

A binding is a named connection from an output stream (or delta stream or window) of one
project to an input stream (or delta stream or window) of another.

Bindings reside in the CCR project configuration file so you can change them at runtime. The
streams being bound must have compatible schemas.

14

SAP Sybase Event Stream Processor




CHAPTER 2: CCL Project Basics

Example: Binding to a Stream on an SSL-Enabled Cluster

This example shows a binding called BaselnputBinding that connects a local input stream
called sinto aremote output stream that is also called sin. When the SSL protocol is enabled on
the manager node of the data source stream’s cluster, the <Manager> element that specifies
the cluster hostname and port in the CCR file must include the https:// prefix, as shown here. If
you omit the https:// prefix, the binding cannot pass data, so the input stream will not receive
anything.
<Configuration>
<Runtime>
<Clusters>
<Cluster name="clusterl" type="remote">
<Username>USER NAME</Username>
<Password>PASSWORD</Password>
<Managers>
<Manager>https://CLUSTER MANAGER HOSTNAME :
CLUSTER MANAGER RPC_ PORT</Manager>
<!-- use https:// when SSL is enabled -->
</Managers>
</Cluster>
</Clusters>

<Bindings>
<Binding name="sin">
<Cluster>clusterl</Cluster>
<Workspace>ws2</Workspace>
<Project>prj2</Project>
<BindingName>BaseInputBinding</BindingName>
<RemoteStream>sin</RemoteStream>
</Binding>
</Bindings>
</Runtime>
</Configuration>

Input/Output/Local

You can designate streams, windows, and delta streams as input or derived. Derived streams,
including delta streams, are either output or local.

Input/Output Streams and Windows

Input streams and windows can accept data from a source external to the project using an input
adapter or by connecting to an external publisher. You can attach an output adapter or connect
external subscribers directly to an input window or input stream. You can also use the SQL
interface to SELECT rows from an input window, INSERT rows in an input stream or INSERT/
UPDATE/DELETE rows in an input window.

Output windows, streams and delta streams can publish data to an output adapter or an
external subscriber. You can use the SQL interface to query (that is SELECT) rows from an
output window.
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Local streams, windows, and delta streams are invisible outside the project and cannot have
input or output adapters attached to them. You cannot subscribe to or use the SQL interface to
query the contents of local streams, windows, or delta streams.

Examples
This is an input stream with a filter:
CREATE SCHEMA mySchema (Coll INTEGER, Col2 STRING) ;

CREATE INPUT STREAM IStr2 SCHEMA mySchema
WHERE IStr2.Col2='abcd';

This is an output stream:

CREATE OUTPUT STREAM OStrl
AS SELECT A.Coll coll, A.Col2 col2
FROM IStrl A;

This is an input window:

CREATE SCHEMA mySchema (Coll INTEGER, Col2 STRING) ;
CREATE MEMORY STORE myStore;
CREATE INPUT WINDOW IWinl SCHEMA mySchema

PRIMARY KEY (Coll)

STORE myStore;

This is an output window:

CREATE SCHEMA mySchema (Coll INTEGER, Col2 STRING) ;
CREATE MEMORY STORE myStore;
CREATE OUTPUT WINDOW OWinl

PRIMARY KEY (Coll)

STORE myStore

AS SELECT A.Coll coll, A.Col2 col2

FROM IWinl A;

Local Streams and Windows

Use a local stream, window, or delta stream when the stream does not need an adapter, or to
allow outside connections. Local streams, windows, and delta streams are visible only inside
the containing CCL project, which allows for more optimizations by the CCL compiler.
Streams and windows that do not have a qualifier are local.

Note: A local window cannot be debugged because it is not visible to the ESP Studio run/test
tools such as viewer or debugger.

Examples

This is a local stream:

CREATE SCHEMA mySchema (Coll INTEGER, Col2 STRING);
CREATE LOCAL STREAM LStrl

AS SELECT i.Coll coll, i.Col2 col2
FROM IStrl i;

This is a local window:
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CREATE SCHEMA mySchema (Coll INTEGER, Col2 STRING) ;
CREATE MEMORY STORE myStore;
CREATE LOCAL WINDOW LWinl

PRIMARY KEY (Coll)

STORE myStore

AS SELECT i.Coll coll, i.Col2 col2

FROM IStrl i;

Implicit Columns

All streams, windows, and delta streams use three implicit columns called ROWID,
ROWTIME, and BIGROWTIME.

Column Datatype Description

ROWID long Provides a unique row identification number for
each row of incoming data.

ROWTIME date Provides the last modification time as a date with
second precision.

BIGROWTIME bigdatetime Provides the last modification time of the row with
microsecond precision. You can perform filters
and selections based on these columns, like filter-
ing out all of those data rows that occur outside of
business hours.

You can refer to these implicit columns just like any explicit column (for example, using the
stream.column convention).

Schemas

A schema defines the structure of data rows in a stream or window.

Every row in a stream or window must have the same structure, or schema, which includes the
column names, the column datatypes, and the order in which the columns appear. Multiple
streams or windows may use the same schema, but a stream or window can only have one
schema.

There are two ways to create a schema: you can create a named schema using the CREATE

SCHEMA statement or you can create an inline schema within a stream or window definition.
Named schemas are useful when the same schema will be used in multiple places, since any
number of streams and windows can reference a single named schema.

Simple Schema CCL Example

This is an example of a CREATE SCHEMA statement used to create a named schema.
TradeSchema represents the name of the schema.
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CREATE SCHEMA TradeSchema (
Ts BIGDATETIME,
Symbol STRING,
Price MONEY (4),
Volume INTEGER

)

This example uses a CREATE SCHEMA statement to make an inline schema:

CREATE STREAM trades SCHEMA (
Ts bigdatetime,
Symbol STRING,
Price MONEY (4),
Volume INTEGER

Stores

Set store defaults, or choose a log store or memory store to specify how data from a window is
saved.

If you do not set a default store using the CREATE DEFAULT STORE statement, each window
is assigned to a default memory store. You can use default store settings for store types and
locations if you do not assign new windows to specific store types.

Memory Stores

A memory store holds all data in memory. Memory stores retain the state of queries for a
project from the most recent server start-up for as long as the project is running. Because query
state is retained in memory rather than on disk, access to a memory store is faster than to a log
store.

Use the CREATE MEMORY STORE statement to create memory stores. If no default store is
defined, new windows are automatically assigned to a memory store.

Log Stores

The log store holds all data in memory, but also logs all data to the disk, meaning it guarantees
data state recovery in the event of a failure. Use a log store to be able to recover the state of a
window after a restart.

Use the CREATE LOG STORE statement to create a log store. You can also set a log store as a
default store using the CREATE DEFAULT STORE statement, which overrides the default
memory store.

Log store dependency loops are a concern when using log stores, as they cause compilation
errors. Log store loops can be created when you use multiple log stores in a project, and assign
windows to these stores. The recommended way to use a log store is to either assign log stores
to source windows only or to assign all windows in a stream path to the same store. If you use
logstorel for n of those windows, then use 1ogstore2 for a different window, you
should never use 1ogstorel again further down the chain. Put differently, if Window Y
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assigned to Logstore B gets its data from Window X assigned to Logstore A, no window that
(directly or indirectly) gets its data from Window Y should be assigned to Logstore A.

CCL Continuous Queries

Build a continuous query using clauses and operators to specify its function. This section
provides reference for queries, query clauses, and operators.

Syntax

select clause

from clause
[matching clause]
[where clause]
[groupFilter clause]
[groupBy clause]
[groupOrder clause]
[having clause]

Components

select clause

Defines the set of columns to be included in the
output. See below and SELECT Clause for more
information.

from clause

Selects the source data is derived from. See below
and FROM Clause for more information.

matching clause

Used for pattern matching. See MATCHING
Clause and Pattern Matching for more informa-
tion.

where clause

Performs a filter. See WHERE Clauseand Filters
for more information.

groupFilter clause

Filters incoming data in aggregation. See
GROUP FILTER Clause and Aggregation for
more information.

groupBy clause

Specifies what collection of rows to use the ag-
gregation operation on. See GROUP BY Clause
and Aggregation for more information.

groupOrder clause

Orders the data in a group before aggregation. See
GROUP ORDER BY Clauseand Aggregationfor
more information.

Programmers Guide
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having clause Filters data that is output by the derived compo-
nents in aggregation. See HAVING Clause and
Aggregation for more information.

Usage

CCL queries are embedded in theCREATE STREAM, CREATE WINDOW, and CREATE DELTA
STREAM statements, and are applied to the inputs specified in the FROM clause of the query
todefine the contents of the new stream or window. The example below demonstrates the use
of both the SELECT clause and the FROM clause as would be seen in any query.

The SELECT clause is used directly after the AS clause. The purpose of the SELECT clause is
to determine which columns from the source or expressions the query is to use.

Following the SELECT clause, the FROM clause names the source used by the query.
Following the FROM clause, implement available clauses to use filters, unions, joins, pattern
matching, and aggregation on the queried data.

Example
This example obtains the total trades, volume, and VWAP per trading symbol in five minute
intervals.

[...]
SELECT
g.Symbol,
(trunc (q.TradeTime) + (((g.TradeTime - trunc(q.TradeTime)) /
300) *300)) FiveMinuteBucket,
sum (gq.Shares * g.Price)/sum(qg.Shares) Vwap,
count (*) TotalTrades,
sum (g.Shares) TotalVolume
FROM
QTrades g
[...]

Adapters

Adapters connect the Event Stream Processor to the external world.

An input adapter connects an input stream or window to a data source. It reads the data output
by the source and modifies it for use in an ESP project.

An output adapter connects an output stream or window to a data sink. It reads the data output
by the ESP project and modifies it for use by the consuming application.

Adapters are attached to input streams and windows, and output streams and windows, using
the ATTACH ADAPTER statement and they are started using the ADAPTER START statement.
In some cases it may be important for a project to start adapters in a particular order. For

example, it might be important to load reference data before attaching to a live event stream.
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Adapters can be assigned to groups and the ADAPTER START statement can control the start
up sequence of the adapter groups.

See the Adapters Guide for detailed information about configuring individual adapters,
datatype mapping, and schema discovery.

Order of Elements

Determine the order of CCL project elements based on clause and statement syntax definitions
and limitations.

Define CCL elements that are referenced by other statements or clauses before using those
statements and clauses. Failure to do so causes compilation errors.

For example, define a schema using a CREATE SCHEMA statement before a CCL CREATE
STREAM statement references that schema by name. Similarly, declare parameters and
variables in a declare block before any CCL statements or clauses reference those parameters
or variables.

You cannot reorder subclause elements within CCL statements or clauses.
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CHAPTER 3 Developing a Project in CCL

Use the CCL Editor in SAP Sybase Event Stream Processor Studio, or another supported
editor, to create and modify your CCL code. Start by developing a simple project, and test it
iteratively as you gradually add greater complexity.

For details of these high-level steps, see the rest of this CCL Programmers Guide, as well as the
Studio Users Guide, the Adapters Guide, and the Programmers Reference.

1

© 0k~ wbd

~

Create a . cc1 file.

Creating a project in SAP Sybase Event Stream Processor Studio creates the . cc1 file
automatically.

Add input streams and windows.

Add output streams and windows with simple continuous queries.

Attach adapters to streams and windows to subscribe to external sources or publish output.
Compile the CCL code.

Run the compiled project against test data, using the debugging tools in SAP Sybase Event
Stream Processor Studio and command line utilities.

Repeat this step as often as needed.

Add queries to the project. Start with simple queries and gradually add complexity.
(Optional) Use functions in your continuous queries to perform mathematical operations,
aggregations, datatype conversions, and other common tasks:

* Built-in functions for many common operations

» User-defined functions written in the SPLASH programming language

» User-defined external functions written in C/C++ or Java

(Optional) Create named schemas to define a reusable data structure for streams or
windows.

10. (Optional) Create memory stores or log stores to retain the state of data windows in

memory or on disk.

11. (Optional) Create modules to contain reusable CCL that can be loaded multiple timesina

project.
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To ensure proper language use in your CCL projects, familiarize yourself with rules on case-
sensitivity, supported datatypes, operators, and expressions used in CCL.

Datatypes

SAP Sybase Event Stream Processor supports integer, float, string, money, long, and
timestamp datatypes for all of its components.

Datatype Description

integer A signed 32-bit integer. The range of allowed values is -2147483648 to
+2147483647 (-23! to 231-1), Constant values that fall outside of this
range are automatically processed as long datatypes.

To initialize a variable, parameter, or column with a value of
-2147483648, specify (-2147483647) -1 to avoid CCL compiler errors.

long A signed 64-bit integer. The range of allowed values is
-9223372036854775808 to +9223372036854775807 (-2%3 to 263-1),

To initialize a variable, parameter, or column with a value of
-9223372036854775808, specify (-9223372036854775807) -1 to
avoid CCL compiler errors.

float A 64-bit numeric floating point with double precision. The range of
allowed values is approximately -10398 through +10308,

string Variable-length character string, with byte values encoded in UTF-8.
Maximum string length is platform-dependent, with a size limit of 2
gigabytes.

money A legacy datatype maintained for backward compatibility. It is a signed

64-bit integer that supports 4 digits after the decimal point. Currency
symbols and commas are not supported in the input data stream.
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Datatype

Description

money (n)

A signed 64-bit numerical value that supports varying scale, from 1 to
15 digits after the decimal point. Currency symbols and commas are not
supported in the input data stream, however, decimal points are.

The supported range of values change, depending on the specified scale.
money (1) :-922337203685477580.8 to 922337203685477580.7
money (2) :-92233720368547758.08 to 92233720368547758.07
money (3):-9223372036854775.808 to 9223372036854775.807
money (4):-922337203685477.5808 to 922337203685477.5807
money (5) :-92233720368547.75808 to 92233720368547.75807
money (6) :-92233720368547.75808 to 92233720368547.75807
money (7):-922337203685.4775808 to 922337203685.4775807
money (8):-92233720368.54775808 to 92233720368.54775807
money (9) : -9223372036.854775808 to 9223372036.854775807
money (10) :-922337203.6854775808 to 922337203.6854775807
money (11):-92233720.36854775808 to 92233720.36854775807
money (12) :-9223372.036854775808 to 9223,372.036854775807
money (13):-922337.2036854775808 to 922337.2036854775807
money (14):-92233.72036854775808 to 92233.72036854775807
money (15) :-9223.372036854775808 to 9223.372036854775807

To initialize a variable, parameter, or column with a value of
-92,233.72036854775807, specify (-9...7) -1 to avoid CCL compiler
errors.

Specify explicit scale for money constants with Dn syntax, where n
represents the scale. For example, 100.1234567D7, 100.12345D5.

Implicit conversion between money (n) types is not supported be-
cause there is arisk of losing range or scale. Perform the cast function to
work with money types that have different scale.
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Datatype Description

bigdatetime Timestamp with microsecond precision. The default format is YYYY-
MM-DDTHH:MM:SS:SSSSSS.

All numeric datatypes are implicitly cast to bigdatetime.

The rules for conversion vary for some datatypes:

e Allboolean, integer, and 1ong values are converted in
their original formatto bigdatetime.

e Only the whole-number portions of money (n) and float
values are converted to bigdatet ime. Use the cast function to
convertmoney (n) and float valuesto bigdatetime
with precision.

* All date values are multiplied by 1000000 and converted to mi-
croseconds to satisfy bigdatetime format.

¢ All timestamp values are multiplied by 1000 and converted to
microseconds to satisfy bigdatetime format.

timestamp Timestamp with millisecond precision. The default format is YYY'Y-
MM-DDTHH:MM:SS:SSS.

date Date with second precision. The default format is YYYY-MM-
DDTHH:MM:SS.
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Datatype Description

interval A signed 64-bit integer that represents the number of microseconds
between two timestamps. Specify an interwval using multiple units
in space-separated format, for example, "5 Days 3 hours 15 Minutes".
External data that is sent to an interval column is assumed to be in
microseconds. Unit specification is not supported for interval
values converted to or from st ring data.

Whenan interval isspecified, the given interval must fitin a 64-bit
integer (1 ong) when it is converted to the appropriate number of
microseconds. For each interwval unit, the maximum allowed val-
ues that fit in a long when converted to microseconds are:

*  MICROSECONDS (MICROSECOND, MICROS): +/-
9223372036854775807

e MILLISECONDS (MILLISECOND, MILLIS): +/-
9223372036854775

+ SECONDS(SECOND, SEC): +/- 9223372036854
«  MINUTES(MINUTE, MIN): +/- 153722867280
«  HOURS(HOUR,HRY): +/- 2562047788

«  DAYS(DAY): +/- 106751991

The values in parentheses are alternate names foran interwval unit.
When the maximum value for a unit is specified, no other unit can be
specified or it causes an overflow. Each unit can be specified only once.

binary Represents a raw binary buffer. Maximum length of value is platform-
dependent, with a size limit of 2 gigabytes. NULL characters are per-
mitted.
boolean Value is true or false. The format for values outside of the allowed range
forboolean is 0/1/false/true/y/n/on/off/yes/no, which is case-insen-
sitive.
Intervals

Interval syntax supports day, hour, minute, second, millisecond, and microsecond values.

Intervals measure the elapsed time between two timestamps, using 64 bits of precision. All
occurrences of intervals refer to this definition:

value | {value [ {DAY[S] | {HOUR[S] | HR} | MIN[UTE[S]] | SEC[OND[S]]

| {MILLISECOND[S] | MILLIS} | {MICROSECOND[S] | MICROS} ] [...]1}

If only value is specified, the timestamp default is MICROSECOND[S]. You can specify
multiple time units by separating each unit with a space, however, you can specify each unit
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only once. For example, if you specify HOUR[S], MIN[UTE[S] ], and SEC[OND[S] ]
values, you cannot specify these values again in the interval syntax.

Each unit has a maximum value when not combined with another unit:

Time Unit Maximum Value Allowed
MICROSECOND[S] | MICROS 9,223,372,036,854,775,807
MILLISECOND[S] | MILLIS 9,233,372,036,854,775

SEC[OND[S]]

9,223,372,036,854,775

MIN[UTE[S]]

153,722,867,280,912

HOUR[S] | HR

2,562,047,788,015

DAY [S]

106,751,991,167

These maximum values decrease when you combine units.

Specifying value with a time unit means it must be a positive value. If value is negative, it
is treated as an expression. Thatis, -10 MINUTES in the interval syntax is treated as — (10
MINUTES). Similarly, 10 MINUTES-10 SECONDS istreatedas (10 MINUTES) - (10
SECONDS).

The time units can be specified only in CCL. When specifying values for the interval column
using the API or adapter, only the numeric value can be specified and is always sent in
microseconds.

Examples
3 DAYS, 1 HOUR, 54 MINUTES

2 SECONDS, 12 MILLISECONDS, 1 MICROSECOND

Operators

CCL supports a variety of numeric, nonnumeric, and logical operator types.

Arithmetic Operators

Arithmetic operators are used to negate, add, subtract, multiply, or divide numeric values.
They can be applied to numeric types, but they also support mixed numeric types. Arithmetic
operators can have one or two arguments. A unary arithmetic operator returns the same
datatype as its argument. A binary arithmetic operator chooses the argument with the highest

numeric precedence, implicitly converts the remaining arguments to that data-type, and
returns that type.
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Preincrement (++argument) value is incremented before it
is passed as an argument

Postincrement (argument++) value is passed and then in-
cremented

Operator | Meaning Example Usage
+ Addition 3+4

- Subtraction 7-3

* Multiplication 3*4

/ Division 8/2

% Modulus (Remainder) 8%3

A Exponent 43

- Change signs -3

++ Increment

++a (preincrement)

a++ (postincre-
ment)

Decrement

Predecrement (--argument) value is decremented before it
is passed as an argument

Postdecrement (argument--) value is passed and then de-
cremented

--a (predecrement)

a-- (postdecrement)

Comparison Operators
Comparison operators compare one expression to another. The result of such a comparison
can be TRUE, FALSE, or NULL.

Comparison operators use this syntax:

expressionl comparison operator expression2

Operator | Meaning Example Us-
age

= Equality a0=al

1= Inequality a0l=al

< Inequality a0<>al

> Greater than a0!>al

>= Greater than or equal to a0l>=al
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Operator | Meaning Example Us-
age
< Less than all<al
<= Less than or equal to a0l<=al
IN Member of a list of values. If the value is in the expression list's | a0 IN (al, a2, a3)
values, then the result is TRUE.

Logical Operators

Operator |Meaning Example Usage

AND Returns TRUE if all expressions are TRUE, and FALSE oth- | (a < 10) AND (b >
erwise. 12)

NOT Returns TRUE if all expressions are FALSE, and TRUE oth- | NOT (a=5)
erwise.

OR Returns TRUE if any of the expressions are TRUE, and (b=8)OR (b=6)
FALSE otherwise.

XOR Returns TRUE if one expression is TRUE and the other is (b=8) XOR (a>14)
FALSE. Returns FALSE if both expressions are TRUE or both
are FALSE.

String Operators

Operator

Meaning

Example Usage

+

Concatenates strings and returns another string.

Note: The + operator does not support mixed datatypes (such
as an integer and a string).

'go’ + ‘cart'

LIKE Operator

May be used in column expressions and WHERE clause expressions. Use the LIKE operator to
match string expressions to strings that closely resemble each other but do not exactly match.
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Operator

Syntax and Meaning

Example Usage

LIKE

Matches WHERE clause string expressions to strings that
closely resemble each other but do not exactly match.

compare_expression LIKE pat-
tern match expression

The LIKE operator returns a value of TRUE if compare_ex-
pression matches pattern_match_expression, or FALSE if
it does not. The expressions can contain wildcards, where the
percent sign (%) matches any length string, and the under-
score (_) matches any single character.

Trades.StockName
LIKE "%Corp%"

[] Operator

The [] operator is only supported in the context of dictionaries and vectors.

Operator

Syntax and Meaning

Example Usage

I

Allows you to perform functions on rows other than the cur-
rent row in a stream or window.

stream-or-window-name [index] .column

stream-or-window-name is the name of a stream or window
and column indicates a column in the stream or window.
index isan expression that can include literals, parameters, or
operators, and evaluates to an integer. This integer indicates
the stream or window row, in relation to the current row or to
the window's sort order.

MyNamedWind-
ow[1].MyColumn

Order of Evaluation for Operators
When evaluating an expression with multiple operators, the engine evaluates operators with
higher precedence before those with lower precedence. Those with equal precedence are

evaluated from left to right within an expression. You can use parentheses to override operator
precedence, since the engine evaluates expressions inside parentheses before evaluating those
outside.

Note: The ~ operator is right-associative. Thus,a”b”*c=a” (b”c), not (a”b) " c.

The operators in order of preference are as follows. Operators on the same line have the same

precedence:

+.- (as unary operators)

AN

* 1, %

+, - (as binary operators and for concatenation)
=, 1=, <>, <, >, <=, >= (comparison operators)
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e LIKE, IN, ISNULL, IS NOT NULL
« NOT

« AND

* OR, XOR

Expressions

An expression is a combination of one or more values, operators, and built in functions that
evaluate to a value.

An expression often assumes the datatype of its components. You can use expressions in many
places including:

e Column expressions in a SELECT clause
« A condition of the WHERE clause or HAVING clause

Expressions can be simple or compound. A built-in function such aslength() or pi() can also be
considered an expression.

Simple Expressions

A simple CCL expression specifies a constant, NULL, or a column. A constant can be a
number or a text string. The literal NULL denotes a null value. NULL is never part of another
expression, but NULL by itself is an expression.

You can specify a column name by itself or with the name of its stream or window. To specify
both the column and the stream or window, use the format "stream_name.column_name."

Some valid simple expressions include:

¢ stocks.volume
e 'this is a string'
e« 26

Compound Expressions

A compound CCL expression is a combination of simple or compound expressions.
Compound expressions can include operators and functions, as well as the simple CCL
expressions (constants, columns, or NULL).

You can use parentheses to change the order of precedence of the expression's components.
Some valid compound expressions include:

e sgrt (9) + 1
e ('example' + 'test' + 'string')
¢ ( length ('example') *10 ) + pi()
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Sequences of Expressions

An expression can contain a sequence of expressions; separated by semicolons and grouped
using parentheses, to be evaluated in order. The type and value of the expression is the type and
value of the last expression in the sequence. For example,

e (varl := v.Price; var2 := v.Quantity; 0.0)

sets the values of the variables varl and var2, and then returns the value 0. 0.

Conditional Expressions

A conditional CCL expression evaluates a set of conditions to determine its result. The
outcome of a conditional expression is evaluated based on the conditions set. In CCL, the
keyword CASE appears at the beginning of these expressions and follows a WHEN-THEN-
ELSE construct.

The basic structure looks like this:

CASE
WHEN expression THEN expression
[ ]

ELSE expression
END

The first WHEN expression is evaluated to be either zero or non-zero. Zero means the
condition is false, and non-zero indicates that it is true. If the WHEN expression is true, the
following THEN expression is carried out. Conditional expressions are evaluated based on the
order specified. If the first expression is false, then the subsequent WHEN expression is tested.
If none of the WHEN expressions are true, the ELSE expression is carried out.

A valid conditional expression in CCL is:

CASE

WHEN mark>100 THEN grade:=invalid
WHEN mark>49 THEN grade:=pass
ELSE grade:=fail

END

CCL Comments

Like other programming languages, CCL lets you add comments to document your code.
CCL recognizes two types of comments: doc-comments and regular multi-line comments.

The visual editor in the SAP Sybase Event Stream Processor Studio recognizes a doc-
comment and puts it in the comment field of the top-level CCL statement (such as CREATE
SCHEMA or CREATE INPUT WINDOW) immediately following it. Doc-comments not
immediately preceding a top-level statement are seen as errors by the visual editor with SAP
Sybase Event Stream Processor Studio.
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Regular multi-line comments do not get treated specially by the Studio and may be used
anywhere in the CCL project.

Begin a multi-line comment with /* and complete it with * /. For example:
/*

This is a multi-line comment.

All text within the begin and end tags is treated as a comment.

4

Begin a doc-comment with /** and end it with * /. For example:

/**

This is a doc-comment. Note that it begins with two * characters
instead of one. All text within the begin and end tags is recognized
by the Studio visual editor and associated with the immediately
following statement (in this case the CREATE SCHEMA statement) .

v

CREATE SCHEMA S1

The CREATE SCHEMA statement provided here is incomplete; it is shown only to illustrate
that the doc comment is associated with the immediately following CCL statement.

It is common to delineate a section of code using a row of asterisks. For example:
/*************************************************************

Do not modify anything beyond this point without authorization
**************************************************************/

CCL treats this rendering as a doc-comment because it begins with / * *. To achieve the same
effect using a multi line comment, insert a space between the first two asterisks: /* *.

Case-Sensitivity

Some CCL syntax elements have case-sensitive names while others do not.

All identifiers are case-sensitive. This includes the names of streams, windows, parameters,
variables, schemas, and columns. Keywords are case-insensitive, and cannot be used as
identifier names. Adapter properties also include case-sensitivity restrictions.

Most built-in function names (except those that are keywords) and user-defined functions are
case-sensitive. While the following built-in function names are case-sensitive, you can
express them in two ways:

« setOpcode, setopcode

» getOpcode, getopcode

« setRange, setrange

» setSearch, setsearch

« copyRecord, copyrecord

« deletelterator, deleteiterator
 getlterator, getiterator
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resetlterator, resetiterator
businessDay, businessday
weekendDay, weekendday
expireCache, expirecache
insertCache, insertcache
keyCache, keycache
getNext, getnext
getParam, getparam
datelnt, dateint

intDate, intdate

uniqueld, uniqueid
LeftJoin, leftjoin
valuelnserted, valueinserted

Example
Two variables, one defined as 'aVariable' and one as 'AVariable' can coexist in the same context
as they are treated as different variables. Similarly, you can define different streams or
windows using the same name, but with different cases.
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Use a CCL query to produce a new derived stream or window from one or more other streams/
windows. You can construct a query to filter data, combine two or more queries, join multiple
datasources, use pattern matching rules, and aggregate data.

You can use queries only with derived elements, and can attach only one query to a derived
element. A CCL query consists of a combination of several clauses that indicate the
appropriate information for the derived element. A query is used with the AS clause to specify
data for the derived element.

Filtering

Use the WHERE clause in your CCL query to filter data to be processed by the derived
elements (streams, windows, or delta streams).

Using the WHERE clause and a filter expression, you can filter which incoming data is
accepted by your derived elements. The WHERE clause restricts the data captured by the
SELECT clause, reducing the number of results generated. Only data matching the value
specified in the WHERE clause is sent to your derived elements.

The output of your derived element consists of a subset of records from the input. Each input
record is evaluated against the filter expression. If a filter expression evaluates to false (0), the
record does not become part of the derived element.

This example creates a new window, IBMTrades, where its rows are any of the result rows
from Trades that have the symbol "IBM":

CREATE WINDOW IBMTrades
PRIMARY KEY DEDUCED
AS SELECT * FROM Trades WHERE Symbol = 'IBM';

See also

o Splitting Up Incoming Data on page 38
e Unionson page 39

e Joinson page 40

e Pattern Matching on page 46

» Aggregation on page 47
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Splitting Up Incoming Data

Use the SPLITTER construct to separate incoming data according to filtering rules and write it
out to different target streams.

When you want to separate incoming data into several subsets and process those subsets
differently, use the CREATE SPLITTER construct, which operates like the ANSI case
statement. It reads the incoming data, applies the specified filtering conditions and writes out
each subset of the data to one or more target streams.

The target stream or delta streams are implicitly defined by the compiler. The schema for the
target streams are derived based on the column_list specification. All the targets are defined as
either local or output depending on the visibility clause defined for the splitter. The default is
local. Note that when the splitter has an output visibility, output adapters can be directly
attached to the splitter targets, even though those targets are implicitly defined.

The first condition that evaluates to true (non-zero value) causes the record as projected in the
column_list to be inserted into the corresponding target streams. Subsequent conditions are
neither considered nor evaluated. If the source is a:

« Stream, the targets are also streams.
» Delta stream or window, the targets are delta streams.

If the source is a window or delta stream, the primary keys need to be copied as-is. The other
columns can be changed.

Note: When the source is a window or a delta stream, the warning about unpredictable results
being produced if one of the projections contains a non-deterministic expressions that applies
for delta streams also applies for splitters.

Example

The example creates a schema named TradeSchema and applies that schema to the input
window Trades. IBM_MSFT_Splitter evaluates and routes data to one of three output
windows. Event records with the symbol IBM or MSFT are sent to the
IBM_MSFT_Tradeswin window. Event records where the product of trw.Price *
trw.Volume is greater than 25,000 are sent to the Large_TradesWin window. All event
records that do not meet the conditions placed on the two previous output windows are sent to
the Other_Trades window.

CREATE SCHEMA TradeSchema (

Id long,

Symbol STRING,

Price MONEY (4),

Volume INTEGER,

TradeTime DATE

) g

CREATE INPUT WINDOW Trades

SCHEMA TradeSchema

38

SAP Sybase Event Stream Processor



CHAPTER 5: CCL Query Construction

PRIMARY KEY (Id) ;
CREATE SPLITTER IBM MSFT Splitter
AS

WHEN trw.Symbol IN ('IBM', 'MSFT') THEN IBM MSFT Trades
WHEN trw.Price * trw.Volume > 25000 THEN Large Trades

ELSE Other Trades

SELECT trw. * FROM Trades trw ;
CREATE OUTPUT WINDOW IBM MSFT TradesWin
PRIMARY KEY DEDUCED

AS SELECT * FROM IBM MSFT Trades ;
CREATE OUTPUT WINDOW Large TradesWin
PRIMARY KEY DEDUCED

AS SELECT * FROM Large Trades ;
CREATE OUTPUT WINDOW Other TradesWin
PRIMARY KEY DEDUCED

AS SELECT * FROM Other Trades ;

See also

»  Filtering on page 37

e Unionson page 39

e Joinson page 40

e Pattern Matching on page 46
» Aggregation on page 47

Unions

Use a UNION operator in your CCL query to combine the results of two or more queries into a

single result.

If the UNION is on a Window or Delta Stream, duplicate rows are eliminated from the result
set due to the primary key. If the UNION is on a Stream, duplicates flow through.

The input for a UNION operator comes from one or more streams or windows. Its output is a set
of records representing the union of the inputs. This example shows a simple union between

two windows, InStocks and InOptions:

CREATE INPUT WINDOW InStocks
SCHEMA StocksSchema
Primary Key (Ts)

’

CREATE INPUT WINDOW InOptions
SCHEMA OptionsSchema
Primary Key (Ts)

CREATE output Window Unionl
SCHEMA OptionsSchema
PRIMARY KEY DEDUCED

AS SELECT s.Ts as Ts, s.Symbol as StockSymbol,
Null as OptionSymbol, s.Price as Price,

Volume

s.Volume

as
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FROM InStocks s
UNION
SELECT s.Ts as Ts, s.StockSymbol as StockSymbol,
s.OptionSymbol as OptionSymbol, s.Price as Price,
s.Volume as Volume
FROM InOptions s

See also

*  Filtering on page 37

o Splitting Up Incoming Data on page 38
e Joinson page 40

e Pattern Matching on page 46

* Aggregation on page 47

Example: Merging Data from Streams or Windows

Use the UNION clause to merge data from two streams or windows and produce a derived
element (stream, window, or delta stream).

1. Create a new window:
CREATE WINDOW name

You can also create a new stream or delta stream.
2. Specify the primary key:
PRIMARY KEY (..)
3. Specify the first derived element in the union:
SELECT * FROM StreamWindowl
4. Add the UNION clause:
UNION
5. Specify the second derived element in the union:

SELECT * FROM StreamWindow2

Joins

Use joins in your CCL query to combine multiple datasources into a single query.

Streams, windows, or delta streams can participate in a join. However, a delta stream can
participate in a join only if it has a KEEP clause. A join can contain any number of windows
and delta streams (with their respective KEEP clauses), but only one stream. Self joins are also
supported. For example, you can include the same window or delta stream more than once ina
join, provided each instance has its own alias.

In a stream-window join the target can be a stream or a window with aggregation. Using a
window as a target requires an aggregation because the stream-window join does not have
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keys and a window requires a key. The GROUP BY columns in aggregation automatically
forms the key for the target window. This restriction does not apply to delta stream-window
joins because use of the KEEP clause converts a delta stream into an unnamed window.

Joins are performed in pairs but you can combine multiple joins to produce a complex
multitable join. Depending on the complexity and nature of the join, the compiler may create
intermediate joins. The comma join syntax supports only inner joins, and the WHERE clause in
this syntax is optional. When it is omitted, it means that there is a many-many relationship
between the streams in the FROM clause.

Joins in ANSI syntax can add the DYNAMIC modifier to a window or stream to indicate that its
data changes frequently. A secondary index is created on windows joining with an incomplete
primary key of a DYNAMIC window or stream. This improves performance but uses additional
memory proportional to the total data length of key columns in the index. By default, windows
and streams are STATIC and no secondary indices are created.

Event Stream Processor supports all join types:

Join Type Description

Inner Join One record from each side of the join is required for the join to
produce a record.

Left Outer Join A record from the left side (outer side) of the join is produced
regardless of whether a record exists on the right side (inner side).
When a record on the right side does not exist, any column from the
inner side has a NULL value.

Right Outer Join Reverse of left outer join, where the right side is the outer side and
the left side is the inner side of the join.

Full Outer Join A record is produced whether there is a match on the right side or
the left side of the join.

Event Stream Processor also supports these cardinalities:

Type Description

One-One Keys of one side of the join are completely mapped to the keys of the other side of
the join. One incoming row produces only one row as output.

One-Many One record from the one side joins with multiple records on the many side. The
one side of the join is the side where all the primary keys are mapped to the other
side of the join. Whenever a record comes on the one-side of the join, it produces
many rows as the output.
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Type Description

Many-Many The keys of both side of the join are not completely mapped to the keys of the
other side of the join. A row arriving on either side of the join has the potential to
produce multiple rows as output.

Thisexample joins two windows (InStocks and InOptions) using the FROM clause with
ANSI syntax. The result is an output window.
CREATE INPUT Window InStocks SCHEMA StocksSchema Primary Key (Ts) ;

CREATE INPUT Window InOptions SCHEMA OptionsSchema Primary Key (Ts)
KEEP ALL ;

CREATE Output Window OutStockOption SCHEMA OutSchema
Primary Key (Ts)
KEEP ALL
AS
SELECT InStocks.Ts Ts,
InStocks.Symbol Symbol,
InStocks.Price StockPrice,
InStocks.Volume StockVolume,
InOptions.StockSymbol StockSymbol,
InOptions.OptionSymbol OptionSymbol,
InOptions.Price OptionPrice,
InOptions.Volume OptionVolume
FROM InStocks JOIN InOptions
ON
InStocks.Symbol = InOptions.StockSymbol and
InStocks.Ts = InOptions.Ts ;

See also

*  Filtering on page 37

«  Splitting Up Incoming Data on page 38
e Unionson page 39

e Pattern Matching on page 46

» Aggregation on page 47

Key Field Rules

Key field rules ensure that rows are not rejected due to duplicate inserts or the key fields being
NULL.

» Thekeyfields of the target are always derived completely from the keys of the many side of
the join. In a many-many relationship, the keys are derived from the keys of both sides of
the join.

« Inaone-one relationship, the keys are derived completely from either side of the
relationship.
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* Inan outer join, the key fields are derived from the outer side of the join. An error is
generated if the outer side of the join is not the many-side of a relationship.

« Inafull-outer join, the number of key columns and the type of key columns need to be
identical in all sources and targets. Also, the key columns require afirstnonnull expression
that includes the corresponding key columns in the sources.

When the result of a join is a window, specific rules determine the columns that form the
primary key of the target window. In a multitable join, the same rules apply because
conceptually each join is produced in pairs, and the result of a join is then joined with another
stream or window, and so on.

This table illustrates this information in the context of join types:

One-One One-Many Many-One Many-Many

INNER | Keys from at least | Keys from the right | Keys from the left | Keys from both
one side should be | side should be inclu- | side should be inclu- | sides should be in-
included in the pro- | ded inthe projection | ded in the projection | cluded in the projec-
jection list (or a list. list. tion list.
combination of
them if keys are
composite).

LEFT Keys from the left | Not allowed. Keys from the left | Not allowed.
side alone should be side should be inclu-
included. ded in the projection

list.

RIGHT | Keys from the right | Keys from the right | Not allowed. Not allowed.
side alone should be | side should be inclu-
included. ded in the projection

list.

OUTER | Keys should be Not allowed. Not allowed. Not allowed.
formed using first-
nonnull () on each
pair of keys from
both sides.

See also

o Join Examples: ANSI Syntax on page 43
o Join Example. Comma-Separated Syntax on page 46

Join Examples: ANSI Syntax

Examples of different join types using the ANSI syntax.

Refer to these inputs for the examples below.

CREATE INPUT STREAM S1 SCHEMA (VallSl integer, Val2Sl integer, Val3Sl

string) ;
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CREATE INPUT WINDOW W1l SCHEMA (KeylWl integer, Key2Wl string, VallWl
integer, Val2Wl string) PRIMARY KEY (KeylWl, Key2Wl);

CREATE INPUT WINDOW W2 SCHEMA (KeylW2 integer, Key2W2 string, VallW2
integer, Val2W2 string) PRIMARY KEY (KeylW2, Key2W2);

CREATE INPUT WINDOW W3 SCHEMA (KeylW3 integer, VallW3 integer,
Val2W3 string) PRIMARY KEY (KeylW3);

Simple Inner Join: One-One
Here, keys can be derived from either W1 or W2.

CREATE OUTPUT WINDOW OW1

PRIMARY KEY (KeylW2, Key2W2)

AS SELECT Wl1.*, W2.%*

FROM W1l INNER JOIN W2 ON Wl.KeylWl = W2.KeylW2 AND Wl.Key2Wl =
W2 .Key2W2;

Simple Left Join: One-One
The keys are derived from the outer side of the left join. It is incorrect to derive the keys from
the inner side because the values could be null.

CREATE OUTPUT WINDOW OW2

PRIMARY KEY (KeylWl, Key2Wl)

AS SELECT Wl.*, W2.*

FROM W1l LEFT JOIN W2 ON Wl.KeylWl = W2.KeylW2 AND W1l.Key2Wl =
W2 .Key2W2;

Simple Full Outer Join: One-One
The key columns all have a required firstnonnull expression in it.

CREATE OUTPUT WINDOW OW3

PRIMARY KEY (Keyl, Key2)

AS SELECT firstnonnull (Wl.KeylWl, W2.KeylW2) Keyl,
firstnonnull (W1l.Key2Wl, W2.Key2W2) Key2, Wl.*, W2.*

FROM W1l FULL JOIN W2 ON Wl.KeylWl = W2.KeylW2 AND Wl.Key2Wl =
W2 .Key2W2;

Simple Left Join: Many-One

All the keys of W2 are mapped and only one key of W1 is mapped in this join. The many-side
is W1 and the one-side is W2. The keys must be derived from the many-side.

CREATE OUTPUT WINDOW OW4

PRIMARY KEY (KeylWl, Key2W1l)

AS SELECT Wl.*, W2.*

FROM W1l LEFT JOIN W2 ON Wl.KeylWl = W2.KeylW2 AND W1l.Val2Wl =
W2 .Key2W2;

Simple Left Join: Many-One (DYNAMIC Modifier)

W3 is DYNAMIC and only one key of W1 is mapped in this join, so a secondary index is created
on W1. W1 isalso DYNAMIC, but all keys of W3 are mapped, so no secondary index is created
on W3.
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CREATE OUTPUT WINDOW OW5

PRIMARY KEY DEDUCED

AS SELECT Wl.*, W3.*

FROM W1 (DYNAMIC) LEFT JOIN W3 (DYNAMIC) ON Wl.KeylWl = W3.KeylW3;

Simple Inner Join: Many-Many
This is a many-many join because neither of the keys are fully mapped. The keys of the target
must be the keys of all the windows participating in the join.

CREATE OUTPUT WINDOW OW6

PRIMARY KEY (KeylWl, Key2Wl, KeylW2, Key2W2)

AS SELECT W1.*, W2.*

FROM W1 JOIN W2 ON W1.VallWl = W2.VallW2 AND W1.Val2Wl = W2.Val2W2;

Simple Stream-Window Left Join
When a left join involves a stream, the stream must be on the outer side. The target cannot be a
window unless it is also performing aggregation.

CREATE OUTPUT STREAM OSWL1

AS SELECT S1.%*, W2.*

FROM S1 LEFT JOIN W2 ON S1.VallSl = W2.KeylW2 AND S1.Val3Sl =
W2 .Key2W2;

Complex Window-Window Join
The keys for OW4 can be derived either from W1 or W2 because of the inner join between the
two tables.

CREATE OUTPUT WINDOW OW7

PRIMARY KEY DEDUCED

AS SELECT S1.*, Wl.*, W2.*, W3.* //Some column expression.

FROM S1 LEFT JOIN (W1l INNER JOIN (W2 LEFT JOIN W3 ON W2.KeylW2 =
W3.KeylW3) ON Wl.KeylWl = W2.KeylW2 AND W1l.Key2Wl = W2.Key2W2) ON
S1.VallSl = Wl.KeylWl

WHERE W2.Key2W2 = 'abcd'

GROUP BY Wl.KeylWl, W2.Key2W2

HAVING SUM (W3.Vallw3) > 10;

Complex Stream-Window Join
Here, the joinistriggered only when arecord arrives on S1. Also, because there is aggregation,
the target must be a window instead of being restricted to a stream.

CREATE OUTPUT WINDOW OW8

PRIMARY KEY DEDUCED

AS SELECT S1.*, Wl.*, W2.*, W3.* //Some column expression.

FROM S1 LEFT JOIN (W1 INNER JOIN (W2 LEFT JOIN W3 ON W2.KeylW2 =
W3.KeylW3) ON Wl.KeylWl = W2.KeylW2 AND Wl.Key2Wl = W2.Key2W2) ON
S1.vallSl = Wl.KeylWl

WHERE W2.Key2W2 = 'abcd'

GROUP BY W1.KeylWl, W2.Key2W2

HAVING SUM(W3.Vallw3) > 10;

See also
* Key Field Rules on page 42

Programmers Guide 45



CHAPTER 5: CCL Query Construction

e Join Example. Comma-Separated Syntax on page 46

Join Example: Comma-Separated Syntax

An example of a complex join using the comma separated syntax.

This join is a complex join of three windows using the comma-separated join syntax. The
WHERE clause specifies the conditions on which records are joined.

CREATE OUTPUT WINDOW OwW4

PRIMARY KEY DEDUCED

AS SELECT Wl.*, W2.*, W3.*

FROM W1, W2, W3

WHERE W1.KeylWl = W2.KeylW2 AND Wl.Key2Wl = W2.Key2W2 AND Wl.KeylWl
= W3.KeylW3;

See also
* Key Field Rules on page 42
e Join Examples: ANSI Syntax on page 43

Pattern Matching

Use the MATCHING clause in your CCL query to take input from one or more elements
(streams, windows, or delta streams) and produce records when a prescribed pattern is found
within the input data.

Pattern streams can check whether or not events (rows from the input sources matching certain
criteria) occur during a specific time interval, and then send records to downstream streams if a
match has occurred.

Pattern matching can be used to distill complex relationships between data into compact and
easily-maintainable expressions.

Attention: The pattern rule engine will use any incoming event in order to match the defined
pattern, regardless of the opcode of an incoming event. The opcode can be included in each
event's definition in order to filter out unwanted rows.

This example creates an output stream, Three Trades, which monitors the QTrades streams
and sends a new event when it detects three trades on the same symbol within five seconds. The
output of this stream is the symbol of the traded stock, and its latest three prices. The trades do
not have to occur consecutively, but the trades must occur within five seconds of each other.
Multiple patterns may be in the process of being matched at the same time.
CREATE OUTPUT STREAM ThreeTrades
AS
SELECT

T1.Symbol,

Tl.Price Pricel,

T2.Price Price2,
T3.Price Price3
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FROM QTrades T1, QTrades T2, QTrades T3
MATCHING[5 SECONDS: T1, T2, T3]
ON T1.Symbol = T2.Symbol = T3.Symbol

’

For details on the MATCHING clause, see the SAP Sybase Event Stream Processor
Programmers Reference.

See also

e Filtering on page 37

o Splitting Up Incoming Data on page 38
*  Unionson page 39

e Joinson page 40

» Aggregation on page 47

Aggregation

Aggregation collects input records based on the values in the columns specified with the
GROUP BY clause, applies the specified aggregation function such as min, max, sum,
count and so forth, and produces one row of output per group.

Records in a group have the same values for the columns specified in the GROUP BY clause.
The columns specified in the GROUP BY clause also needs to be included in the SELECT
clause because these columns form the key for the target. This is the reason why the primary
key for the aggregate window must use the PRIMARY KEY DEDUCED clause instead of
explicitly specifying a primary key.

In addition to the GROUP BY clause, a GROUP FILTER and GROUP ORDER BY clause can be
specified. The GROUP ORDER BY clause orders the records in a group by the specified
columns before applying the GROUP FILTER clause and the aggregation functions. With the
records ordered, aggregation functions sensitive to the order of the records such as first,
last, and nth can be used meaningfully.

The GROUP FILTER clause is executed after the GROUP ORDER BY clause and eliminates any
rows in the group that do not meet the filter condition. The filter condition that is specified is
similar to the one in the WHERE clause. The only exception being that a special rank function
can be specified. The rank function is used in conjunction with the GROUP ORDER BY clause.
After the GROUP ORDER BY clause is executed every row in the group is ranked from 1 to N.
Now in the GROUP FILTER clause one can say rank () < 11, which means that the
aggregation function is only applied to the first 10 rows in the group after it has been ordered
by the columns specified in the GROUP ORDER BY clause.

Finally an optional HAVING clause can also be specified. The HAVING clause filters records
based on the results of applying aggregation functions on the records in a given group. The
primary difference is that a HAVING clause aggregation operation is allowed and a WHERE
clause aggregation operation is not.
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Note: The GROUP ORDER BY, GROUP FILTER, and HAVING clauses can only be specified in
conjunction with a GROUP BY clause.

When using aggregation, you must consider the memory usage implications. All of the input
records for which an aggregate function is to be calculated have to be stored in memory. The
data structure that holds all the records in memory is called the aggregation index.

If a stream feeds input to an aggregation window directly, the memory usage of the
aggregation index increases without bound. To prevent such unbounded growth, insert an
intermediate window between the stream and the aggregation window. In this intermediate
window, use a GROUP BY clause to set one or more of the stream columns as the primary key,
then set a retention policy to prevent runaway memory usage. Note that although this
intermediate window is an aggregation window, it does not perform any aggregation
functions, so its index does not grow indefinitely.

The intermediate aggregation window acts as the stream and feeds input into the aggregation
window directly. The aggregation window performs its aggregation functions using the input
retained from the intermediate aggregation window.

Example

The following example computes the total number of trades, maximum trade price, and total
shares traded for every Symbo1. The target window only has those Symbo1 s where the total
traded volume is greater than 5000.

CREATE INPUT STREAM Trades
SCHEMA (TradeId integer, Symbol string, Price float, Shares integer);

CREATE WINDOW TradeRetention

PRIMARY KEY DEDUCED

KEEP 1 DAY

AS

SELECT trd.TradelID, trd.Symbol, trd.Price, trd.Shares
FROM Trades trd

GROUP BY trd.Tradeld;

CREATE OUTPUT WINDOW TradeSummary

PRIMARY KEY DEDUCED

KEEP 1 DAY

AS

SELECT tr.Symbol, count (tr.TradeId) NoOfTrades, max (tr.Price)
MaxPrice, sum(tr.Shares) TotalShares

FROM TradeRetention tr

GROUP BY tr.Symbol

HAVING sum(tr.Shares) > 5000;

See also

e Filtering on page 37

»  Splitting Up Incoming Data on page 38
e Unions on page 39

e Joinson page 40
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e Pattern Matching on page 46
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CHAPTER 6 Advanced CCL Programming
Techniques

Use advanced CCL techniques to develop sophisticated and complex projects.
Use declare blocks to define variables, constants, SPLASH functions, and custom datatypes.
Create modules to encapsulate reusable code.

Use explicit memory stores to fine tune performance. Use log stores to retain the contents of
named windows on disk, to allow for recovery in the event of a failure.

Declare Blocks

Declare blocks allow a model designer to include elements of functional programming, such
as variables, parameters, typedefs, and function definitions in CCL data models.

CCL supports global and local declare blocks.

* Global declare blocks—accessible to an entire project; however, you can also set
individual global declare blocks for each module.

Note: Global declare blocks are merged together if more are imported from other CCL
files. Only one is possible per project.

» Local declare blocks—declared in CREATE statements, are accessible only in the
SELECT clause of the stream or window in which they are declared.

Note: The variables and functions defined in a local declare block are only accessible in
the SELECT clause and anywhere inside the Flex Operator.

CCL variables allow for the storage of values that may change during the execution of the
model. Variables are defined in the declare block using the SPLASH syntax.

CCL typedefs are user-defined datatypes and can also be used to create an alias for a standard
datatype. A long type name can be shortened using typedef. Once a typedef has been defined
in the declare block, it can be used instead of the datatype in all SPLASH statements, and
throughout the project.

CCL parameters are constants for which you can set the value at the model's runtime. You can
use these parameters instead of literal values in a project to allow behavior changes at runtime,
such as window retention policies, store sizes, and other similar changes that can be easily
modified at runtime without changing the project. You define CCL parameters in a global
declare block, and initialize them in a project configuration file. You can also set a default
value for the parameter in its declaration, so that initialization at server start-up is optional.
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You can create SPLASH functions in a declare block to allow for operations that are more
easily handled using a procedural approach. Call these SPLASH functions from stream
queries and other functions throughout the project.

Typedefs

Declares new names for existing datatypes.

Syntax
typedef existingdatatypeName newdatatypeName;

Components
existingdatatypeName The original datatype.
newdatatypeName The new name for the datatype.
Usage

Typedefs allow giving new names for existing datatypes, which can be used to define new
variables and parameters, and specify the return type of functions. Typedefs can be declare in
declare blocks, UDFs and inside FLEX procedures. The types declared in typedefs must
resolve to simple types.

Note: For unsupported datatypes, use a typedef in a declare block to create an alias for a
supported datatype.

Example
This example declares euros to be another name for the money(2) datatype:

typedef money(2) euros;

Once you have defined the euro typedef, you can use:

euros price := 10.80d2;

which is the same as:
money (2) price := 10.80d2;

Parameters

Constants that you set during project setup using the server-command name or the project
configuration file.

Syntax
parameter typeName parameterNamel [:= constant expression]
[,parameterName2 [:= constant expression],..];
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Components
typeName The datatype of the declared parameter.
parameterName The name of the declared parameter.
constant_expression An expression that evaluates to a constant.
Usage

Parameters are defined using the qualifier parameter. Optionally, you can specify a default
value. The default value is used only if no value is provided for the parameter at server start-

up.

Parameters can use only basic datatypes, and must be declared in the global DECLARE block
of a project or a module. Parameters cannot be declared with complex datatypes. Since
parameters are constant, their value cannot be changed in the model.

Parameters at Project Setup

You can define parameters inside the global declare block for a project and inside the global
declare block for amodule. Project-level parameters can be bound on server start-up. Module-
level parameters are bound when the module is loaded.

Parameters can be assigned values at server start-up time by specifying the values on the
command line used to start the server or through the project configuration file. You must
provide values for any project parameters that do not have a default value. Parameters can only
be bound to a new value when a module or project is loaded.

In the parameter declaration, you can specify a default value. The default value is used for the
parameter if it is not bound to a new value when the project or module is loaded. If a parameter
does not have a default value, it must be bound when the module or project is loaded, or an
error occurs.

When a parameter is initialized with an expression, that expression is evaluated only at
compile time. The parameter is then assigned the result as its default value.

When supplying values at runtime for a parameter declared as an interval datatype, interval
values are specified with the unit notation in CCL and with a bare microsecond value in the
project configuration file. See the Studio Users Guide for more information on project
configurations and parameters in the project configuration file.

Variables

Variables represent a specific piece of information that may change throughout project
execution. Variables are declared using the SPLASH syntax.

Syntax

typeName {variableName[:=any expression] [, ...]}
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Usage
Variables may be declared within any declare block, SPLASH UDF, or Flex procedures.
Multiple variables may be declared on a single line.

The declaration of a variable can also include an optional initial value, which must be a
constant expression. Variables without an initial value initialize to NULL.

Variables can be of complex types. However, complex variables can only be used in local
declare blocks and declare blocks within a Flex stream.

Variables declared in a local declare block may subsequently be used in SELECT clauses, but
cause compiler errors when used in WHERE clauses.

Example
This example defines a variable, then uses the variable in both a regular stream and a FLEX
stream.

declare
INTEGER ThresholdValue := 1000;
end;
//
// Create Schemas
Create Schema TradeSchema (
Ts bigdatetime,
Symbol STRING,
Price MONEY (4),
Volume INTEGER
)

Create Schema ControlSchema (
Msg STRING,
Value INTEGER

)i //

// Input Trade Window

//

CREATE INPUT WINDOW TradeWindow
SCHEMA TradeSchema
PRIMARY KEY (Ts);

//
// Input Stream for Control Messages

//
CREATE INPUT STREAM ControlMsg SCHEMA ControlSchema ;

//
// Output window, only has rows that were greater than the
thresholdvalue
// was when the row was received
CREATE Output WINDOW OutTradeWindow
SCHEMA (Ts bigdatetime, Symbol STRING, Price MONEY (4), Volume
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INTEGER)
PRIMARY KEY (Ts)
as
select *
from TradeWindow
where TradeWindow.Volume > ThresholdValue;

//
//Flex Stream to process the control message
CREATE FLEX FlexControlStream
IN ControlMsg
OUT OUTPUT WINDOW SimpleOutput
SCHEMA ( a integer, b string, c integer)
PRIMARY KEY ( a)
BEGIN
ON ControlMsg
{
// change the value of Thresholdvalue
if ( ControlMsg.Msg = 'set')
{ThresholdValue:=ControlMsg.Value;}
// The following is being populate so you can see that the
ThresholdValue is being set
output [a=ControlMsg.Value; b=ControlMsg.Msg;
c=Thresholdvalue; |];
}

END

Declaring Project Variables, Parameters, Datatypes, and Functions

Declare variables, parameters, typedefs, and functions in both global and local DECLARE
blocks.

1. Create a global declare block for your project by using the DECLARE statement in your
main project file.

2. Add parameters, variables, or user-defined SPLASH functions to the global declare
block.

Elements defined in this declare block are accessible to any elements in the project that are
not inside a module.

3. Create local declare blocks by using the DECLARE statement within derived streams,
windows, or both..

4. Add variables, parameters, or user-defined SPLASH functions to the local declare block.

These elements are accessible only from within the stream, window, or flex operator in
which the block is defined.
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Flex Operators

Flex operators provide extensibility to CCL, allowing custom event handlers, written in
SPLASH, to produce derived streams or windows.

A flex operator produces derived streams, windows, or delta streams in the same way that a
CREATE statement produces these elements. However, a CREATE statement uses a CCL
query to derive a new window from the inputs, whereas a flex operator uses a SPLASH script.

Flex operators make CCL extensible, allowing you to implement event processing logic that
would be difficult to implement in a declarative SELECT statement. SPLASH gives you
process control and provides data structures that can retain state from one event to the next.

All of the features of SPLASH are available for use in a flex operator, including:

Data structures e Variables
¢ EventCache (windows)
¢ Dictionaries
e \ectors
Control structures «  While
o If
e For

A flex operator can take any number of inputs, and they can be any mix of streams, delta
streams, or windows. You can write a splash event handler for each input. When an event
arrives on that input, the associated SPLASH script or method is invoked.

You need not have a method for every input. Some inputs may merely provide data for use in
methods associated with other inputs; for inputs without an associated method, incoming
events do not trigger an action, but are accessible to other methods in the same flex operator.

Modularity

A module in SAP Sybase Event Stream Processor offers reusability; it can be loaded and used
multiple times in a single project or in many projects.

Modularity means organizing project elements into self-contained, reusable components
called modules, which have well-defined inputs and outputs, and allow you to encapsulate
data processing procedures that are commonly repeated.

Modules, along with other objects such as import files and the main project, have their own
scope, which defines the visibility range of variables or definitions. Any variables, objects, or
definitions declared in a scope are accessible within that scope only; they are inaccessible to
the containing scope, called the parent scope, or to any other outer scope. The parent scope can
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be a module or the main project. For example, if module A loads module B and the main
project loads module A, then module A's scope is the parent scope to module B. Module A's
parent scope is the main project.

Modules have explicitly declared inputs and outputs. Inputs to the module are associated with
streams or windows in the parent scope, and outputs of the module are exposed to the parent
scope using identifiers. When a module is reused, any streams, variables, parameters, or other
objects within the module replicate, so that each version of the module exists separately from
the other versions.

You can load modules within other modules, so that module A can load module B, which can
load module C, and so on. Module dependency loops, however, are invalid. For example, if
module A loads module B, which loads A, the CCL compiler generates an error indicating a
dependency loop between modules A and B.

The CREATE MODULE statement creates a module that can be loaded multiple times in a
project, where its inputs and outputs can be bound to different parts of the larger project. The
LOAD MODULE statement allows reuse of a defined module one or more times throughout a
project. Modularity is particularly useful when used with the IMPORT statement, which allows
you to use (LOAD) modules created in a separate CCL file.

Note: All module-related compilation errors are fatal.

Module Creation and Usage
Use the CREATE MODULE statement to create a reusable module, and LOAD MODULE to load
a previously created module.

When you load a module, you can connect or bind its input streams or windows to streams in
the project. A module's outputs can be exposed to its parent's scope and referenced in that
scope using the aliases provided in the LOAD MODULE statement.

Parameters inside the module are bound to parameters in the parent scope or to constant
expressions. Stores within the module are bound to stores in the parent scope. Binding a store
within a module to a store outside the module means that any windows using the module store
instead use the bound store.

Example: Creating and Using Modules

Use basic concepts of modularity to create a module that processes raw stock trade
information and outputs a list of trades with a price exceeding 1.00.

1. Create an import file to group your schemas and allow for reuse throughout the project.
In this example, the import file is called schemas . cc1 and contains:

CREATE SCHEMA TradesSchema (
Id integer,
TradeTime date,
Venue string,
Symbol string,
Price float,
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Shares integer

)

Note: You can define schemas directly inside a module or project; however, this example
uses an import file to decrease code duplication and increase maintainability of the CCL.

In the project, create a module using the CREATE MODULE statement, and import the
import file (schemas . cc1) using the IMPORT statement.

CREATE MODULE FilterByPrice IN TradeData OUT FilteredTradeData
BEGIN
IMPORT 'schemas.ccl';

CREATE INPUT STREAM TradeData SCHEMA TradesSchema;

CREATE OUTPUT STREAM FilteredTradeData SCHEMA TradesSchema

AS SELECT * FROM TradeData WHERE TradeData.Price > 1.00;
END;

The module's input stream, TradeData, takes in a raw feed from the stock market, and
its output stream, FilteredTradeData, provides filtered results. Using the IMPORT
statement inside the module allows you to use all of the schemas grouped in the
schemas. ccl file in the module streams.

Load the module into your main project using the LOAD MODULE statement.

This example also shows how to connect the module to a stock market stream:

IMPORT 'schemas.ccl';

CREATE INPUT STREAM NYSEData SCHEMA TradesSchema;

LOAD MODULE FilterByPrice AS FilterOverl IN TradeData = NYSEData
OUT FilteredTradeData = NYSEPriceOverlData;

< The first line of the project file imports schemas . cc1, which allows the use of the
same schema as the module.

e The input stream NYSEData represents trade information from the New York Stock
Exchange.

* The LOAD MODULE statement loads the module, FilterByPrice, which is
identified by the instance name of FilterOverl.

» Binding the module's input stream, TradeData, with the input stream NYSEData
allows information to flow from the NYSEData stream into the module.

* The output of the module is exposed to the project (NYSEPriceOverlData).

< To access the output of the module, select the information from the
NYSEPriceOverlData Stream.

Example: Parameters in Modules

Develop your understanding of parameter bindings. Create a module that defines a parameter
that can be bound to an expression or to another parameter in the parent scope.

The module FilterByPrice filters all incoming trades based on price, and outputs only
the trades that have a price greater than the value in the minimumPrice parameter.
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minimumPrice canbesetwhen FilterByPrice isloaded, oritcan be boundto another
parameter within the project so that the value of minimumPrice is set when the project is
loaded on the server.

The module definition is:

CREATE MODULE FilterByPrice IN TradeData OUT FilteredTradeData
BEGIN
IMPORT 'schemas.ccl';

DECLARE
parameter money (2) minimumPrice := 10.00d2;
END;

CREATE INPUT STREAM TradeData SCHEMA TradesSchema;

CREATE OUTPUT STREAM FilteredTradeData SCHEMA TradesSchema AS
SELECT * FROM TradeData WHERE TradeData.Price > minimumPrice;
END;

Binding a Parameter to an Expression

In parameter to expression binding, minimumPrice binds to an expression at the time of
loading:

LOAD MODULE FilterByPrice AS FilterOver20 IN TradeData = NYSEData OUT

FilteredTradeData = NYSEPriceOver20Data PARAMETERS minimumPrice =
20.00d2;

In this type of parameter binding, the module outputs stocks only with a price greater than
20.00.

Binding a Parameter in the Module to a Parameter in the Parent Scope

In this type of binding, the parameter inside the module binds to a parameter declared in the
main project, therefore modifying the value on which trades are filtered at runtime. This is
done by creating a parameter within the project's DECLARE block, then binding the parameter
(minimumPrice) within the module to the new parameter:

DECLARE

parameter money (2) minProjectPrice := 15.00d2;
END;

LOAD MODULE FilterByPrice AS FilterOverMinProjPrice IN TradeData =
NYSEData OUT FilteredTradeData = NYSEPriceOverMinProjPrice
PARAMETERS minimumPrice = minProjectPrice;

If no value is specified for the project's parameter (minProjectPrice)atruntime, then the
module filters based on the project parameter's default value of 15.00. However, if
minProjectPrice is given a value at runtime, the module filters based on that value.

No Parameter Binding
In this example, minimumPrice has a default value in the module definition, therefore no
parameter binding is required when loading the module. The module can be loaded as:
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LOAD MODULE FilterByPrice AS FilterOverlO IN TradeData = NYSEData OUT
FilteredTradeData = NYSEPriceOverlOData;

Since no binding is provided in the LOAD MODULE statement, the module filters on its default
value of 10.00.

Data Recovery

A log store allows data recovery inside a window if a server fails or is shut down.

Properly specified log stores recover window elements on failure, and make sure data gets
restored correctly if the server fails and restarts. You can use log stores with windows that have
no retention policy; you cannot use log stores with stateless elements.

When using log stores:

» Log stores only store window contents.

« Log stores do not directly store intermediate state, such as variables.

« Local Flex stream variables and data structures are not directly stored. However, they may
be regenerated from source data if the source data is in persistent storage.

» Logstores do not preserve opcode information. (During periodic log store compaction and
checkpointing, only the current window state is preserved. Records are then restored as
inserts.)

« Row arrival order is not preserved. In any stream, multiple operations may be collapsed
into a single record during log store compaction, changing arrival order. Inter-stream
arrival order is not maintained.

« You can define one or more log stores in a project. When using multiple stores make sure
you prevent the occurrence of log store loops. A log store loop is created when, for
example, Windowl in Logstorel feeds Window?2 in Logstore2, which feeds
Window3 in Logstorel. Log store loops cause compilation errors.

* The contents of memory store windows that receive data directly from a log store window
are recomputed once the log store window is restored from disk.

« The contents of memory store windows that receive data from a log store window via other
memory store windows are also recomputed, once the input window's contents have been
recomputed.

Note: Ifamemory store window receives data from a log store window via a stateless element,
for example, a delta stream or a stream, its contents are not restored during server recovery.

Log stores are periodically compacted, at which point all data accumulated in the store is
checkpointed and multiple operations on the same key are collapsed. After a checkpoint, the
store continues appending incoming data rows to the end of the store until the next checkpoint.

Note: The recovery of data written to the store, but not yet checkpointed, is available for input
windows only. SAP recommends that when you assign a window to a log store, you also assign
all of its input windows to a log store. Otherwise, data written to the window after the last
checkpoint is not restored.
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Unlike memory stores, log stores do not extend automatically. Use the CCL maxfilesize
property to specify log store size. The size of a log store is extremely important. Log stores that
are too small can cause processing to stop due to overflow. They can also cause significant
performance degradation due to frequent cleaning cycles. A log store that is too large can
hinder performance due to larger disk and memory requirements.

Log Store Optimization Techniques
Specify persistence to optimize data models for maximum performance.

* Whenever possible, create a small log store to store static (dimension) data, and one or
more larger log stores for dynamic (fact) data.

« Ifyou are using multiple log stores for larger, rapidly changing, dynamic (fact) data, try to
organize the stores on different RAID volumes.

e The correct sizing of log stores is extremely important. See Sizing a Log Store in the
Configuration and Administration Guide.

Error Streams

Error streams gather errors and the records that caused them.

Description

The error stream provides a means to capture error information along with the data that caused
the error. This can assist in debugging errors during development. It can also provide real-time
monitoring of projects in a production environment.

You can specify more than one error stream in a single project.
An error stream is identical to other user-defined streams, except it:

« Receives records from its source stream or window only when there is an error on the
source stream or window. The record it receives is the input to the source stream or window
that caused the error.

« Has a predefined schema that cannot be altered by the user.

Schema
Column Datatype | Description
errorCode integer The numeric code for the error that was reported
errorRecord binary The record that caused the error
errorMessage string Plain text message describing the error
errorStreamName | string The name of the stream on which this error was reported

Programmers Guide 61



CHAPTER 6: Advanced CCL Programming Techniques

Column Datatype | Description

sourceStream- string The name of the stream that sent the record that caused the error

Name

errorTime bigdatetime | The time the error occurred: a microsecond granularity time-
stamp

Error Codes and Corresponding Values

NO_ERR -0
GENERIC_ERROR - 1
FP_EXCEPTION - 2
BADARGS - 3
DIVIDE_BY_ZERO - 4
OVERFLOW ERR-5
UNDERFLOW ERR - 6
SYNTAX_ERR - 7

Limitations
The syntax of the error stream provides a mechanism for trapping runtime errors, subject to
these limitations:

Only errors that occur during record computation are captured in error streams. Errors in
computations that occur at server start-up, such as evaluation of expressions used to
initialize variables and parameters, are not propagated to error streams. Other errors, such
as connection errors and noncomputational errors, are not captured in error streams.
Errors occurring during computations that happen without a triggering record, such as in
the ON START TRANS and ON END TRANS blocks of a flex block, propagate an error
record where the errorRecord field contains an empty record.

For the recordDataToRecord built-in, the stream name must be a string literal constant.
This limitation is so that a record type of the return value of the built-in can be determined
during compilation.

The triggering record must be retrieved using provided built-ins. No native nested record
support is provided to refer to the record directly.

The triggering record reported is the immediate input for the stream in which the error
happened. This may be a user-defined stream or an intermediate stream generated by the
compiler. When using the recordDataToString and recordDataToRecord built-ins, the first
argument must match the intermediate stream if one has been generated.

The subscription utility does not automatically decrypt (convert from binary to ASCII) the
error record.

Output adapters do not automatically decrypt (convert from binary to ASCII) the error
record.
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< Arithmetic and conversion errors occurring in external functions (C and Java) are not
handled; such errors are the users responsibility.
« Error streams are not guaranteed to work within the debugger framework.

Monitoring Streams for Errors
Use error streams to monitor other streams for errors and the events that cause them.

Process

1. Identify the project and the specific streams to monitor.

2. Determine whether to use multiple error streams. Determine the visibility for each error
stream.

3. Create the error streams in that project.

4. Display some or all of the information from the error streams in the error record, that is,
information aggregated or derived from the error records.

Examples
In a project that has one input stream and two derived streams, create a locally visible error
stream to monitor all three streams using:

CREATE ERROR STREAM AllErrors ON InputStream, DerivedStreaml,
DerivedStream?2;

To keep a count of the errors according to the error code reported, add:

CREATE OUTPUT WINDOW errorHandlerAgg SCHEMA (errorNum integer, cnt
long)

PRIMARY KEY DEDUCED

AS

SELECT e.errorCode AS errorNum, COUNT(*) AS cnt

FROM AllErrors e

GROUP BY e.errorCode

’

In a project that has three derived streams, create an externally visible error stream to monitor
only the third derived stream (which calculates a volume weighted average price) using:
CREATE OUTPUT ERROR STREAM vwapErrors ON DerivedStream3;

To convert the format of the triggering record from binary to string, add:

CREATE OUTPUT vwapMessages SCHEMA (errorNum integer, streamName
string, errorRecord string) AS
SELECT e.errorcode AS errorNum,

e.streamName AS streamName,

recordDataToString (e.sourceStreamName, e.errorRecord) AS
errorRecord
FROM vwapErrors e;

To convert the format of the triggering record from binary to record, add:

CREATE OUTPUT vwapMessages SCHEMA (errorNum integer, streamName
string, errorRecord string) AS
SELECT e.errorcode AS errorNum,
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e.streamName AS streamName,

recordDataToRecord (e.sourceStreamName, e.errorRecord) AS
errorRecord
FROM vwapErrors e;
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Specify log store size in a project's XML file.

Unlike memory stores, log stores do not extend automatically. Sizing the log stores correctly is
important. A store that is too small requires more frequent cleaning cycles, which severely
degrades performance. In the worst case, the log store can overflow and cause the processing
to stop. A store that is too large also causes performance issues due to the larger memory and
disk footprint; however, these issues are not as severe as those caused by log stores that are too
small.

reservePct Parameter
The reserve is kept as intermediate space that is used during periodic cleaning of the store, and
to perform the correct resize of the store.

Note: Ifthe reserve space istoo small and the project runs until the store fills with data, a resize
attempt may cause the store to become wedged. This means that it cannot be resized, and the
data can be extracted from it only by SAP Technical Support. It is safer to have too much
reserve than too little. The default of 20 percent is adequate in most situations. Multigigabyte
stores may use a reduced value as low as 10 percent. Small stores, under 30MB, especially
those with multiple streams, may require a higher reserve (up to 40 percent). If you find that 40
percent is still not enough, increase the size of the store.

Event Stream Processor automatically estimates the required reserve size and increases the
reserve if it is too small. This usually affects only small stores.

Note: Increasing the reserve reduces the amount of space left for data. Monitor server log
messages for automatic adjustments when you start a new project. You may need to increase
the store size if these messages appear.

As the store runs, more records are written into it until the free space falls below the reserve. At
this point, the source streams are temporarily stopped, the streams quiesced, and the
checkpoint and cleaning cycle are performed. Streams do not quiesce immediately: they must
first process any data collected in their input queues. Any data produced during quiescence is
added to the store, meaning that the reserve must be large enough to accommodate this data
and still have enough space left to perform the cleaning cycle. If this data overruns the reserve,
the store becomes wedged, because it cannot perform the cleaning cycle. The automatic
reserve calculation does not account for uncheckpointed data.

Log Store Size Warnings

As the amount of data in the store grows, and the free space falls below 10 percent (excluding
the reserve), Event Stream Processor starts reporting "1og store is nearing
capacity"in the server log. If the data is deleted from the store in bursts, (for example, if
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data is collected during the day, and data older than a week is discarded at the end of the day),
these messages may appear intermittently even after the old data has been flushed. As the
cleaning cycle rolls over the data that has been deleted, the messages disappear.

Unless your log store is very small, these warnings appear before the store runs out of space. If
you see them, stop Event Stream Processor when convenient, and increase the store size.
Otherwise, Event Stream Processor aborts when the free space in the project falls below the
reserve size.

If a store is sized incorrectly, the entire reserve may be used up, or “wedged”, and cannot be
resized or preserve the content. Delete the store files and restart Event Stream Processor with a
clean store. If you make a backup of the store files before deleting them SAP Technical
Support may be able to extract content. Change the store size in the project, and it is resized on
restart. You cannot decrease the store size. When you restart a project after resizing the store, it
will likely produce server log messages about the free space being below the reserve until the
cleaning cycle assimilates the newly added free space.

Streams and Log Stores

If a stream, such as a flex stream, uses the context of local or global variables in its logic, it
generally uses a memory store. Otherwise, when Event Stream Processor is restarted, the
stream's store is preserved, but values of variables are reset. If these variables are used to create
unique keys, they are not unique.

In general, SAP recommends that you either place only the source streams into the log stores,
or place a source stream in which all the streams are directly or indirectly derived from it, into
the same log store. If the stores are mixed in the sequence of processing, an abrupt halt and
restart may cause messages about bad records with duplicate keys on restart. With local or
global variables, a restart may cause even bigger inconsistencies.

Keep the streams that change at substantially different rates in different log stores. If a log
store contains a large but nearly-static stream and a small but rapidly changing stream, each
cleaning cycle must process large amounts of data from the static stream. Keeping streams
separate optimizes cleaning cycles. While this contradicts keeping the source stream and all
the streams derived from it in the same log store, it is better to keep only the source streams in
the log stores and the derived streams in the memory stores.

ckcount Parameter

The ckcount (checkpointing count) parameter affects the size of uncheckpointed data. This
count shows the number of records that may be updated before writing the intermediate index
data. Setting it to a large value amortizes the overhead over many records to make it almost
constant, averaging 96 bytes per record. Setting it to a small value increases the overhead.
With the count set to zero, index data is written after each transaction, and for the single-
transaction records the overhead becomes:

96 + 32 * ceiling (log,(humber_of records_in_the_stream))

If a stream is small (for example, fewer than 1000 records), the overhead for each record is:
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96 + 32 * ceiling (10g,(1000)) = 96 + 32 * 10 = 416

In many cases, the record itself is smaller than its overhead of 416 bytes. Since the effect is
logarithmic, large streams are not badly affected. A stream with a million records has a
logarithm of 20 and incurs an overhead of 736 bytes per record. The increased overhead
affects performance by writing extra data and increasing the frequency of store cleaning.

sweepamount Parameter

The sweepamount parameter determines how much of the log file is “swept through” during
each cleaning pass. It must be between 5 percent to 20 percent of the fullsize parameter. A
good lower bound for the sweep size is half the size of the write cache on your storage array.
Usually, it indicates a sweep size of 512 to 1024 megabytes. Smaller sweep sizes minimize
spikes in latency at the expense of a higher average latency. High values give low average
latency, with higher spikes when reclaiming space.

If the value of the sweepamount parameter is too small, the system performs excessive
cleaning; in some cases, this does not allow the log store to free enough space during cleaning.

The size of the sweep isalso limited by the amount of free space left in reserve at the start of the
cleaning cycle. If the reserve is set lower than the sweep amount and the sweep does not
encounter much dead data, the sweep stops if the relocated live data fills up the reserve. The
swept newly cleaned area becomes the new reserve for the next cycle. Unless other factors
override, SAP recommends that you keep the sweep and the reserve sizes close to each other.
reservePct is specified in percent while sweepamount is specified in megabytes.

Log Store Size and File Locations

Ensure the total size of all log store files does not exceed the size of the machine's available
RAM. If this occurs, the machine takes longer to process the data, causing all monitoring tools
to display low CPU utilization for each stream, and standard UNIX commands such as vmstat
to display high disk usage due to system paging.

For storing data locally using log stores, SAP recommends that you use a high-speed storage
device, for example, a raid array or SAN, preferably with a large dynamic RAM cache. For a
moderately low throughput, place backing files for log stores on single disk drives, whether
SAS, SCSI, IDE, or SATA.

Sizing a Log Store

Calculate the size of the log store your project requires. Correctly sizing your log store is
important, as stores that are too small or large can lead to performance issues.

1. Estimate the maximum amount of data, in bytes, that you collect in the log store, as both
record count and volume. If you are certain about both the number of records arriving in
the source streams and the size of the records, simply perform the calculation. If not, you
can use the Playback feature in Studio or the esp_playback utility to record and play back
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real data to get a better idea of the amount of data you need to store. (See the Utilities Guide
for details on esp_playback.)

The log store reports "1iveSize™ in the server log when the project exits (with log level
three or higher) and after every compaction (with log level six or higher).

Note: Skip step 2if the messages in the server log report “1iveSize” with the indexing
overhead already included.

. To calculate the basic indexing overhead, multiply the record count by 96 bytes. Add the

result to the volume.

. Choose the value of the reservePct parameter. The required store size, in bytes, including

the reserve, is calculated as:
storeBytes = dataBytes * 100 / (100 - reservePct)

Round this value up to the next megabyte.

. Ensure the reserve cannot be overrun by the uncheckpointed data.

Estimate the maximum amount of uncheckpointed data that is produced when the input
queues of all the streams, except source streams, are full. The records in the queues that are
located early in the sequence must be counted together with any records they produce as
they are processed through the project. Include the number of output records that are
produced by the stream for each of its input records.

This example shows the stream queue depth set to the default of 1024, for a log that
contains four streams ordered like this:

source --> derivedl --> derived2 --> derived3

a) Determine the number of records that are produced by each stream as it consumes the
contents of its queue:

e 1024 records may end up in derived1l's input queue. Assuming the queue
produces one output record for one input record, it produces 1024 records.

e 2048 records may end up in derived2's input queue (1024 that are already
collected on its own queue, and 1024 more from derivedl). Assuming that
derived?2 is a join and generates on average 2 output records for each input
record, it produces 4096 records ([1024 + 1024] * 2).

e 5120 records may end up in derived3 (1024 from its own queue and 4096 from
derived?2). Assuming a passthrough ratio of 1, derived3 produces 5120
records.

When the project's topology is not linear, you must take all branches into account. The
passthrough ratio may be different for data coming from the different parent streams.
You must add up the data from all the input paths. Each stream has only one input
queue, so its depth is fixed, regardless of how many parent streams it is connected to.
However, the mix of records in each queue may vary. Assume the entire queue is
composed from the records that produce that highest amount of output. Some input
streams may contain static data that is loaded once and never changes during normal
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work. You do not need to count these inputs. In the example, derived?2 isa join
stream, and has static data as its second input.

b) Calculate the space required by multiplying the total number of records by the average
record size of that stream.
For example, if the records in derivedl average 100 bytes; derived2, 200 bytes;
and derived3, 150 bytes, the calculation is:

(1024 * 100) + (4096 * 200) + (5120 * 150) = 1,689,600

Trace the record count through the entire project, starting from the source streams
down to all the streams in the log store. Add the data sized from the streams located in
the log store.

¢) Multiply the record count by 96 bytes to calculate the indexing overhead and add the
result to the volume in bytes:

(1024 + 4096 + 5120) * 96 = 983,040

1,689,600 + 983,040 = 2,672,640

Verify that this result is no larger than one quarter of the reserve size:
uncheckpointedBytes < storeBytes * (reservePct / 4) / 100

If the result is larger than one quarter of the reserve size, increase the reserve percent
and repeat the store size calculation. Uncheckpointed data is mainly a concern for
smaller stores. Other than through the uncheckpointed data size, this overhead does not
significantly affect the store size calculation, because the cleaning cycle removes itand
compacts the data.

Creating a Log Store

If failover is enabled, configure a log store to capture the data that flows through a project.

Note: Log stores do not store SAP Sybase Event Stream Processor event logs (cluster logs,
server logs, or project logs).

Create one log store per project. The preferred destination for log store files is the base
directory where project files are stored.

1. Inthe CCL editor, create a log store using the CREATE LOG STORE Statement:

CREATE [DEFAULT] LOG STORE storename

PROPERTIES

filename='filepath'
[sync={ true | false},]
[sweepamount=size, ]
[reservepct=size, ]
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[ckcount=size, ]
[maxfilesize=filesize];
2. For the filename property enter either a relative (preferred) or absolute file path for the
location of the log store:

Relative path A relative path is relative to the ESP base directory. Using a
(preferred) relative path means that your log store automatically points to
the base directory. Relative paths do not point to the directory
stack; this means that the path does not start with a drive letter or
slash (/).

Absolute path (not | An absolute path points to any location on your machine,
recommended) regardless of the current working directory (base directory). For
Windows systems, an absolute path begins with the drive letter;
on UNIX and Solaris systems, the absolute path begins with a
slash (/).

The relative path location must be a shared disk accessible by all cluster nodes. The log
store path is specified in the filename property within the log store definition. Using a
relative path automatically places the log store under: <base-directory>/
<workspace-name>.<project-name>.<instance-number>. YOU can view
base directory definitions in the cluster configuration file (<node-name> . xm1), under
the controller section.
SAP recommends that you use a relative path. To use an absolute path, first ensure that all
cluster nodes can read and write to the absolute path you specify. This means that the
location must be the same for all cluster nodes. You must also ensure that no two projects
use the same path for the log store location. If using a shared disk is not possible, configure
a strong affinity to ensure the project always runs on the same cluster node.

3. Enter appropriate values for the remaining properties in the CREATE LOG STORE
statement.

4. Click Compile (F7).

5. Click Run Project.
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Reviewing samples of SPLASH code is the best way to familiarize yourself with its
constructs.

These code samples show how to use SPLASH. To see projects utilizing SPLASH that you can
run on your Event Stream Processor, refer to Using SPLASH In Projects.

Internal Pulsing

A stock market feed is a good example of several updates flowing into a stream.

Suppose the stock market feed keeps the last tick for each symbol. Some of the downstream
calculations might be computationally expensive, and you might not need to recalculate on
every change. You might want to recalculate only every second or every ten seconds. How can
you collect and pulse the updates so that the expensive recalculations are done periodically
instead of continuously?

The dictionary data structure and the timer facility allow you to code internal pulsing. Let's
suppose that the stream to control is called InStream. First, define two local variables in the
Flex operator:

integer version := 0;
dictionary (typeof (InStream), integer) versionMap;

These two variables keep a current version and a version number for each record. The
SPLASH code handling events from the input stream is:
{

versionMap [InStream] := version;

}

The special Timer block within the Flex operator sends the inserts and updates:
{

for (k in versionMap) {
if (version = versionMapl[k])
output setOpcode (k, upsert);
}

version++;

}

You can configure the interval between runs of the Timer block in numbers of seconds. Only
those events with the current version get sent downstream, and the version number is
incremented for the next set of updates.

This code works when InStream has only inserts and updates. It's a good exercise to extend this
code to work with deletes.
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Order Book

One example inspired by stock trading maintains the top of an order book.

Suppose there is a stream called Bid of bids of stocks (the example is kept simple by not
considering the offer side), with records of the type:

[integer Id; | string Symbol; float Price; integer Shares; ]

where Id is the key field, the field that uniquely identifies a bid. Bids can be changed, so not
only might the stream insert a new bid, but also update or delete a previous bid.

The goal is to output the top three highest bids any time a bid is inserted or changed for a
particular stock. The type of the output where Position ranges from 1 to 3 is:

[integer Position; | string Symbol; float Price; integer Shares; ]

For example, suppose the Bids have been:

[Id=1; | Symbol='IBM'; Price=43.11; Shares=1000; ]
[Id=2; | Symbol='IBM'; Price=43.17; Shares=900]
[Id=3; | Symbol='IBM'; Price=42.66; Shares=800]
[Id=4; | Symbol='IBM'; Price=45.81; Shares=50]

With the next event:
[Id=5; | Symbol='IBM'; Price=46.41; Shares=75]

The stream should output the records

[Position=1; Symbol="'IBM'; | Price=46.41; Shares=75]
[Position=2; Symbol='IBM'; | Price=45.81; Shares=50]
[Position=3; Symbol='IBM'; | Price=43.17; Shares=900]

Note: The latest value appears at the top.

One way to solve this problem is with an event cache that groups by stock and orders the events
by price:

eventCache (Bids [Symbol], coalesce, Price desc) previous;

The following code outputs the current block of the order book, down to the level specified by
the depth variable.

{

integer i := 0;
string symbol := Bids.Symbol;
while ((i < count (previous.Id)) and (i < depth) ) {

output setOpcode ([ Position=i; Symbol = symbol; |
Price=nth (i, previous.Price) ;
Shares=nth (i,previous.Shares) ;
1, upsert);
i++;
}
while (i < depth) {
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output setOpcode ([ Position=i; Symbol=symbol ], safedelete);
i++;
}
}
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CCL uses Flex operators to execute SPLASH code to process events. They have local
declaration blocks, which are blocks of SPLASH function and variable declarations. They
also have one method block per input stream and an optional timer block also written in
SPLASH.

Access to the Event

When an event arrives at a Flex operator from an input stream, the method for that input stream
is run.

The SPLASH code for that method has two implicitly declared variables for each input
stream: one for the event and one for the old version of the event. More precisely, if the input
stream is named InputStream, the variables are:

e InputStream, with the type of record events from the input stream, and
* InputStream old, with the type of record events from the input stream.

When the method for input stream is run, the variable InputStream is bound to the event
that arrived from that stream. If the event is an update, the variable InputStream oldis
bound to the previous contents of the record, otherwise it is null.

Note: Delete events always come populated with the data previously held in the input stream.

A Flex operator can have more than one input stream. For instance, if there is another input
stream called AnotherInput, the variables AnotherInput and AnotherInput oldare
implicitly declared in the method block for InputStream. They are set to null when the method
block begins, but can be assigned within the block.

Access to Input Windows

Within method and timer code in Flex operators, you can examine records in any of the input
windows.

More precisely, there are implicitly declared variables:

* <InputWindowName> stream and

* <InputWindowName> iterator.

The variable <windowName> stream is quite useful for looking up values. The
<WindowName>_ iterator is less commonly used and is for advanced users.
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For example, suppose you are processing events from an input stream called Trades, with the
following records:
[ Symbol="T'; | Shares=10; Price=22.88; ]

You might have another input window called Earnings that contains recent earnings data,
storing records:
[ Symbol="T'; Quarter="2008Q1l"; | Value=10000000.00; ]

In processing events from Earnings, you can look up the most recent Trades data using:

Trades := Trades_stream[Earnings];

The record in the Trades window that has the same key field Symbol. If there is no matching
record in the Trades window, the result is null.

When processing events from the Trades window, you can look up earnings data using:

Earnings := Earnings stream{ [ Symbol = Trades.Symbol; | ] };

The syntax here uses curly braces rather than square brackets because the meaning is different.
The Trades event does not have enough fields to look up a value by key in the Earnings
window. In particular, it's missing the field called Quarter. The curly braces indicate "find any
record in the Earnings window whose Symbol field is the same as Trades . Symbol". If
there is no matching record, the result is null.

If you have to look up more than one record, you can use a for loop. For instance, you might
want to loop through the Earnings window to find negative earnings:
for (earningsRec in Earnings stream) {
if ( (Trades.Symbol = Earnings.Symbol) and (Earnings.Value < 0) ) {
negativeEarnings := 1;
break;
}
}

As with other for loops in SPLASH, the variable earningsRec is a new variable whose
scope is the body of the loop. You can write this slightly more compactly:

for (earningsRec in Earnings stream where Symbol=Trades.Symbol) {
if (Earnings.Value < 0) {
negativeEarnings := 1;
break;
}
}

This loops only over the records in the Earnings window that have a Symbol field equal to
Trades.Symbol. If you happen to list the key fields in the where section, the loop runs
very efficiently. Otherwise, the where form is only nominally faster than the first form.

Using a Flex operator, you can access records in the window itself. For instance, if the Flex
operator is called Flex1, you can write a loop just as you can with any of the input windows:
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for (rec in Flexl) {

}

Output Statement

Typically, a Flex operator method creates one or more events in response to an event. In order
to use these events to affect the store of records, and to send downstream to other streams, use
the output statement.

Here's code that breaks up an order into ten new orders for sending downstream;
integer i:= 0;
while (i < 10) {
output setOpcode ([Id = i; |
Shares = InStream.Shares/10;
Price = InStream.Price; ], upsert);

}

Each of these is an upsert, which is a particularly safe operation; it gets turned into an insert if
no record with the key exists, and an update otherwise.

Notes on Transactions

A Flex operator method processes one event at a time. The Event Stream Processor can,
however, be fed data in transaction blocks (groups of insert, update, and delete events).

In such cases, the method is run on each event in the transaction block. The Event Stream
Processor maintains an invariant: a stream takes in a transaction block, and produces a
transaction block. It's always one block in, one block out. The Flex operator pulls apart the
transaction block, and runs the method on each event within the block. All of the events that
output are collected together. The Flex operator then atomically applies this block to its
records, and sends the block to downstream streams.

If you happen to create a bad event in processing an event, the whole block is rejected. For
example, if you try to output a record with any null key columns.

output [ | Shares = InStream.Shares; Price = InStream.Price; ];

This whole transaction block would be rejected. Likewise, if you try the following implicit

insert:

output [Id = 4; |
Shares = InStream.Shares;
Price = InStream.Price; ];

If there isalready a record in the Flex operator with Id set to 4, the block is rejected. You can get
a report of bad transaction blocks by starting the Event Stream Processor with the —B option.
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Oftenit's better to ensure that key columns are not null, and use setOpcode to create upsert
or safedelete events so that the transaction block is accepted.

Transaction blocks are made as small as possible before they are sent to other streams. For

instance, if your code outputs two updates with the same keys, only the second update is sent
downstream. If your code outputs an insert followed by a delete, both events are removed from
the transaction block. Thus, you might output many events, but the transaction block might
contain only some of them.
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Two projects demonstrate how SPLASH is used.

This project displays the top three prices for each stock symbol.

CREATE SCHEMA TradesSchema (
Id integer,
TradeTime date,
Venue string,
Symbol string,
Price float,
Shares integer

)

/* R R e S e S e b I I S i S b I b b b b b b I S I b I S S I S e S b I S S b b b S Ih S b I 2 4
* Create a Nasdag Trades Input Window
*/

CREATE INPUT WINDOW QTrades SCHEMA

TradesSchema PRIMARY KEY (Id)

’

/* R IR R b I S b b b I b b b I b 2 b 2 b b b b b b b I b b b b b I b I b b b b b b b 2b b b b b db I b 4
* Use Case a:

= Keep records corresponding to only the top three
* distinct values. Delete records that falls of the top
* three values.

*

* Here the trades corresponding to the top three prices
* per Symbol is maintained. It uses

* - eventcaches

* - local UDF

*/

CREATE FLEX Top3TradesFlex
IN QTrades
OUT OUTPUT WINDOW Top3Trades SCHEMA TradesSchema PRIMARY
KEY (Symbol, Price)
BEGIN
DECLARE
eventCache (QTrades [Symbol], manual, Price asc)
tradesCache;
/%

* Inserts record into cache if in top 3 prices and

returns
* the record to delete or just the current record if it
was
* inserted into cache with no corresponding delete.
=/
typeof (QTrades) insertIntoCache( typeof (QTrades)
gTrades )
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the

END;

}

// keep only the top 3 distinct prices per symbol in

// event cache

integer counter := 0;
typeof (QTrades) rec;
long cacheSz := cacheSize (tradesCache);
while (counter < cacheSz) {
rec := getCache( tradesCache, counter );
if( round(rec.Price,2) = round(gTrades.Price,2) ) {

// if the price is the same update
// the record.
deleteCache (tradesCache, counter);
insertCache ( tradesCache, gTrades );
return rec;
break;

} else if( gTrades.Price < rec.Price) {
break;

}

counter++;

}

//Less than 3 distinct prices

if (cacheSz < 3) {
insertCache (tradesCache, gTrades) ;
return gTrades;

} else { //Current price is > lowest price
//delete lowest price record.
rec := getCache (tradesCache, 0);

deleteCache (tradesCache, 0);
insertCache (tradesCache, gTrades) ;
return rec;

}

return null;

ON QTrades {

}i

keyCache ( tradesCache, [Symbol=QTrades.Symbol;|] );
typeof (QTrades) rec := insertIntoCache( QTrades );
if (rec.Id) {

//When id does not match current id it is a
//record to delete
if (rec.Id <> QTrades.Id) {
output setOpcode (rec, delete);
}
output setOpcode (QTrades, upsert);

This project collects data for thirty seconds and then computes the desired output values.

CREATE SCHEMA TradesSchema (
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Id integer,
TradeTime date,
Venue string,
Symbol string,
Price float,
Shares integer

)

’
/* KA AR AR KR AR A AR AR A AR A AR AR A AR A AR AR A AR A AR AR AR A A A A AR A ARk Ak kA kK

* Create a Nasdag Trades Input Window
*/
CREATE INPUT WINDOW QTrades SCHEMA
TradesSchema PRIMARY KEY (Id)

’

Ak hkhkhk kA hkk A hhkhhkhkhhhkhkhk A hkhkhhhkrhhkhkhhkhkhkrhkkrkhkhkrkhkhhkhkkkkhkxkkxk

/
Use Case b:

Perform a computation every N seconds for records
arrived in the last N seconds.

% ok ok X %

Here the Nasdag trades data is collected for 30 seconds
* before being released for further computation.
=/
CREATE FLEX PeriodicOutputFlex
IN QTrades
OUT OUTPUT WINDOW QTradesPeriodicOutput SCHEMA TradesSchema
PRIMARY KEY (Symbol, Price)
BEGIN
DECLARE
dictionary (typeof (QTrades), integer) cache;
END;
ON QTrades {
//Whenever a record arrives just insert into
dictionary.
//The key of the dictionary is the key to the record.
cache [QTrades] := 0;
}i
EVERY 30 SECONDS ({
//Cycle through event cache and output all the rows
//and delete the rows.
for (rec in cache) {
output setOpcode (rec, upsert);
}
clear (cache);
}i
END;

/**
* Perform a computation from the periodic output.
*
/
CREATE OUTPUT WINDOW QTradesSymbolStats
PRIMARY KEY DEDUCED
AS SELECT
g.Symbol,
MIN (g.Price) Minprice,
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MAX (g.Price) MaxPrice,

sum (q.Shares * g.Price)/sum(q.Shares) Vwap,
count (*) TotalTrades,

sum(g.Shares) TotalVolume
FROM

QTradesPeriodicOutput g
GROUP BY

g.Symbol
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There are several methods of querying ESP using SQL. All SQL statements must follow these
rules for dealing with the specified datatypes in ESP.

Inserting Date and Time Data

To insert date, timestamp, and bigdatetime values into a SQL statement, use the the undate,
untimestamp, and unbigdatetime functions to convert the input values into the correct
datatype.

insert into win

(c_key,date, timestamp,bigdatetime)

values (21478,undate ('2013-02-11 17:35:45") ,untimestamp ('2013-02-11
17:35:45"),

unbigdatetime ('2013-02-11 17:35:45"))

Specifying Money Data
When specifying the value for money data, you must append either d or D.
insert into win

(c_key,c money)
values (111770,8.12345d)

There are fifteen money datatypes with a fixed number of digits following the decimal point:
money1 with one digit, money2 with two digits, ... money15 with fifteen digits. When
specifying a value for one of these datatypes, you must append either d or D and the number
following money (for example d7 for money7.

insert into win

(c_key,c moneyl,c money2,c money3,c money4,c money5,c moneylO,c mon
eyl5)

values (111770,8.12345d1,8.12345d2,8.12345d3,8.12345d4,8.12345d5,8.1
23456789012345d10,8.123456789012345d15)

Reading and Writing Binary Data

To write binary data to ESP in a SQL statement, use the hex_binary() function to convert the
string representation of the hexadecimal value to binary.

insert into win

(c_key,c binary)
values (111770, hex binary('9140ACA0361856334DD319F05"))

To read binary data from ESP inan SQL statement, use the hex_string() function to convert the
binary value to a string representation of the hexadecimal value.

select c_key,hex string(c _binary)from win
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Processor

Event Stream Processor users create and manipulate the ESP schema using
PowerDesigner®.

PowerDesigner is a powerful modeling tool. Event Stream Processor users can use it develop
physical data models as well as the logical data models that define the ESP schema.

Getting Started

PowerDesigner® is a tool for creating and manipulating ESP schema. Optionally, it can be
used with physical data models.

This guide is intended for database and application development staff, and for SAP
Professional Services representatives, customer IT support, and other technical personnel
who set up and administer PowerDesigner. It includes information you need to understand,
model, and modify logical schema definitions and physical database structure when
developing schema.

Data Modeling Scenarios

Integrated modeling supports efficient schema definition and database design, and consistent
production deployments.

Using the ESP Schema and extensions, you can:

e Model schema in the ESP Schema model, a PowerDesigner logical data model

e Convert an ESP Schema logical data model to SAP HANA, ASE, or SAP Sybase 1Q
physical data models

« Convert existing SAP HANA, ASE, and SAP Sybase 1Q physical data models to an ESP
Schema logical data model

« Import schema definitions defined in a CCL file into an ESP Schema model

» Export schema definitions from an ESP Schema model into a CCL file

« Validate a model using custom checks for ESP Schema, in addition to the standard
PowerDesigner checks

* Analyze the impact of changes to schema, a model, or a database table on all components
in the integrated model

The corresponding adapter (1Q, HANA, ASE) schema must match the SAP Sybase 1Q,
HANA, and ASE database schema for all tables in which data is inserted. After you make
changes, you can use PowerDesigner to produce a set of data definition language (DDL)
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statements directly from the physical data models (1Q, HANA, and ASE). PowerDesigner
saves the DDL ina SQL script that you can run to generate the tables and other objects for the
target databases.

DDL generation does not require use of the extended modeling feature.

Sample PowerDesigner Project

A sample project supports integrated modeling.

You can install a PowerDesigner sample project that includes:
e A sample ESP Schema logical model
* SAP Sybase 1Q, SAP HANA, and ASE physical data models

Opening the Sample Project
Open the sample model from the sample project.

1. Choose Start > Programs > Sybase > Power Designer 16.
2. In the Welcome dialog, under Getting started, choose Open Model or Project.

If you are not a first-time user, you may see different options in the Welcome dialog, based
on your previous work in PowerDesigner.

3. Browse to the sample project, by defaultin $PowerDesigner 16\Examples\ESP
\ESP.pr7j, and choose Open.

PowerDesigner opens a workspace for the ESP Schema sample project.

4. Double-click the ESP project ().
The sample project opens with the sample ESP Schema model, SAP Sybase 1Q model,
ASE model, SAP HANA model, and the Model Relationship Diagram in the Browser
View.

Learning More About PowerDesigner

This guide tells you how to use PowerDesigner in ESP.

For more information on using PowerDesigner, press F1 to open the online help, or see the
PowerDesigner online product documentation, especially:

* CoreFeatures Guide— PowerDesigner interface and model basics
« Data Modeling — Building, checking, and generating models and databases

To view PowerDesigner online tutorials, choose Help > Tutorial Videos.
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Data Model

PowerDesigner includes a logical data model for ESP schema and three physical data models
for the SAP Sybase 1Q, SAP HANA, and ASE databases.

The indexes for both physical data models are database-specific and must be defined
individually. You can open, view, modify, and extend the data models using PowerDesigner.

ESP Schema Logical Data Model

The ESP Schema model represents market data in a logical data model independent of any
data store.

The ESP Schema logical model represents the building of schema and the databases parsing
schema and storing them.

The ESP Schema model contains a definition for each schema. The schema definitions are
contained in the Market Data diagram in the sample ESP Schema model. Adding schema to
the diagram is optional.

To create a new ESP Schema model, you can:

« Create it from scratch using the ESP Schema Model category

» Createitfromscratch using the ESPSchema . xem file to extend the model during or after
creation

e Generate it from an SAP Sybase 1Q, SAP HANA, or ASE physical data model

Finding an Object in a Diagram
Locate any object with a symbol in a diagram or among several diagrams. Objects without
graphical symbols, such as domains, are not shown in diagrams.
Right-click an object in the Browser and select Find in Diagram.

Data Model Tables

A list of all data model tables in the Market Data diagrams with their code names and
descriptions.

Table 3. Data model tables

Table name Code Description

Bond History BOND_HISTORY Stores bond historical data, one record per
each trading date. The data includes daily
price and yield values (open/close, high/
low), trade volume (number of bonds tra-
ded), and so on, for each bond.
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Table name Code Description

Bond Quote BOND_QUOTE Stores real-time (intraday) quote data. Each
quote record includes a yield, bid/ask price,
and size (in other words, a number of bonds
offered at a bid/ask price).

Bond Trade BOND_TRADE Stores real-time (intraday) trade data. Each

trade record includes abond's price and yield
and a transaction's size (number of bonds
traded).

Dividend Event

DIVIDEND_EVENT

Stores information on a dividend payment
event when a shareholder receives a certain
payment for each share of stock owned. The
dividend amount is commonly defined as a
certain percentage of a share price but can
also be specified as a monetary amount. The
Monetary or Percentage Indicator
(MOP_INDICATOR) column indicates how
the dividend amount is defined.

Index History

INDEX_HISTORY

Stores the index’s historical data, one record
per each trading date. The data includes the
index’s daily values (open/close, high/low)
and trade volume.

Index Intraday

INDEX_INTRADAY

Stores the index’s real-time (intraday) data
that shows its value movements during a
trading day. Each data point includes an in-
dex value and trade volume.

Mutual Fund History

MUTL_FUND_HIST

Stores the historical data for a mutual fund,
one record per each trading date. The data
includes a trade date and price.

Option History

OPTION_HISTORY

Stores the options historical data, one record
per each trading date. The data includes op-
tions daily price (open/close, high/low),
trade volume (number of contracts traded),
and so on.

Option Quote

OPTION_QUOTE

Stores the options real-time (intraday) quote
data. Each quote record includes a bid/ask
price, size (number of contracts offered at a
bid/ask price), and so on.

Option Trade

OPTION_TRADE

Stores the options real-time (intraday) trade
data. Each trade record includes a trade's
price, size (number of contracts traded), and
so on.
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Table name

Code

Description

Split Event

SPLIT_EVENT

Stores information on a stock split event
when the number of outstanding shares of a
company’s stock is increased and the price
per share is simultaneously decreased so that
proportionate equity of each shareholder re-
mains the same.

The split is characterized by a split factor; a
factor of 0.5 indicates that the number of
shares is increased two times and that the
share price is decreased two times. In a less
common reverse split, the number of shares
is decreased and the price per share is in-
creased in a similar manner; a split factor of
2 indicates that the number of shares is de-
creased two times and that the share price is
increased two times.

Stock History

STOCK_HISTORY

Stores the stock historical data, one record
per each trading date. The data includes
stocks daily prices (open/close, high/low)
and trade volume (number of shares traded).

Stock Quote

STOCK_QUOTE

Stores the stocks' real-time (intraday) quote
data. Each quote record includes a bid/ask
price and corresponding size values (in other
words, a number of shares offered at bid/ask
price).

Stock Trade

STOCK_TRADE

Stores the stocks' real-time (intraday) trade
data. Each trade record includes a transac-
tion's price and size (in other words, a num-
ber of shares traded).

Extensions

Extensions (. xem files) provide means for customizing and extending PowerDesigner
metaclasses, parameters, and generation. Extended models can be used to store additional
information, or to change model behavior.

PowerDesigner provides four . xem files:

* ESPSchema.xem —extensions for an logical data model. Contains rules and code that let
you model ESP Schema in a PowerDesigner logical data model.

* 1Q.xem —extensions for a physical data model. Contains only transformation rules needed
to convert an ESP Schema definition to an SAP Sybase 1Q table definition, in an SAP

Sybase 1Q model.
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* ASE.xem —extensions for a physical data model. Contains only transformation rules
needed to convert an ESP Schema definition to an ASE table definition, in an ASE model.

*  HANA xem —extensions for a physical data model. Contains only transformation rules
needed to convert an ESP Schema definition to an SAP HANA table definition, inaHANA
model.

When you use the models provided with PowerDesigner, the extensions are present. When
you create a new model using the ESP model category set, extensions are applied
automatically.

When you create a new model without using the ESP Model categories, or when you have an
existing model you can extend it using the PowerDesigner tools and ESP extension files.

Category Set
You can set the ESP category set to create any ESP model type.

The ESP model category set includes ESP Schema, SAP Sybase 1Q, SAP HANA, and ASE
categories. To create new models from this category set, you must enable the categories in
PowerDesigner. You can either merge the ESP categories with others that you use, or change
PowerDesigner to use only the ESP categories.

Once you set up the ESP category set, you can create any ESP model type and extend it with
the appropriate extension.

The EsP.mcc file, installed with the extensions, defines the ESP categories.

Schema Definitions
A schema definition in the ESP Schema model represents a data stream in ESP.

The sample ESP Schema model contains a schema definition for each market data table. You
can customize any schema definition, or create a new one.

To create new schema in the ESP Schema model, you can either:

« Create schema in PowerDesigner, and then generate a CCL file from it, or,
» Import schema definitions that are defined in a CCL file.

Each schema definition contains:

* identifiers—associate schema with columns that are keys in the associated table.

» attributes—associate schema with a destination column name in the SAP Sybase 1Q, SAP
HANA, and ASE databases with length and precision where appropriate, lookup table and
column information for columns that are foreign keys, and descriptive notes.
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Sample Schema Definition List

Sample schema definitions correspond to the Market Data diagram provided with
PowerDesigner. While each schema appears in the SAP Sybase 1Q, SAP HANA, and ASE
Market Data diagram, not every table in that diagram is a schema.

< Bond History

« Bond Quote

« Bond Trade

« Dividend Event
e Index History

e Index Intraday
* Mutual Fund History
e Option History
e Option Quote

e Option Trade

» Split Event

» Stock History

» Stock Quote

« Stock Trade

Impact and Lineage Analysis
PowerDesigner provides powerful tools for analyzing the dependencies between model
objects.

When you perform an action on a model object, in a single operation you can produce both:

* Impact Analysis—to analyze the effect of the action on the objects that depend on the
initial object.
e Lineage Analysis— to identify the objects that influence the initial object.

These tools can help you answer questions like these:

» If I change the precision on a column in my ASE model which I generated from the ESP
schema model, what table columns in my SAP Sybase 1Q or SAP HANA model must also
change, and what schema are affected?

« Which schema fields influence each column in my ASE, SAP HANA, and SAP Sybase 1Q
models?

e If I delete a column from my 1Q model, what is the impact on tables and columns in my
ASE and SAP Sybase 1Q models, and what schema definitions must change in my ESP
Schema model?
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Extended Model Setup

Your installer will set up the use of extensions automatically for you.

To apply the extensions automatically for new models, set up and use the ESP Schema model
category set.

To integrate existing PDMs with the ESP model, extend the models by attaching the
appropriate extensions file.

Extending an Existing Model

Attach extensions to any SAP Sybase 1Q, SAP HANA, or ASE physical data model, or to an
logical data model that was generated from an ESP physical data model but not extended.

1. Open the model you want to extend.
2. From the PowerDesigner main menu, choose Model > Extended Model Definitions.

Tip: If Extended M odel Definitionsis not in the menu, make sure that the extensions file
is unzipped in the folder where PowerDesigner is installed.

3. Click Import an Extended Model Definition &,

A list shows available extensions that have not been applied to this model.

4. Select the correct model extension and choose OK.
For example, to extend an ASE physical data model, choose ASE.

5. Inthe List of Extended M odel Definitions dialog, choose OK to extend the model.
PowerDesigner applies the ESP extensions to the model. No other changes are made. For

example, a generic logical data model is not transformed to an ESP Schema model simply by
adding the extensions.

Setting Up the Model Category Set File
Set up PowerDesigner to use the ESP category set for new models.

PowerDesigner can display only one set of categories in the New Model dialog. While not
required, using the ESP category makes it easier to develop models for use with Event Stream
Processor.

Decide which option you want to use to create new models:

Option Action required

Only the installed ESP category set Change categories

ESP category set merged with existing categories | Merge ESP categories
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Option Action required

Neither Manually extend any models

Merging ESP Categories

When you create a new model using categories, you can see the existing categories, as well as
the three standard ESP categories. You can merge existing model categories with the ESP
category.

Choose Tools > Resources > Model Category Sets.
From the list in the dialog, select the set you want to add to the ESP category.

Click the Merge button ﬂ in the toolbar.
Select ESP from the list and choose OK.

A w bR

Changing the Default Category
Change the default category to the ESP category, so that you can create new ESP models.

1. From the PowerDesigner main menu, choose Tools > General Options.
2. Under Category, select Model Creation.

3. Inthe Model Creation frame, with Enable categories checked, select a default category
set.

4. Choose OK.

Setting Datatypes for an ESP Schema

Manually set the datatype attribute for a ESP Schema definition if the ESP Data Type column
in the Attributes tab of an ESP schema definition is empty or shows the wrong values.

You may need to set datatypes for a logical data model you generate from a physical data
model, if the generation process cannot determine how to convert the database datatype to an
Event Stream Processor datatype. Datatypes for the shipped sample model are set correctly
and no further adjustments are necessary.

1. Right-click a schema definition and choose Properties.
2. Click the Attributes tab and review values in the ESP Data Type column.

For example, in the sample model, the Bond Quote Attributes shows these datatypes:

Attribute Name ESP Datatype
Instrument string

Quote Date date

Quote Sequence Number integer
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Attribute Name ESP Datatype
Quote Time timestamp

Ask Price money(4)

Ask Size integer

Bid Price money(4)

Bid Size integer

Yield money(2)

If values are missing or incorrect, continue with steps 3 - 5.

3- Click Customize Columnsand Filter f-’_! (Ctrl+U).
4. If needed, adjust columns available for viewing:

a) Unselect Data Type, Length, and Precision.
b) Select:

Name

ESP Datatype

Length

Precision

Mandatory

Primary Identifier

Displayed (selected by default)

5. Use the controls below the list to adjust the order so that Primary Identifier and
Displayed are the last two checkboxes.

Performing this task once corrects the datatypes for all schema definitions.

ESP Schema Model Development

Develop schema using the PowerDesigner extensions.

You can:

» Explore the sample model

« Create aschema model using categories, or by creating and extending a logical data model
» Add schema to models

» Validate your schema with built-in checks, as well as custom ones

* Import defined schema definitions into an ESP Schema model from CCL files

« Export schema definitions from the ESP Schema model into CCL files
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Exploring the Sample Model
Review the sample model from the sample project.

Prerequisites
Install the sample model and complete the extended model setup.

Task

1. Start PowerDesigner and open the sample project with the sample model.
2. To open any of the models, either:
* Double-click the model in the Model Relationship Diagram, or,

* Inthe Browser tree, double-click the model, or right-click and choose Open or Open
asread-only.

Note: Do not save changes to the installed sample model. Save it to another folder so thata
new version of the model and project are created.

3. Todisplay the sample schema definitions in the ESP Schema model, expand the navigation
buttons in the Browser tree.

4. To see more information on a schema definition:
» Right-click the schema definition, an identifier, or an attribute in the tree view and

choose Properties, or,
* Right-click the schema definition in the tree view and choose Find in Diagram.

Explore the SAP Sybase 1Q, SAP HANA, and ASE models in the same way.

The Sample Model

The sample model includes sample ESP schema, and the SAP Sybase 1Q, SAP HANA, and
ASE data models.

The right frame shows the diagram selected. The top-level Model Relationship diagram shows
that the ESP Schema model is related to the three physical data models by generation—that is,
these physical models were generated from the logical model. You can also generate a logical
model from a physical model.

When you open the ESP Schema model and expand a schema definition and its attributes in
the Browser, you see a hierarchy like this one for Bond History.
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Figure 2: ESP Schema Definitions in Browser
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To show the Bond History diagram, right-click it in the Browser and choose Find in
Diagram.

Figure 3: Bond History Diagram

Bond History

Instrument string =pis
Trade Date date =pi=
Time To Maturity integer
Open Price money(4)
Close Price money(4)
High Price money(4)
Low Price money(4)
Open Yield money(2)
Close Yield money(2)
High Yield money(2)
Low Yield money(2)
Volume integer

Creating an ESP Schema Model

Create a new ESP Schema model using the ESP Schema category, either by creating a logical
model and extending it, or by generating it from an SAP Sybase 1Q, SAP HANA, or ASE
model that has been extended.

Creating a Model Using Categories
Use PowerDesigner to create and automatically extend any ESP Schema model type.

Prerequisites
Designate the ESP Schema set as the default category.

Task

1. Choose File> New Model.
2. Inthe New Model dialog, select Categories, and choose a category item:

e ESP Schema
* SAP SybaselQ
« ASE
« HANA
3. Enter a model name.
4. Choose OK.

Creating a Logical Data Model
Create a logical data model and add extensions to it.

1. Choose File> New Mod€.
2. In the New Model dialog, select M odel typesand L ogical Data M odel.
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3,
4,

5.

Enter a model name.

Click the Select Extensions button 2 to the right of the Extensions box.

A dialog shows currently loaded extensions. You can apply extensions when you create the
model or later.

Select ESP Schema, select whether to share or copy, and choose OK.

Option Description

Share the PowerDesigner always uses the contents of the . xem file. If the

extended model | contents of the . xem file change, the model sees those changes.

definitions For example, if a future version of ESP Schema includes a new
version of the file, models that share it sees those changes
immediately.

Copy the Copies the contents of the . xem file into the model. The model

extended model | uses its local copy instead of the file on disk.

definitions

With either approach, you can use other extensions besides the shipped ESP Schema
extensions by creating your own . xem file. Although it is possible to do this by adding to
the ESPSchema . xem file, SAP does not recommended this.

Adding Schema Definition

Add a schema definition by creating it, importing schema definitions in a CCL file, or
generating it from an SAP Sybase 1Q, SAP HANA, or ASE table.

Creating Schema from the Schema Definitions Container

Create a new schema definition with initial properties.

1
2.
3.

4,

Open the ESP Schema model.
In the Browser tree, right-click the ESP Schemas container and choose New.
Complete the information in the General tab or other tabs.

You can complete schema definition properties at any time before generating the physical
models.

Click OK to save the schema definition.

Creating Schema with the Entity Tool

Create schema from the diagram.

1
2.

Open the ESP Schema model.
In the diagram, click the Entity tool E
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A new, empty schema definition appears in the diagram, and in the Browser tree when
expanded.

3. Right-click the diagram and choose Properties.
4. Add attributes and identifiers in the properties sheet.

Creating a Schema from the ESP Schema Container
Create a new schema definition with initial properties.

1. Right-click the ESP Schema container and choose New > ESP Schema.
2. Complete the information in the General tab or other tabs.

You can complete schema definition properties at any time before generating the physical
models.

3. Click OK to save the schema definition.

Generating Schema from a Sybase 1Q, SAP HANA, or ASE Table
Follow the same steps as when generating an ESPSchema model, selecting a single table to
generate.

Defining Schema Properties
Define schema details in the properties sheet.

Prerequisites
Add the schema definition to the ESP Schema model.

Task

Open the ESP Schema Properties sheet from the Browser tree or the diagram.

Edit fields on the General, Attributes, and | dentifier stabs.

(Optional) Right-click an attribute to open the Attribute Properties sheet.

(Optional) In the Attribute Properties sheet, choose M or eto see extended property details.
Choose Apply to apply changes.

Choose OK when done.

o o~ wDNPE
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General Tab Properties

View information about the Name, and Comment properties of a schema definition on the
General tab of the Schema Definition Properties sheet.

Table 4. Schema Definition Properties — General Tab

Property Description

Name Text that identifies the object's purpose for non-technical users, for example,
Stock Quote. This element is used for descriptive purposes only, and can contain
any string.

Comment An optional comment field. This is stored only in the model, not in the schema.

Attributes Tab Properties

The Attributes tab of the Schema Definition Properties sheet lets you quickly set information

for all fields of an ESP Schema.

Table 5. Schema Definition Properties — Attributes Tab

Property Description

Name Name of the field. The value can contain any
string. This element is used for descriptive pur-
poses only.

Code By default the code is generated from the name by

applying the naming conventions specified in the
model options. To decouple name-code synchro-
nization, click to release the = button to the right
of the Code field.

ESP Datatype

Select from the list of supported ESP datatypes.

For more information on supported datatypes and
conversions, see related information in Power-
Designer>Core Features Guide.

Data Type (Internal PowerDesigner datatype)

Select from the list of supported datatypes.

For more information on supported datatypes and
conversions, see related information in Power-
Designer>Core Features Guide.

Length

Required for money data.

Limited to precision 38. Precision must be the
same on SAP Sybase 1Q and ASE.

Not used for other datatypes.
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Property Description

Precision Required for money data. Not used for other da-
tatypes.

Domain Specifies a domain which defines the datatype

and related data characteristics for the schema
attribute. It may also indicate check parameters,
and business rules.

Select a domain from the list, or click the Ellipsis
button to create a new domain in the List of Do-
mains.

Attribute Properties Sheet
Each field in a schema definition has its own Properties sheet.

In the Attribute Properties Sheet, you can:

* View or edit the same information as in the Attributes tab of the Schema Definition
Properties sheet

« Specify validation checks for an attribute
* View attribute dependencies
* View impact and lineage analyses for an attribute

Adding an Attribute to Schema
Add fields to schema by adding attributes to the schema definition.

1. In the schema definition to which you are adding an attribute, do any of:

» From the schema definition, right-click and choose New. This opens the Attribute
Properties sheet.

< From the Attributes tab in the ESP Schema Properties sheet, type information in the
row below the last attribute.

« From the Attributes tab in the ESP Schema Properties sheet, click one of the toolbar
buttons to Insert a Row, Add a Row, or Add Attributes or Replicate Attributes
from other schema definitions.

Before replicating attributes, read Object Replications in PowerDesigner Core Features
Guide.

2. Edit information in the Attributes Properties sheet or row as needed.

Identifiers
An identifier is a column or combination of columns that uniquely defines a specific ESP
Schema.

Identifiers in the ESP Schema model become keys on tables in the SAP Sybase 1Q, SAP
HANA, and ASE physical models.
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Each ESP Schema can have at most one primary identifier, which becomes the primary key in
the generated table.

When an identifier has multiple attributes, the primary key in the destination table is composed
of multiple columns. For example, in the sample model, the Dividend Event schema has one
identifier. Attributes for this primary identifier are Instrument and Disbursed Date. Thus the
primary key for the Dividend Event table is composed of both the Instrument and Disbursed
Date columns.

Defining Identifiers
Define identifiers to indicate which schema attributes become keys in the destination table.

1. Either:

* Right-click an ESP Schema and choose New > I dentifier, or

* (Primary identifiers only) On the ESP Schema Properties sheet, select the Attributes
tab, and click the Primary Identifier column (the narrow column with the header P) for
each attribute that is part of the primary identifier. Skip the remaining steps.

Note: In the ESP Schema Properties Attributestab, a checkmark in the P column
indicates a primary identifier.

2. Select the General tab in the Identifier Properties sheet:
a) (Optional) Set the identifier name.
b) For a primary key, select Primary | dentifier.

3. On the Attributestab in the Identifier Properties sheet, enter the fields that identify the
schema.

Validating a Model

Check the validity of your model after schema changes, and before generating schema
templates, code, or a physical model.You can check the validity of a model at any time.

1. (Optional) Select diagrams for the schema you want to validate.

2. Choose Tools > Check Modél (F4).

3. Inthe Optionstab of Check Model Parameters, expand the containers and choose
validation checks.
The Optionstab lists checks to be performed with symbols indicating their severity.
« Do not disable any ESP-specific checks.
* (Default and recommended) Disable Existence of relationship or entity link under

Entity.

4. Inthe Selection tab, navigate to the ESP Schemas subtab and select schema definitions to

check:

« Select or unselect check boxes.
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e Choose a named selection.
» Ifyou selected schema in your diagram before starting the model check, you can select

them for checking by clicking Use Graphical Selection () in the Selection tab
toolbar.

5. Choose OK.

Next
Review results in the Check M odel subtab in the status bar. It lists the checks made, and any
errors or warnings.

Correct any errors. No automatic corrections are provided.

PowerDesigner Validity Checks
Standard PowerDesigner checks determine if a model is internally consistent and correct.

For example:

« Each ESP Schema name must be unique
» Each object name in an ESP Schema model must be unique
« Each field must have an assigned ESP Data Type.

For descriptions of standard PowerDesigner checks, see Working with Data Models >
Checking a Data Model in the PowerDesigner Data Modeling guide.

Custom Checks for ESP Schema Extensions
The ESP Schema extension offers many custom checks.

Checks for Each Schema
Custom checks under Schema Definition type validate values in the General tab of the Schema
Properties sheet.

Table 6. Schema Definition Custom Checks

Option Validates
NamelsValid Names of ESP Schema must be valid java iden-
tifiers.

Checks for Each Field in a Schema
Custom checks for fields are under Entity Attribute type. They validate values in the Attributes
tab of the ESP Schema Properties sheet.
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Table 7. Attribute Custom Checks

Option

Validates

FieldNamelsValid

Field names must be valid java identifiers.

ESPDatatypeExists

Datatype is specified

UniqueDestColumnName

DestColumnName is unique within that schema

Impo

rting a CCL File

Import the defined schema definitions in a CCL file into an ESP Schema model.

1
2.

File....

Open the ESP Schema model.
In the Browser tree, right-click the ESP Schema container and choose Import CCL

Navigate to the CCL file you wish to import.
Click OK to import the schema definitions defined in the CCL file.

Note: A warning message appears if the CCL file schema definitions are not valid. You
must resolve the errors before importing the CCL file. Navigate to the

$PowerDesigner

compiledOutput.

16/Resource Files/ESP Compiler/
log file to view the errors.

The schema defined in the CCL file is imported into the ESP Schema model.

Expo

rting a CCL File

Export all the defined schema from the ESP Schema model into a CCL file for compiling and
further analysis.

1
2.

3,
4,

File....

Open the ESP Schema model.
In the Browser tree, right-click the ESP Schema container and choose Export CCL

Navigate to the CCL file you wish to export to.
Click OK to export the schema definitions.

The schema defined in the ESP Schema model is exported as a CCL file.

Model Generation

Model generation with the ESP Schema models is a critical step in ensuring the integrity of
your production environment.

You can either:
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Generate SAP Sybase 1Q, SAP HANA, and ASE physical data models from an ESP
Schema model, or

Generate an ESP Schema logical datamodel from an SAP Sybase 1Q, SAP HANA, or ASE
physical data model

Each generation process relies on transformation rules for that model type, which are defined
in the ESP Schema extensions for PowerDesigner.

Generating a new Sybase I1Q, SAP HANA, or ASE Model from an ESP

Schema Model

Generate either an SAP Sybase 1Q, SAP HANA, or an ASE physical data model from an ESP
Schema logical data model.

1
2.
3.

Open the ESPSchema model.
From the PowerDesigner main menu, choose Tools > Generate Physical Data M odel.

In the General tab of the PDM Generation Options dialog, choose Gener ate new
Physical Data Moddl.

For a new model, choose the target DBMS and the appropriate Name and Code.

* For HANA, choose:

Field

Value

DBMS

SAP HANA Database 1.0

Name

Keep the default, ESPSchema, or enter another name.

Code

Auto-generated from Name. For example, when Name is ESPSchema, Code is
ESPSCHEMA.

For ASE, choose:

Field

Value

DBMS

Sybase Adaptive Server Enterprise 15.7

Name

Keep the default, ESPSchema_1 (the name of the container), or enter another name.

Code

Auto-generated from Name. For example, when Name is ESPSchema_1, Code is
ESPSCHEMA 1.

For 1Q, choose:

Field

Value

DBMS

SAP Sybase |Q 15.X

Note: Use latest version of SAP Sybase 1Q available.
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Field |[Value

Name | Keep the default, ESPSchema_1 (the name of the container), or enter another name.

Code | Auto-generated from Name. For example, when Name is ESPSchema_1, Code is
ESPSCHEMA _1.

Click the Detail tab.
(Optional) Choose Check model and Save gener ation dependencies.
Ensure that Enable transfor mations is selected.

© N o O

Click the Extensions tab and ensure that the appropriate extension is selected:
* ASE when generating a new Adaptive Server Enterprise model

* |1Q when generating a new SAP Sybase 1Q model

* HANA when generating a new SAP HANA model

9. Onthe Pre-generation and Post-gener ation tabs, ensure that all transformation rules are
selected.

The post-generation tab appears only for new models.

10. On the Selection tab, select ESPSchemarto create tables for SAP Sybase 1Q, SAP HANA,
or ASE, and choose OK.

Next
After generation, check indexes, set physical options, and add foreign keys as needed.

Checking Indexes
PowerDesigner creates default indexes. Add, edit, or remove them as needed.

1. Open the new or updated physical data model.
2. For each table, right-click the table and choose Properties.
3. Inthe Indexestab, edit indexes as needed for your data and performance requirements.

Setting Physical Options
Set physical options for each table as needed for your SAP Sybase 1Q or ASE database.

1. Right-click the table and choose Properties.
2. Define any options needed.

* (ASE only) In the Physical Options(Common) tab, choose from the physical options
most commonly set for the object.

* Inthe Physical Optionstab, choose from all available options.
* (ASE only) In the Partitions tab, set partitioning options for selected columns.

For more information on partitioning, see the Adaptive Server Enterprise and SAP Sybase
IQ documentation sets.
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Adding Foreign Keys

Add foreign-key relationships to physical data models.

1

2.
3.

Add tables to the physical data model that are not in your Market Data diagram and that
contain lookup columns for foreign keys.

New ASE, SAP HANA, and SAP Sybase 1Q models generated from a ESP Schema model
contain only market data tables.

Right-click the table and choose Propertiesor Keys.

Add foreign-key relationships to tables that are not in the Market Data diagram.

Generating anew ESP Schema Model from a Sybase 1Q, SAP HANA, or

ASE Model

Generate a new ESP Schema logical data model from either SAP Sybase 1Q, SAP HANA, or
ASE physical data models.

1.
. From the PowerDesigner main menu, choose Tools > Generate L ogical Data M odel.

6.
7.
8.

Open either the 1Q, HANA, or ASE model.

In the Gener al tab of the LDM Generation Options dialog, choose Gener atenew L ogical
Data Model.

Specify a Name.

Code is autogenerated from the name.

On the Detail tab, choose Options:

e (Optional) Check model

« (Optional) Save generation dependencies

e (Optional) Convert names into codes

e (Required) Enable transformations

On the Extensions tab, choose ESPSchema.

On the Selection tab, choose tables from which to generate schema.
Choose OK.

Updating an existing Sybase 1Q, SAP HANA, or ASE Model from an

ESP Schema Model

Update either an SAP Sybase 1Q, SAP HANA, or a ASE physical data model from a ESP
Schema logical data model.

1
2.

Open the ESP Schema model.
From the PowerDesigner main menu, choose Tools > Generate Physical Data M odél.
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3. Inthe General tab of the PDM Generation Options dialog, choose Update existing
Physical Data Moddl.

Select the model and leave Preserve M odifications selected.

Click the Detail tab.

(Optional) Choose Check model and Save gener ation dependencies.
Ensure that Enable transfor mations is selected.

In the Merge Models dialog, confirm the updates you want and choose OK.

© N o 0 A

Next
After generation, check indexes, set physical options, and add foreign keys as needed.

Updating an existing ESP Schema Model from a Sybase 1Q, SAP

HANA, or ASE Model

Update an existing ESP Schema logical data model from either SAP Sybase 1Q, SAP HANA,
or ASE physical data models.

1. Open either the 1Q, HANA, or ASE model.
2. From the PowerDesigner main menu, choose Tools > Gener ate L ogical Data M odel.

3. Inthe General tab of the LDM Generation Options dialog, choose Update existing
Logical Data Model.

4. Select the model and leave Preserve M odifications selected.

5. On the Detail tab, choose Options:

(Optional) Check model

(Optional) Save generation dependencies

(Optional) Convert names into codes

(Required) Enable transformations

6. On the Selection tab, choose tables from which to generate schema.
7. Choose OK.

Impact and Lineage Analysis

With impact and lineage analysis, you can determine the full impact of changes to any object
in the integrated model.

Impact analysis shows the effect of an action on the objects that depend on the initial object.
Lineage analysis identifies the objects that influence the initial object.
You can perform these analyses on:

« A schema definition or any of its properties in the ESP Schema logical data model
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» Atable or column in the ASE, SAP HANA, or SAP Sybase 1Q physical data model
The results shows the effect of a change throughout the logical and physical data models.

Launching an Impact and Lineage Analysis

Analyze the impact of a change to your model from the Impact and Lineage Analysis dialog
box.

The Impact and Lineage Analysis dialog lets you review your analysis through:

* A preview — displays the impact and lineage analysis in a tree form (see PowerDesigner
Core Features Guide > Reviewing an Analysis in Preview).

* Animpact analysis model (IAM) — displays the impact and lineage analysis in a diagram
(see PowerDesigner Core Features Guide > Reviewing an Analysis in an IAM Model).

1. Open an impact and lineage analysis in any of these ways:

» Select an object in the Browser or in the diagram and press Ctrl + F11.

» Select one or more objects in the diagram and select Tools > Impact and Lineage
Analysis.

* Right-click an object symbol in the diagram and select Edit > Impact and Lineage
Analysis.

» Right-click an object entry in the Browser and select Impact and Lineage Analysis.

* (When deleting an object) Click | mpact on the Confirm Deletion dialog box.

* Open an object's property sheet, click the Dependencies tab, then click | mpact
Analysis.

2. (Optional) Enter a name for your analysis result. This becomes the name of the generated
model.

3. Select an impact rule set for your analysis. Choose one of these predefined rule sets:

e Conceptual Impact Analysis — restrict the analysis to objects impacted by modeling
changes on the initial object, such as a modification on a requirement definition.
« Data Impact Analysis —identify the use, if any, of a value contained in the initial object.

* Delete Impact Analysis — (default when deleting an object) restrict the analysis to
objects that are directly impacted by the deletion of the initial object.

« Global Impact Analysis — (default when not deleting an object) identify all the objects
that depend on the initial object.

» None — no impact rule set is selected.
4. Select a lineage rule set for your analysis. Choose one of these predefined rule sets:

« Conceptual Lineage Analysis — justify the modeling existence of the initial object, and
ensure it fulfills a well-identified need.

< Data Lineage Analysis — identify the origin of the value contained in the initial object.
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5.

< Global Lineage Analysis — (default when not deleting an object) identify all the objects
that influence the initial object.
* None - (default when deleting an object) no lineage rule set is selected.

(Optional) Click the Propertiestool next to each rule set to review it (see PowerDesigner
Core Features Guide > Editing analysis rules).

The analysis appears in the Impact and Lineagetab of the dialog box (see PowerDesigner
Core Features Guide > Reviewing an Analysis in Preview).

Note: You can click the Select Path tool to change the default folder for analysis rule sets, or
click the List of Rule Setstool to open the List of Impact and Lineage Analysis Rule Sets
window, and review a specific rule.

Generating an Analysis Diagram

Generate an analysis diagram to view the impact or lineage analysis in graphical form.

Prerequisites
Launch an impact or lineage analysis.

Task

1

2.

In the Impact and Lineage Analysis dialog, click Generate Diagram to view a graphical
form of the analysis in its default diagram.

(Optional) Save (Ctrl+S) the diagram as an impact analysis model (IAM).
See PowerDesigner Core Features Guide > Reviewing an Analysis in an IAM Model.

Reviewing an Impact and Lineage Analysis

Review the analysis in the preview or the impact and lineage model diagram.

1
2.
3.

Review the impact of the action and the lineage of the entity in the preview.
In the preview List tab, save the analysis in RTF or CSV format, or print.

You can refine your analysis by removing or adding initial objects, changing the analysis
rule sets to be used, and customizing actions.

If you have generated an IAM, you can customize the display preferences and model
options, print the model, and compare it with another IAM.

Watch for a red dot on an object icon in a generated model.
When you generate a model to another model or create an external shortcut, you create

cross-model dependencies, which are taken into account during impact and lineage
analysis.

When an object belonging to an unavailable related model is encountered, a red dot
appears on the object icon and the analysis is interrupted. To continue, open the related
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model by right-clicking the object in the IAM Browser or in the preview, and selecting
Open Model.

Sample Analysis for a Schema Definition

The sample analysis for a schema definition shows that the Bond History schema in the ESP
Schema model was used to generate the BOND HISTORY tables in the SAP HANA, ASE,
and SAP Sybase 1Q models.

Figure 4: Impact Analysis Example for Schema Definition

%% Impact and Lineage Analysis = |-G =
Analysis result name:  Impact analysis for ESP Schema "Bond History” [Change]

Analysisile sets o 53

Impact nle set: [GIobaI Impact Analysis '] &

Lineage rule set: [GIobaI Lineage Analysis '] &

Impact and Lineage | List
3 |ﬂ [7] Use Repositam

ﬂi Impact analysis for ESP Schema ‘Bond Histary' [Change]
=1-{_ Initial Objects

(%]

[ Generate Diagram ] [ Close J [ Help
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Sample Analysis for a Table

The sample analysis for a table shows that the STOCK_QUOTE table was generated from the
Stock Quote schema definition in the ESP Schema model.

Outgoing References shows foreign-key relationships. ESP Schema definitions become
Market Data diagram tables when generated to a PDM.

Figure 5: Impact and Lineage Analysis for STOCK_QUOTE Table in ASE

ﬁ;i Impact and Lineage Analysis = @
Analysis result name:  Impact analysis for Table "Stock Quote’ [Change]

Analysisrle sets [ 5

Impact rule set: lGIobaI Impact Analysis 'l &

Lineage rule set: ’GIobaI Lineage Analysis 'l &

Impact and Lineage | List

=R [ Uze Repasitany
ﬁ_;i Impact analysis for Table "Stock Guote’ [Change]

=1+ Initial Objects

[¥%)

Generate Diagram ] [ (Cloze l [ Help
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DDL Script Generation

The data models for the SAP Sybase 1Q, SAP HANA, and ASE databases target different
databases; however, they share an almost identical structure. Modify data models by creating
additional tables or columns to suit your business environment.

The corresponding adapter (1Q, HANA, ASE) schema must match the SAP Sybase 1Q,
HANA, and ASE database schema for all tables in which data is inserted. After you make
changes, you can use PowerDesigner to produce a set of data definition language (DDL)
statements directly from the physical data model (1Q, HANA, and ASE). PowerDesigner
saves the DDL statements in a SQL script that you can run to generate the tables and other
objects for the target databases.

Generating Database Schema with PowerDesigner
PowerDesigner includes all the resources you need to generate a set of DDL statements in

SQL scripts directly from the PowerDesigner data models. Run these scripts to generate a
schema for your SAP Sybase 1Q, SAP HANA, and ASE databases.

In PowerDesigner, open the data model.

Change the default database user.

Generate the script that creates a schema for the new database.
Log in to the database and run the script.

> w DN

Changing the Default Database User
Overwrite the default database owner for the SAP Sybase 1Q, SAP HANA, or ASE database
with a name specific to your environment.

In the database, the user who creates an object (table, view, stored procedure, and so on) owns
that object and is automatically granted all permissions on it. Overwriting the default user
name globally changes ownership of database objects from the default owner to the new
owner.

1. Start PowerDesigner.

2. Select File>Open and choose the database that you want to change the default owner of (
IQ.pdm, HANA.pdm, Of ASE . pdm).

3. Select Model > Usersand Roles> Users.
4. Inthe Name and Code columns, change the default user to the new database user.
5. Click OK.
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Generating DDL Scripts

Generate DDL scripts directly from the SAP Sybase 1Q, SAP HANA, or ASE data model.
PowerDesigner saves the results in a SQL script that you can use to generate the tables and
other objects in the target database.

Use the model file of the database for which you wish to generate DDL scripts. For example, to
generate DDL for the ASE database, use the ASE model. When you have the model open, do
not change the target database as doing so results in the loss of index information.

By default, the ASE . pdm data model includes only those indexes that support the sample
queries. The statements that create these indexes are included in the DDL scripts, which
means the indexes supplied with the model are created automatically when you run the
corresponding DDL scripts.

You can add or remove indexes from the ASE data model. For detailed information on ASE
indexes, see the Adaptive Server Enterprise product documentation.

1. Select Database > Generate Database.

2. Browse to the directory where you want to store the script. Click OK.
3. Enter a name for the SQL script.

4. On the Options tab, verify that the options are set correctly:

Object Options
Domain Create User-Defined Data Type
Table Create Table
Column User Data Type
Key Create Primary Key Inside
Index e Create Index
¢ Index Filter Foreign Key
¢ Index Filter Alternate Key
e Index Filter Cluster
e Index Filter Others

Click the Selection tab.
Choose the database owner.
On the Tablestab, click Select All.

On the Domainstab, choose the database owner, click Select All, click Apply, then click
OK.

© N o u

PowerDesigner checks the model for any errors, builds a result list, and generates the
DDL. The Result dialog appears, which identifies the name and location of the generated
file.
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9. You can click Edit to view the generated script.
The Result List dialog appears in the background and may include several warnings, for

example, "Existence of index"and "Existence of reference". You
can safely ignore these warnings.

10. Close the Result List dialog, then exit PowerDesigner.

« If PowerDesigner prompts you to save the current workspace, click No.
« If PowerDesigner prompts you to save the model, click Yesto save the modified model.
Otherwise, click No.

Executing DDL Scripts for the SAP Sybase IQ Database

Execute the DDL script in Interactive SQL and create database objects in the SAP Sybase 1Q
database.

Prerequisites
Start the SAP Sybase 1Q database server if it is not running.

Task

1. Inacommand prompt, change to the directory that contains the database files and enter:

start iq -n server name Qconfig file.cfg database name.db.

Use the -n switch to name the server, either in the configuration file or on the command line
when you start the server.

Note: If you specify -n server_name without a database_name, you connect to the default
database on the current server. If you specify -n database name without a server_name,
you connect to the specified database on the current server.

2. Enter dbisql.

3. Enter the correct user ID, password, and server information.

4. Openthe generated DDL script for SAP Sybase 1Q and click Execute SQL Statement on
the toolbar.

Executing DDL Scripts for the SAP HANA Database
Execute the DDL script using hdbsgl and create database objects in the SAP HANA database.

Prerequisites
Start the SAP HANA database server if it is not running.

Task
In a command prompt, enter:
hdbsgl -n <host>:<port> -u <user> -p <password> -I <script file>
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Executing DDL Scripts for the ASE Database
Execute the DDL script in Interactive SQL and create database objects in the ASE database.

Prerequisites

Start the ASE server if it is not running.

Task

1. Inacommand prompt, enter:

isgl -S <server name> -U <user name> -P <password> -i <ase ddl.sql
file> -o <log file>

2. PowerDesigner prompts:

» To save the current workspace. Click No

* To save the (modified) model. Click Yesor No.
3. Check the log file for errors.
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Reserved words in CCL that are case-insensitive. Keywords cannot be used as identifiers for

any CCL objects.

A list of keywords present in CCL:
adapter age(s) all and as asc
attach auto begin break case cast
connection | continue count create day(s) declare
deduced default delete delta desc distinct
dumpfile dynamic else end eventCache every
exit external false fby filter first
flex for foreign foreigndava | from full
group groups hash having hour(s) hr
if
import in inherits inner input insert
into is join keep key last
language left library like load local
log max memory micros microsecond(s) | millis
millisec- min minute(s) module money name
ond(s)
new nostart not nth null on
or order out outfile output parameter(s)
partition partitions
pattern primary properties rank records retain
return right roundrobin row(s) safedelete schema
sec
second(s) select set setRange slack start
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static store(s) stream sum sync switch
then times to top transaction true
type typedef typeof union update upsert
values when where while window within
xmlattri- xmlelement

butes
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Set time zone parameters, date format code preferences, and define calendars.

Time Zones

Atime zone is a geographic area that has adopted the same standard time, usually referred to as
the local time.

Most adjacent time zones are one hour apart. By convention, all time zones compute their local
time as an offset from GMT/UTC. GMT (Greenwich Mean Time) is an historical term,
originally referring to mean solar time at the Royal Greenwich Observatory in Britain. GMT
has been replaced by UTC (Coordinated Universal Time), which is based on atomic clocks.
For all SAP Sybase Event Stream Processor purposes, GMT and UTC are equivalent. Due to
political and geographical practicalities, time zone characteristics may change over time. For
example, the start date and end date of daylight saving time may change, or new time zones
may be introduced in newly created countries.

Internally, Event Stream Processor always stores date and time type information as a number
of seconds, milliseconds, or microseconds since midnight January 1, 1970 UTC, depending
on the datatype. If a time zone designator is not used, UTC time is applied.

Daylight Saving Time

Daylight saving time is considered if the time zone uses daylight saving time and if the
specified timestamp is in the time period covered by daylight savings time. The starting and
ending dates for daylight saving time are stored in a C++ library.

If the user specifies a particular time zone, and if that time zone uses daylight saving time,
Event Stream Processor takes these dates into account to adjust the date and time datatype. For
example, since Pacific Standard Time (PST) is in daylight saving time setting, the engine
adjusts the timestamp accordingly:

to timestamp ('2002-06-18 13:52:00.123456 PST', 'YYYY-MM-DD
HH24:MI:SS.ff TZD')

Transitioning from Standard Time to Daylight Savings Time and Vice-Versa

During the transition to and from daylight saving time, certain times do not exist. For example,
in the US, during the transition from standard time to daylight savings time, the clock changes
from 01:59 to 03:00; therefore 02:00 does not exist. Conversely, during the transition from
daylight saving time to standard time, 01:00 to 01:59 appears twice during one night because
the time changes from 2:00 to 1:00 when daylight saving time ends.
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However, since there may be incoming data input during these undefined times, the engine
must deal with them in some manner. During the transition to daylight savings time, Event
Stream Processor interprets 02:59 PST as 01:59 PST. When transitioning back to standard
time, Event Stream Processor interprets 02:00 PDT as 01:00 PST.

Changes to Time Zone Defaults

If you do not specify a value for the optional time zone parameter in certain date and time
functions, Event Stream Processor uses Coordinated Universal Time (UTC).

Corresponding functions in Sybase CEP defaulted to the server's local time zone when no
parameter was specified. If you are migrating CEP projects that do not have a time zone
defined, they will use UTC when converted to Event Stream Processor. To continue using the
server’s local time zone, explicitly set that time zone in the time zone parameter for the
following functions:

Sybase CEP Functions Event Stream Processor Functions
dayofmonth dayofmonth
dayofweek dayofweek
dayofyear dayofyear

hour hour
maketimestamp makebigdatetime
microsecond microsecond
minute minute

month month

second second
to_string to_string

year year

List of Time Zones
Event Stream Processor supports standard time zones and their abbreviations.

Below is a list of time zones used in the Event Stream Processor from the industry-standard
Olson time zone (also known as TZ) database.

ACT AET AGT

ART AST Africa/Abidjan
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Africa/Accra Africa/Addis_Ababa Africa/Algiers
Africa/Asmera Africa/Bamako Africa/Bangui
Africa/Banjul Africa/Bissau Africa/Blantyre
Africa/Brazzaville Africa/Bujumbura Africa/Cairo
Africa/Casablanca Africa/Ceuta Africa/Conakry

Africa/Dakar Africa/Dar_es_Salaam Africa/Djibouti
Africa/Douala Africa/El_Aaiun Africa/Freetown
Africa/Gaborone Africa/Harare Africa/Johanneshurg
Africa/Kampala Africa/Khartoum Africa/Kigali
Africa/Kinshasa Africa/Lagos Africa/Libreville
Africa/Lome Africa/Luanda Africa/Lubumbashi
Africa/Lusaka Africa/Malabo Africa/Maputo
Africa/Maseru Africa/Mbabane Africa/Mogadishu
Africa/Monrovia Africa/Nairobi Africa/Ndjamena
Africa/Niamey Africa/Nouakchott Africa/Ouagadougou
Africa/Porto-Novo Africa/Sao_Tome Africa/Timbuktu
Africa/Tripoli Africa/Tunis Africa/Windhoek
America/Adak America/Anchorage America/Anguilla
America/Antigua America/Araguaina America/Argentina/Bue-

nos_Aires

America/Argentina/Cata-
marca

America/Argentina/ComodRiva-
davia

America/Argentina/Cordoba

America/Argentina/Jujuy

America/Argentina/La_Rioja

America/Argentina/Mendoza

America/Argentina/

America/Argentina/San_Juan

America/Argentina/Tucuman

Rio_Gallegos

America/Argentina/Ush- America/Aruba America/Asuncion
uaia

America/Atka America/Bahia America/Barbados

America/Belem

America/Belize

America/Boa_Vista
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America/Bogota

America/Boise

America/Buenos_Aires

America/Cambridge_Bay

America/Campo_Grande

America/Cancun

America/Caracas

America/Catamarca

America/Cayenne

America/Cayman

America/Chicago

America/Chihuahua

America/Coral_Harbour

America/Cordoba

America/Costa_Rica

America/Cuiaba

America/Curacao

America/Danmarkshavn

America/Dawson

America/Dawson_Creek

America/Denver

America/Detroit

America/Dominica

America/Edmonton

America/Eirunepe

America/El_Salvador

America/Ensenada

America/Fort_Wayne

America/Fortaleza

America/Glace_Bay

America/Godthab

America/Goose_Bay

America/Grand_Turk

America/Grenada

America/Guadeloupe

America/Guatemala

America/Guayaquil

America/Guyana

America/Halifax

America/Havana

America/Hermosillo

America/Indiana/Indianapolis

America/Indiana/Knox

America/lndiana/Marengo

America/Indiana/Petersburg

America/Indiana/Vevay

America/Indiana/Vincennes

America/Indianapolis

America/Inuvik

America/lgaluit

America/Jamaica

America/Jujuy America/Juneau America/Kentucky/Louisville
America/Kentucky/Monti- | America/Knox_IN America/La_Paz

cello

America/Lima America/Los_Angeles America/Louisville

America/Maceio

America/Managua

America/Manaus

America/Martinique

America/Mazatlan

America/Mendoza

America/Menominee

America/Merida

America/Mexico_City

America/Miquelon

America/Moncton

America/Monterrey

America/Montevideo

America/Montreal

America/Montserrat

America/Nassau

America/New_York

America/Nipigon

America/Nome

America/Noronha

America/North_Dakota/Center
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America/Panama

America/Pangnirtung

America/Paramaribo

America/Phoenix

America/Port-au-Prince

America/Port_of_Spain

America/Porto_Acre

America/Porto_Velho

America/Puerto_Rico

America/Rainy_River

America/Rankin_Inlet

America/Recife

America/Regina

America/Rio_Branco

America/Rosario

America/Santiago

America/Santo_Domingo

America/Sao_Paulo

America/Scoresbysund

America/Shiprock

America/St_Johns

America/St_Kitts

America/St_Lucia

America/St_Thomas

America/St_Vincent

America/Swift_Current

America/Tegucigalpa

America/Thule

America/Thunder_Bay

America/Tijuana

America/Toronto

America/Tortola

America/Vancouver

America/Virgin

America/Whitehorse

America/Winnipeg

America/Yakutat America/Yellowknife Antarctica/Casey
Antarctica/Davis Antarctica/DumontDUrville Antarctica/Mawson
Antarctica/McMurdo Antarctica/Palmer Antarctica/Rothera
Antarctica/South_Pole Antarctica/Syowa Antarctica/Vostok
Arctic/Longyearbyen Asia/Aden Asia/Almaty
Asia/Amman Asia/Anadyr Asia/Agtau
Asia/Aqtobe Asia/Ashgabat Asia/Ashkhabad
Asia/Baghdad Asia/Bahrain Asia/Baku
Asia/Bangkok Asia/Beirut Asia/Bishkek
Asia/Brunei Asia/Calcutta Asia/Choibalsan
Asia/Chongqing Asia/Chungking Asia/Colombo
Asia/Dacca Asia/Damascus Asia/Dhaka
Asia/Dili Asia/Dubai Asia/Dushanbe
Asia/Gaza Asia/Harbin Asia/Hong_Kong
Asia/Hovd Asia/lrkutsk Asia/lstanbul

Asia/Jakarta

Asia/Jayapura

Asiallerusalem
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Asia/Kabul Asia/Kamchatka Asia/Karachi
Asia/Kashgar Asia/Katmandu Asia/Krasnoyarsk
Asia/Kuala_Lumpur Asia/Kuching Asia/Kuwait
Asia/Macao Asia/Macau Asia/Magadan
Asia/Makassar Asia/Manila Asia/Muscat
Asia/Nicosia Asia/Novosibirsk Asia/Omsk
Asia/Oral Asia/Phnom_Penh Asia/Pontianak
Asia/Pyongyang Asia/Qatar Asia/Qyzylorda
Asia/Rangoon Asia/Riyadh Asia/Riyadh87
Asia/Riyadh88 Asia/Riyadh89 Asia/Saigon
Asia/Sakhalin Asia/Samarkand Asia/Seoul
Asia/Shanghai Asia/Singapore Asia/Taipei
Asia/Tashkent Asia/Thilisi Asia/Tehran
Asia/Tel_Aviv Asia/Thimbu Asia/Thimphu
Asia/Tokyo Asia/Ujung_Pandang Asia/Ulaanbaatar
Asia/Ulan_Bator Asia/Urumgqi Asia/Vientiane
Asia/Vladivostok Asia/Yakutsk Asia/Yekaterinburg

Asia/Yerevan

Atlantic/Azores

Atlantic/Bermuda

Atlantic/Canary

Atlantic/Cape_Verde

Atlantic/Faeroe

Atlantic/Jan_Mayen

Atlantic/Madeira

Atlantic/Reykjavik

Atlantic/South_Georgia

Atlantic/St_Helena

Atlantic/Stanley

Australia/ACT

Australia/Adelaide

Australia/Brisbane

Australia/Broken_Hill

Australia/Canberra

Australia/Currie

Australia/Darwin

Australia/Hobart

Australia/LHI

Australia/Lindeman

Auwustralia/Lord_Howe

Australia/Melbourne

Australia/NSW

Australia/North

Australia/Perth

Australia/Queensland

Australia/South

Australia/Sydney

Australia/Tasmania

Australia/Victoria

Australia/\West
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Australia/Yancowinna BET BST

Brazil/Acre Brazil/DeNoronha Brazil/East
Brazil/West CAT CET

CNT CST CST6CDT

CTT Canada/Atlantic Canada/Central
Canada/East-Saskatche- Canada/Eastern Canada/Mountain
wan

Canada/Newfoundland Canada/Pacific Canada/Saskatchewan

Canada/Yukon Chile/Continental Chile/Easterlsland
Cuba EAT ECT

EET EST ESTSEDT
Egypt Eire Etc/GMT
Etc/GMT+0 Etc/GMT+1 Etc/GMT+10
Etc/GMT+11 Etc/GMT+12 Etc/GMT+2
Etc/GMT+3 Etc/GMT+4 Etc/GMT+5
Etc/GMT+6 Etc/GMT+7 Etc/GMT+8
Etc/GMT+0 Etc/GMT-0 Etc/GMT-1
Etc/GMT-10 Etc/GMT-11 Etc/GMT-12
Etc/GMT-13 Etc/GMT-14 Etc/GMT-2
Etc/GMT-3 Etc/GMT-4 Etc/GMT-5
Etc/GMT-6 Etc/GMT-7 Etc/GMT-8
Etc/GMT-9 Etc/GMTO Etc/Greenwich
Etc/UCT Etc/UTC Etc/Universal
Etc/Zulu Europe/Amsterdam Europe/Andorra
Europe/Athens Europe/Belfast Europe/Belgrade

Europe/Berlin

Europe/Bratislava

Europe/Brussels

Europe/Bucharest

Europe/Budapest

Europe/Chisinau

Europe/Copenhagen

Europe/Dublin

Europe/Gibraltar
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Europe/Helsinki

Europe/lIstanbul

Europe/Kaliningrad

Europe/Kiev Europe/Lisbon Europe/Ljubljana
Europe/London Europe/Luxembourg Europe/Madrid
Europe/Malta Europe/Mariehamn Europe/Minsk
Europe/Monaco Europe/Moscow Europe/Nicosia
Europe/Oslo Europe/Paris Europe/Prague
Europe/Riga Europe/Rome Europe/Samara
Europe/San_Marino Europe/Sarajevo Europe/Simferopol
Europe/Skopje Europe/Sofia Europe/Stockholm

Europe/Tallinn

Europe/Tirane

Europe/Tiraspol

Europe/Uzhgorod Europe/Vaduz Europe/Vatican
Europe/Vienna Europe/Vilnius Europe/Warsaw
Europe/Zagreb Europe/Zaporozhye Europe/Zurich
Factory GB GB-Eire

GMT GMT+0 GMT-0

GMTO Greenwich HST

Hongkong IET IST

Iceland Indian/Antananarivo Indian/Chagos

Indian/Christmas

Indian/Cocos

Indian/Comoro

Indian/Kerguelen

Indian/Mahe

Indian/Maldives

Indian/Mauritius

Indian/Mayotte

Indian/Reunion

Iran Israel JST

Jamaica Japan Kwajalein

Libya MET MIT

MST MST7MDT Mexico/BajaNorte

Mexico/BajaSur

Mexico/General

Mideast/Riyadh87

Mideast/Riyadh88

Mideast/Riyadh89

NET

NST

NZ

NZ-CHAT
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Navajo PLT PNT

PRC PRT PST

PST8PDT Pacific/Apia Pacific/Auckland
Pacific/Chatham Pacific/Easter Pacific/Efate
Pacific/Enderbury Pacific/Fakaofo Pacific/Fiji

Pacific/Funafuti

Pacific/Galapagos

Pacific/Gambier

Pacific/Guadalcanal

Pacific/Guam

Pacific/Honolulu

Pacific/Johnston

Pacific/Kiritimati

Pacific/Kosrae

Pacific/Kwajalein

Pacific/Majuro

Pacific/Marquesas

Pacific/Midway

Pacific/Nauru

Pacific/Niue

Pacific/Norfolk

Pacific/Noumea

Pacific/Pago_Pago

Pacific/Palau

Pacific/Pitcairn

Pacific/Ponape

Pacific/Port_Moreshy

Pacific/Rarotonga

Pacific/Saipan

Pacific/Samoa

Pacific/Tahiti

Pacific/Tarawa

Pacific/Tongatapu Pacific/Truk Pacific/Wake
Pacific/Wallis Pacific/Yap Poland

Portugal ROC ROK

SST Singapore SystemV/AST4
SystemV/AST4ADT SystemV/CST6 SystemV/CST6CDT
SystemV/EST5 SystemV/ESTSEDT SystemV/HST10
SystemV/MST7 SystemV/MST7TMDT SystemV/PST8
SystemV/PST8PDT SystemV/YST9 SystemV/YSTOYDT
Turkey UCT US/Alaska
US/Aleutian US/Arizona US/Central
US/East-Indiana US/Eastern US/Hawaii
US/Indiana-Starke US/Michigan US/Mountain
US/Pacific US/Pacific-New US/Samoa

uTC Universal VST
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W-SU WET Zulu

Date/Time Format Codes

A list of valid components that can be used to specify the format of a date/time type: date,
timestamp, or bigdatetime.

Date/time type formats must be specified with either the Event Stream Processor formatting
codes, or a subset of timestamp conversion codes provided by the C++ strftime() function. The
are a number of different valid codes, however, A valid date/time type specification can
contain no more than one occurrence of a code specifying a particular time unit (for example, a
code specifying the year).

Note: All designations of year, month, day, hour, minute, or second can also read a fewer
number of digits than is specified by the code. For example, DD reads both two-digit and
one-digit day entries.

Event Stream Processor Time Formatting Codes

Column Code Description Input | Output
MM Month (01-12; JAN = 01). Y Y
YYYY Four-digit year. Y Y
YYY Last three digits of year. Y Y
YY Last two digits of year. Y Y
Y Last digit of year. Y Y
Q Quarter of year (1, 2, 3, 4; JAN-MAR =1). N Y
MON Abbreviated name of month (JAN, FEB, ..., DEC). | Y Y
MONTH Name of month, padded with blanks to nine char- | Y Y
acters (JANUARY, FEBRUARY, ..., DECEMBER).
RM Roman numeral month (1-XI1I; JAN =1). Y Y
ww Week of year (1-53), where week 1 starts on the first | N Y
day of the year and continues to the seventh day of
the year.
w Week of month (1-5), where week 1 startsonthe | N Y
first day of the month and continues to the seventh
day of the month.
D Day of week (1-7; SUNDAY = 1). N Y
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Column Code Description Input [ Output
DD Day of month (1-31). Y Y
DDD Day of year (1-366). N Y
DAY Name of day (SUNDAY, MONDAY, ..., SATUR- | Y Y

DAY).
DY Abbreviated name of day (SUN, MON, ..., SAT). | Y Y
HH Hour of day (1-12). Y Y
HH12 Hour of day (1-12). Y Y
HH24 Hour of day (0-23). Y Y
AM Meridian indicator (AM/PM). Y Y
PM Meridian indicator (AM/PM). Y Y
Ml Minute (0-59). Y Y
SS Second (0-59). Y Y
SSSSS Seconds past midnight (0-86399). Y Y
SE Seconds since epoch (January 1, 1970 UTC). This | Y Y

format can only be used by itself, with the FF for-

mat, and/or with the time zone codes TZD, TZR,

TZH and TZM.
MIC Microseconds since epoch (January 1, 1970 UTC). Y
FF Fractions of seconds (0-999999). When used in Y Y

output, FF produces six digits for microseconds.

FFFF produces twelve digits, repeating the six dig-

its for microseconds twice. (In most circumstances,

thisis not the desired effect.) When used in input, FF

collects all digits until a non-digit is detected, and

then uses only the first six, discarding the rest.
FF[1-9] Fractions of seconds. For output only, produces the | N Y

specified number of digits, rounding or padding

with trailing zeros as needed.
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Column Code Description Input [ Output

MS Milliseconds since epoch (January 1, 1970 UTC). | Y Y
When used for input, this format code can only be
combined with FF (microseconds) and the time
zone codes TZD, TZR, TZH, TZM. All other format
code combinations generate errors. Furthermore,
when MS is used with FF, the MS code must pre-
cede the FF code: for example, MS.FF.

FM Fill mode toggle: suppress zeros and blanks or not | Y Y
(default: not).

FX Exact mode toggle: match case and punctuations | Y Y
exactly (default: not).

RR Lets you store 20th century dates in the 21st century | Y N
using only two digits.

RRRR Round year. Accepts either four-digit or two-digit | Y N
input. If two-digit, provides the same return as RR.

TZD Abbreviated time zone designator such as PST. Y Y

TZH Time zone hour displacement. For example, -5 in- | N Y

dicates a time zone five hours earlier than GMT.

TZM Time zone hour and minute displacement. Forex- | N Y
ample, -5:30 indicates a time zone that is five hours
and 30 minutes earlier than GMT.

TZR Time zone region name. For example, US/Pacific | N Y
for PST.

Strftime() Timestamp Conversion Codes
Instead of using Event Stream Processor time formatting codes, output timestamp formats can
be specified using a subset of the C++ strftime() function codes. The following rules apply:

« Any timestamp format specification that includes a percent sign (%) is considered a
stritime() code.

 Strings can only include one type of formatting codes: the Event Stream Processor
formatting codes, or the strftime() codes.

» Some strftime() codes are valid only on Microsoft Windows or only on UNIX-like
operating systems. Different implementations of strftime() also include minor differences
in code interpretation. To avoid errors, ensure that both the ESP Server and the ESP Studio
are on the same platform, and are using compatible strftime() implementations. It is also
essential to confirm that the provided codes meet the requirements for the platform.
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« Alltime zones for formats specified with strftime() are assumed to be the local time zone.
« strftime() codes cannot be used to specify date/time type input, only date/time type output.

The Event Stream Processor supports the following strftime() codes:

Strftime() Description

Code

%a Abbreviated weekday name; example: "Mon".

%A Full weekday name: for example "Monday".

%Db Abbreviated month name: for example: "Feb".

%B Full month name: for example "February".

%c Full date and time string: the output format for this code differs, depending on
whether Microsoft Windows or a UNIX-like operating system is being used.
Microsoft Windows output example: 08/26/08 20:00:00 UNIX-like operating
system output example: Tue Aug 26 20:00:00 2008

%d Day of the month, represented as a two-digit decimal integer with a value
between 01 and 31.

%H Hour, represented as a two-digit decimal integer with a value between 00 and
23.

%I Hour, represented as a two-digit decimal integer with a value between 01 and
12.

%j Day of the year, represented as a three-digit decimal integer with a value be-
tween 001 and 366.

%m Month, represented as a two-digit decimal integer with a value between 01 and
12.

%M Minute, represented as a two-digit decimal integer with a value between 00 and
59.

%p Locale's equivalent of AM or PM.

%S Second, represented as a two-digit decimal integer with a value between 00 and
61.

%U Number of the week in the year, represented as a two-digit decimal integer with a
value between 00 and 53, with Sunday considered the first day of the week.

%w Weekday number, represented as a one-digit decimal integer with a value be-
tween 0 and 6, with Sunday represented as 0.
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Calendar Files

Strftime() Description

Code

%W Number of the week in the year, represented as a two-digit decimal integer with a
value between 00 and 53, with Monday considered the first day of the week.

%X Full date string (no time): The output format for this code differs, depending on
whether you are using Microsoft Windows or a UNIX-like operating system.
Microsoft Windows output example: 08/26/08 UNIX-like operating system
output example: Tue Aug 26 2008

%X Full time string (no date).

%y Year, without the century, represented as a two-digit decimal number with a
value between 00 and 99.

%Y Year, with the century, represented as a four-digit decimal number.

%% Replaced by %.

A text file detailing the holidays and weekends in a given time period.

Syntax

weekendStart <integer>
weekendEnd <integer>
holiday yyyy-mm-dd
holiday yyyy-mm-dd

Components

weekendStart Aninteger that represents a day of the week, when
Monday=0, Tuesday=1, ..., Saturday=>5, and Sun-
day=6.

weekendEnd Aninteger that represents a day of the week, when
Monday=0, Tuesday=1, ..., Saturday=5, and Sun-
day=6.

holiday A day of the year, in the form yyyy-mm-dd. A

calendar file can have unlimited holidays.
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A calendar file is a text file that describes the start and end date of a weekend, and the holidays
within the year. The lines beginning with '# characters are ignored, and can be used to provide

user clarification or comments.

Calendar files are loaded and cached on demand by the Event Stream Processor. If changes
occur in any of the calendar files, acommand must be sent to refresh the cached calendar data,

the refresh_calendars command.

Example
The following is an example of a legal calendar file:

# Sybase calendar data for US 1983

weekendStart 5
weekendEnd 6

holiday
holiday
holiday
holiday
holiday
holiday
holiday

1983-02-21
1983-04-01
1983-05-30
1983-07-04
1983-09-05
1983-11-24
1983-12-26
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APPENDIXC  Performance and Tuning Tips

Optimizing performance in SAP Sybase Event Stream Processor requires tuning at the project
level as well as at the infrastructure level (machine, OS, network configuration, and so on).

If you tune your projects to produce maximum throughput and minimum latency but do not
configure your infrastructure to handle the throughput, you will see sub-optimal performance.
Likewise, if you configure your infrastructure to handle maximum throughput but do not tune
your projects, your performance suffers.

Distributing Load through Parallelization

To improve performance of large ESP projects, separate the data into smaller chunks that are
processed within their own partitions. Processing on multiple partitions in parallel can
improve performance over processing in one large partition.

There are various ways to parallelize an ESP project.

1. Application-based Partitioning

You can send all incoming data to each of the input adapters within your ESP project, and then
attach each of these adapters to a stream or delta stream that filters a subset of the overall
incoming data. The output adapters receive this data and output it to the external datasource.

Advantages:

« You can improve performance and process high volumes of data since having multiple
streams processing subsets of the data divides the load on the processor.

< You also have the advantage of not having to create a custom adapter or do any custom
coding aside from specifying the filtering.
« Can partition across cores, but is best suited for partitioning across machines.

Disadvantages over other methods:

* You have to duplicate the input data feeding into the input adapters.
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Input
Stream

Adapter
Adapter

Partition 1

Incoming Outgoing

Data Data

Adapter
Adapter

Partition 2

Input
Stream

Adapter
Adapter

Partition 3

2. Partitioning Using a Custom Adapter

You can write a custom adapter to receive input data and publish it to various streams, delta
streams, or windows on separate machines. These streams or windows would then process and
send this data to separate output adapters which would then publish it to the end datasource.
The custom adapter is responsible for partitioning the input data in this scenario.

Advantages:

» You can improve performance and process high volumes of data by filtering incoming data
across multiple machines.

* You can customize your adapter to meet your partitioning requirements.

* You do not need to duplicate any data.

< Can partition across cores, but is best suited for partitioning across machines.

Disadvantage over other methods:

» Requires more effort in terms of coding because you have to write a custom adapter as you
cannot currently partition the available adapters provided with Event Stream Processor.

2B

Partition 1

Incoming Custom
Data Adapter

Partition 2

2B

Partition 3

Adapter

Outgoing
Data

Adapter

Adapter
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3. Partitioning Using a SPLITTER Statement
You can use the CCL SPLITTER object to subdivide input data based on specific criteria, and
then a UNION statement to consolidate the data before sending it to the output adapter.

Advantages:

« You have more flexibility in terms of the operations that you can perform on the streams
resulting from the SPLITTER. For example, you first split the data, perform operations on
the resulting streams, and then consolidate the data again.

« Can partition across cores.

_§ =3

Although the example in the illustration uses a single input adapter, you can use a SPLITTER
when using multiple input adapters.

Incoming
Data

output
Adapter

[
L
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o
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=
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Note: Using the JOIN object does not realize the same performance benefit as using the
UNION. In fact, the JOIN operation can degrade performance considerably, so to optimize
performance, parallelizing your project using the SPLITTER/UNION combination is
recommended over using JOIN.

In both the cases, the number of parallel instances is limited to the throughput of the union and,
when used, the SPLITTER. In addition, the number of parallel instances depends on the
number of available CPUs.

General Guidelines

Hash partitioning uses hash functions to partition data. The hash function determines which
partition to place a row into based on the column names you specify as keys. These do not have
to be primary keys. Round-robin partitioning distributes data evenly across partitions without
any regard to the values.

Choose a type based on the calculations you are performing on the input data. For example,
round-robin is sufficient for stateless operations like simple filters, but not for aggregation as
this would produce differing results. Hash partitioning is necessary for grouping records
together, but grouping may not evenly distribute the data across instances.

When implementing the scenarios above, you can use round-robin or key-based partitioning.
Round-robin partitioning provides the most even distribution across the multiple parallel
instances, but is recommended only for projects limited to insert operations (that is, no updates
or deletes). For projects using insert, update, and delete operations, key-based partitioning is
preferable. Any update or delete operation on a record should occur on the same path where
the record was inserted, and only key-based partitioning can guarantee this. However, key-
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based partitioning can distribute load unevenly if the HASH function is not applied correctly,
which results in some partitions with a higher burden than others.

For more information on the SPLITTER and UNION statements, see the Programmers
Reference Guide and refer to the splitter, Union, and RAP splitter examples
provided in your Examples folder.

Distributing Load through Modularization

You can optimize performance by breaking projects into modules. This strategy spreads the
load out to more cores, thereby increasing throughput.

Use modules to double, quadruple, and so on, the number of partitions, with very little
additional code. The more partitions you create, the more you distribute the load.

For information on modularity, see the Programmers Reference, the Continuous Computation
Language chapter in the Getting Started Guide, and the Submodules example provided in
your examples folder.

Data Flow in Event Stream Processor

The throughput of an Event Stream Processor project depends on the throughput of the slowest
component in the project.

Each stream in ESP has an internal queue that holds up to 1024 messages. This queue size is
hard-coded and cannot be modified. An internal queue buffers data feeding a stream if that
stream is unable to keep up with the inflowing data.

Consider an example where data flows from an input adapter, through streams A, B, and C,
and then through an output adapter. If the destination target of the output adapter cannot
handle the volume or frequency of messages being sent by the output adapter, the internal
queue for the stream feeding the output destination fills up and stream C cannot publish
additional messages to it. As a result, the internal queue for stream C also fills up and stream B
can no longer publish to it.

This continues up the chain until the input adapter can no longer publish messages to stream A.
If, in the same example, the input adapter is slower than the other streams, messages will
continue being published from stream to stream, but the throughput is constrained by the
speed of the input adapter.

Note that if your output destination is a database, you can batch the data for faster inserts and
updates. Set the batch size for a database adapter in the service . xml file for the database.
For information on configuring the service.xml file, see the Configuration and
Administration Guide.
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Batching data carries some risk of data loss because the database adapters run on an in-
memory system. To minimize the risk of data loss, set the batch size to 1.

Log Store Considerations

The size and location of your log stores can impact performance.

Sizing the log stores correctly is important. A store that is too small requires more frequent
cleaning cycles, which severely degrades performance. In the worst case, the log store can
overflow and cause the processing to stop. A store that is too large also causes performance
issues due to the larger memory and disk footprint. For detailed information on calculating the
optimal log store size, see Basic Administrative Tasks > Sizing the Log Store in the
Configuration and Administration Guide.

When storing ESP data locally using log stores, use a high-speed storage device (for example,
araid array or SAN, preferably with a large dynamic RAM cache). Putting the backing files
for log stores on single disk drives (whether SAS, SCSI, IDE, or SATA) always yields
moderately low throughput.

Note: On Solaris, putting log files in /tmp uses main memory.

Batch Processing

When stream processing logic is relatively light, inter-stream communication can become a
bottleneck. To avoid such bottlenecks, you can publish data to the ESP server in micro batches.
Batching reduces the overhead of inter-stream communication and thus increases throughput
at the expense of increased latency.

ESP supports two modes of batching: envelopes and transactions.

* Envelopes—When you publish data to the server using the envelope option, the server
sends the complete block of records to the source stream. The source stream processes the
complete block of records before forwarding the ensuing results to the dependent streams
in the graph, which in turn process all the records before forwarding them to their
dependent streams. In envelope mode, each record in the envelope is treated atomically so
a failure in one record does not impact the processing of the other records in the block.

* Transactions—When you publish data to the server using the transaction option,
processing is similar to envelope mode in that the source stream processes all of the records
in the transaction block before forwarding the results to its dependent streams in the data
graph. Transaction mode is more efficient than envelope mode but there are some
important semantic differences between the two.

The key difference between envelopes and transactions is that in transaction mode, if one
record in the transaction block fails, then all records in the transaction block are rejected
and none of the computed results are forwarded downstream.
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Another difference is that in transaction mode, all resultant rows produced by a stream,
regardless of which row in the transaction block produced them, are coalesced on the key
field. Consequently, the number of resulting rows may be somewhat unexpected.

In both the cases the number of records to place in a micro batch depends on the nature of the
model and needs to be evaluated by trial and error. Typically, the best performance is achieved
when using a few tens of rows per batch to a few thousand rows per batch. Note that while

increasing the number of rows per batch may increase throughput, it also increases latency.

Main Memory Usage

There are no SAP Sybase Event Stream Processor configuration settings that directly set up or
control RAM usage on the machine. However, ESP reference counts records in the system,
ensuring that at most one copy of a record is present in memory, although multiple references
to that record may exist in different streams.

Memory usage is directly proportional to the number of records in a project. To limit the
amount of memory the entire instance of ESP uses before it reports an out-of-memory
condition, use the ulimit command to restrict the amount of memory available to each shell
process.

Determining Stream Memory Usage

When the server is running at log level 7 and it is shutdown cleanly, it reports the amount of
memory consumed by every stream and any aggregation indices in the server log file.

The log level is a project configuration option you can set on the Advanced tab of the Project
Configuration editor in Studio.

You do not have to constantly run the server at log level 7 to print memory usage statistics; the
statistics are printed as long as the level is set at 7 when the server is shutting down. To change
the log level at run time, use the esp_client tool and execute:

esp_client -p [<host>:]<port></workspace-name/project-name> -c
<username>:<password> "loglevel 7"

Not all of the memory consumed by the server is reported when the server shuts down.
Therefore, the total of the reported memory will not be equal to the memory reported by
system utilities (Task Manager in Windows or top in Linux) for the ESP Server. Components
that potentially consume significant amounts of memory that are not reported include:

 Input queues for streams.

e SPLASH data structures such as vectors and dictionaries used.
 Indices required for handling Retention and Aging.

» Subscriber queues.
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< Memory required to process SQL subscriptions that require aggregation and pulsed
subscriptions.

The following sample illustrates the memory usage statistics reported in the log file:

[SP-6-131039] (189.139) sp(21115) CompiledSourceStream (W1l) :
Collecting statistics (this could take awhile).

[SP-6-131040] (190.269) sp(21115) CompiledSourceStream(Wl): Memory
usage: 1,329,000,000 bytes in 3,000,000 records.

[SP-6-114012] (190.269) sp(21115) Platform(cepgplinuxl) ::run() --
cleaning up CompiledAggregateStream (grpbyout) .

[SP-6-131039] (191.065) sp(21115) CompiledAggregateStream (grpbyout) :
Collecting statistics (this could take awhile).

[SP-6-124001] (191.065) sp(21115)
CompiledAggregateStream (grpbyout) : :Memory usage: 1,545,000,000 bytes
in aggregation index.

[SP-6-131039] (195.957) sp(21115) CompiledAggregateStream (grpbyout) :
Collecting statistics (this could take awhile).

[SP-6-131040] (196.267) sp(21115) CompiledAggregateStream (grpbyout) :
Memory usage: 1,020,000,000 bytes in 3,000,000 records.
[SP-6-114012] (196.267) sp(21115) Platform(cepgplinuxl) ::run() --
cleaning up CompiledAggregateStream (grpbyout?2) .

[SP-6-131039] (197.038) sp(21115)

CompiledAggregateStream (grpbyout2): Collecting statistics (this
could take awhile).

[SP-6-124001] (197.039) sp(21115)
CompiledAggregateStream (grpbyout?2) : :Memory usage: 1,545,000,000
bytes in aggregation index.

[SP-6-131039] (202.184) sp(21115)

CompiledAggregateStream (grpbyout2): Collecting statistics (this
could take awhile) .

[SP-6-131040] (202.496) sp(21115)

CompiledAggregateStream (grpbyout2): Memory usage: 1,122,000,000
bytes in 3,000,000 records.

[SP-6-114012] (202.496) sp(21115) Platform(cepgplinuxl) ::run() --
cleaning up CompiledStream(coutputwin) .

[SP-6-131039] (202.496) sp(21115) CompiledStream(coutputwin) :
Collecting statistics (this could take awhile).

[SP-6-131040] (203.654) sp(21115) CompiledStream (coutputwin) : Memory
usage: 651,000,000 bytes in 3,000,000 records.

CPU Usage

SAP Sybase Event Stream Processor automatically distributes its processing load across all
the available CPUs on the machine. If the processing of a data stream seems slow, monitor
each stream’s CPU utilization using either the esp_monitor utility from the command line or
through Sybase Control Center. If the monitoring tool shows one stream in the project using
the CPU more than other streams, refine the project to ensure that the CPU is used evenly
across the streams.

In addition to the CPU usage per stream as reported by the monitoring tools, the queue depth is
also a very important metric to monitor. Each stream is preceded by a queue of input records.
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All input to a given stream is placed in the input queue. If the stream processing logic cannot
process the records as quickly as they arrive to the input queue, the input queue can grow to a
maximum size of 1,024 records. At that point, the queue stops accepting new records, which
results in the automatic throttling of input streams. Since throttled streams require no CPU
time, all CPU resources are distributed to the streams with the full queues, in effect performing
a CPU resource load balance of the running project. When a stream's input queue is blocked,
but the stream has managed to clear half of the pending records, the queue is unblocked, and
input streams can proceed to supply the stream with more data.

If this inherent load balancing is insufficient to clear the input queue for any given stream, the
backup of the queue can percolate upward causing blockages all the way up the dependency
graph to the source stream. If your monitoring indicates growing or full queues on any stream
or arc of streams in the directed graph, examine this collection of streams to determine the
cause of the slow processing.

TCP Buffer and Window Sizes

High throughput data transfers between clients and SAP Sybase Event Stream Processor rely
on the proper tuning of the underlying operating system's TCP networking system.

The data generated by clients for delivery to ESP does not always arrive at a uniform rate.
Sometimes the delivery of data is bursty. In order to accommodate large bursts of network
data, large TCP buffers, and TCP send/receive windows are useful. They allow a certain
amount of elasticity, so the operating system can temporarily handle the burst of data by
quickly placing it in a buffer, before handing it off to ESP for consumption.

If the TCP buffers are undersized, the client may see TCP blockages due to the advertised TCP
window size going to zero as the TCP buffers on the ESP server fill up. To avoid this scenario,
tune the TCP buffers and window sizes on the server on which ESP is running to between one
and two times the maximum size that is in use on all client servers sending data to ESP.

For information and best practices for determining and setting TCP buffer and window sizes,
consult the documentation provided with your operating system.

Improving Aggregation Performance

Aggregation functions typically require the server to iterate over every element in a group. For
this reason, the performance of the aggregation operator is inversely proportional to the size of
the group.

Aggregation functions can be used ina SELECT statement along with a GROUP BY clause or
over event caches in SPLASH inside UDFs and FLEX operators.
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Forthe SUM, COUNT, AVG, and valuelnserted aggregation functions, the server can perform
additive optimization, where the function executes in constant time. In such cases, the time it
takes to perform an operation is the same regardless of group size.

In a SELECT statement, the server can perform additive optimization provided functions
eligible for optimization are used in all values being selected, with the exception of the
columns referenced in the GROUP BY clause.

The following SELECT is optimized for additive optimization since all non-GROUP BY
columns (name, counter, summary) only use additive aggregation functions (that is,
valuelnserted, SUM, and COUNT).

CREATE OUTPUT WINDOW AggResult
SCHEMA (id INTEGER, name STRING, counter INTEGER, summary FLOAT)
PRIMARY KEY DEDUCED
AS
SELECT BaselInput.intData 1 AS id,
valueInserted (BaseInput.strData 1) AS name,
count (BaseInput.intData 1) AS counter,
sum (BaseInput.dblData 1) AS summary
FROM BaselInput
GROUP BY Baselnput.intData 1

’

Note: For optimal peformance, when selecting only the column ina SELECT statement witha
GROUP BY clause, use the valuelnserted function, where feasible.

The following SELECT is not optimized for additive optimization since one of the non-
GROUP BY columns (name) directly selects a column which cannot be computed additively.

CREATE OUTPUT WINDOW AggResult
SCHEMA (id INTEGER, name STRING, counter INTEGER, summary FLOAT)
PRIMARY KEY DEDUCED
AS
SELECT BaselInput.intData 1 AS id,
BaseInput.strData 1 AS name,
count (BaseInput.intData 1) AS counter,
sum (BaseInput.dblData 1) AS summary
FROM BaseInput
GROUP BY BaselInput.intData 1

’

When applying aggregation functions over an event cache, additive optimization is turned on
when using the SUM, COUNT, AVG, or valuelnserted functions only in the ON clause of a
FLEX operator. The additive optimization does not apply when functions are used inside a
UDF.

The following Flex stream computes the SUM in the ON clause additively, since the SUM
function is computed additively and the used EventCaches (e0,el) are declared locally.
CREATE INPUT WINDOW Inl

SCHEMA (cl INTEGER, c2 STRING, c3 INTEGER, summary FLOAT)
PRIMARY KEY (cl, c2);
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CREATE FLEX MyFlex
IN Inl
OUT OUTPUT WINDOW FlexOut
SCHEMA (cl INTEGER, c2 INTEGER, c¢3 INTEGER, c4 INTEGER)
PRIMARY KEY (cl, c2)

BEGIN
declare
eventCache (Inl, coalesce) e0;
eventCache (Inl, coalesce) el;
end;
ON Inl {

{
output setOpcode([cl=Inl.cl;c2=Inl.c2; |
c3=sum(e0.cl);cd4=sum(el.c3);],getOpcode (Inl)) ;
}
}i
END;

The following Flex stream is not computed additively , since the STDDEYV function cannot be
computed additively.

CREATE INPUT WINDOW Inl
SCHEMA (cl INTEGER, c2 STRING, c3 INTEGER)
PRIMARY KEY (cl, c2);

CREATE FLEX MyFlex
IN Inl
OUT OUTPUT WINDOW FlexOut
SCHEMA (cl INTEGER, c2 INTEGER, c3 INTEGER, c4 FLOAT)
PRIMARY KEY (cl, c2)

BEGIN
declare
eventCache (Inl, coalesce) eO;
eventCache (Inl, coalesce) el;
end;
ON Inl {

{
output setOpcode ([cl=Inl.cl;c2=Inl.c2; |
c3=sum(e0.cl) ;cd4=stddev(el.c3);],getOpcode (Inl)) ;
}
2
END;

Another restriction is that additive optimizations are disabled when functions are used inside
nonlinear statements (if, while, for, and case statements). To enable additive optimizations

when using a function within a nonlinear statement, assign the result of the function to a
variable outside of the statement. Then use the variable inside the nonlinear statement.

Note: The function used within the nonlinear statement must be from the set of functions
eligible for additive optimization.
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The following SELECT is not optimized for additive optimization since one of the
expressions (CASE) in the SELECT list is a nonlinear expression.

CREATE OUTPUT WINDOW AggResult
SCHEMA (id INTEGER, name STRING, counter INTEGER, summary FLOAT)
PRIMARY KEY DEDUCED
AS
SELECT BaselInput.intData 1 AS id,
valuelnserted (BaselInput.strData 1) AS name,
CASE WHEN (count (BaseInput.intDATA 1) < 100) THEN O ELSE 1 END
AS counter,
sum (BaseInput.dblData 1) AS summary
FROM BaselInput
GROUP BY Baselnput.intData 1

’
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